Field Reference for Configuration Pages

This chapter provides descriptions of the fields found in the pages under the Configuration tab of Cisco
Prime Infrastructure.

» Network Devices Field Descriptions, on page 1

* Features and Technologies Field Descriptions, on page 9
 CLI Templates Field Descriptions, on page 108

* Wireless Configuration Field Descriptions, on page 136
« Compliance Field Descriptions, on page 152

« Configure Switches, on page 157

Network Devices Field Descriptions

Thefollowing topics contain descriptions of thefieldsfound in the Configur ation > Networ k Devices pages:

Wireless Controllers > System > AP 802.1X Supplicant Credentials

The following table describes the fields in Configuration > Network Devices > Controllers> AP 802.1X
Supplicant Credentials page.

Table 1: Wireless Controllers > System > AP 802.1X Supplicant Credentials

Field

Description

Template Basic

Name Enter a name for the template.
Description Enter an optional description for the template.
Tags Enter one or moretags. Tags are used to group templates. There are two ways you can tag atempl ate:

« Create the tags when you create the templ ate.

» Use the Tag icon located under the Templates search bar.

Validation Criteria

Device Type

Choose the device type from the drop-down list.
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Field

Description

Template Detail

Global Supplicant Credential

Select this option to enable the global supplicant credentials.

Wireless Controllers > System > AP Timers

Table 2-2 describes the fields in Configuration > Network Devices > Controllers> AP Timers page.

Table 2: Wireless Controllers > System > AP Timers

Field

Description

Access Point Mode

The Access Point Mode is automatically populated. The valuesin the Access Point Mode column are
links. When you click alink, the Controller Template access point mode page appears.

* FlexConnect Mode—Click thislink to configure FlexConnect Mode templ ate.

* Local Mode—Click thislink to configure the Local Mode template.

Applied to Controllers

Displays the number of controllers the WLAN templateis applied to.

Applied to Virtual Domains

Displays the number of virtual domains the controller template is applied to.

Last Saved At

Indicates when the template was last saved.

Wireless Controllers > System > AP Timers > FlexConnect Mode > Edit

The following describes the fields in Configuration > Network Devices > Controllers> AP Timers>
FlexConnect Mode > Edit page.

Table 3: Configuration > Network Devices > Controllers > AP Timers > FlexConnect Mode > Edit

Field

Description

Template Basic

Name Enter a name for the template.
Description Enter an optional description for the template.
Tags

Enter one or more tags. Tagsare used to group templates. There are two waysyou can tag atempl ate:
» Create the tags when you create the template.

* Use the Tag icon located under the Templates search bar.

Validation Criteria

Device Type

Choose the device type from the drop-down list.
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Wireless Controllers > System > AP Timers > Local Mode > Edit .

Field

Description

Template Detail

Access Point Mode

The Access Point Mode is automatically populated.

AP Fast Heartbeat Timer State

Select this check box to enable AP Fast Heartbeat Timeourt.

AP Fast Heartbeat Timeout

Enter an AP Fast Heartbeat Timeout value. The valid rangeis 1 to 15 seconds. The default is 10
seconds. The recommended timeout values are:

« 10 to 15 seconds for 7500 series controllers.
« 10 to 15 seconds for 5500 series controllers Release 7.0.98.0 and earlier.

« 1 to 10 seconds for 5500 series controllers Release 7.0.98.0 and | ater.

1 to010 seconds for other controllers.

Wireless Controllers > System > AP Timers > Local Mode > Edit

The following table describes the fields in Configuration > Network Devices > Controllers> AP Timers
> Local Mode > Edit page.

Table 4: Configuration > Network Devices > Controllers > AP Timers > Local Mode > Edit

Field

Description

Template Basic

Name Enter a name for the template.
Description Enter an optional description for the template.
Tags Enter one or moretags. Tagsare used to group templates. There are two waysyou can tag atemplate:

« Create the tags when you create the template.

* Use the Tag icon located under the Templates search bar.

Validation Criteria

Device Type Choose the device type from the drop-down list.
Template Detail
Access Point Mode The Access Point Mode is automatically populated.

AP Fast Heartbeat Timer State

Select this check box to enable AP Fast Heartbeat Timeout.
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. Wireless Controllers > System > AP Username Password

Field

Description

AP Fast Heartbeat Timeout Enter an AP Fast Heartbeat Timeout value. The valid rangeis 1 to 15 seconds. The default is 10

seconds. The recommended timeout values are:

* 10 to 15 seconds for 7500 series controllers.
« 10 to 15 seconds for 5500 series controllers Release 7.0.98.0 and earlier.

+ 1 to 10 seconds for 5500 series controllers Release 7.0.98.0 and | ater.

1 to10 seconds for other controllers.

Wireless Controllers > System > AP Username Password

Thefollowingtable describesthefieldsin Configuration > Networ k Devices> Controllers> AP Username
Passwor d page.

Table 5: Configuration > Network Devices > Controllers > AP Username Password

Field

Description

Template Basic

Name Enter a name for the template.
Description Enter an optional description for the template.
Tags Enter one or more tags. Tags are used to group templates. There are two ways you can tag a template:

» Create the tags when you create the template.

 Use the Tag icon located under the Templates search bar.

Validation Criteria

Device Type Choose the device type from the drop-down list.

Template Detail

AP Password Type the password that you want to be inherited by all access point that join the controller.
Confirm Password Retype the access point password.

Enable Password Enable password is applicable for Cisco 10S APs.

Confirm Enable Password | For Cisco |OS access points, you must also enter and confirm the enable password.

Wireless Controllers > System > DHCP

Thefollowing table describes the fieldsin Configuration > Networ k Devices> Controllers> DHCP page.
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Wireless Controllers > System > Dynamic Interface .

Table 6: Configuration > Network Devices > Controllers > DHCP

Field

Description

Template Basic

Name Enter a name for the template.
Description Enter an optional description for the template.
Tags Enter one or more tags. Tags are used to group templates. There are two ways you can tag

atemplate:
« Create the tags when you create the template.

 Use the Tag icon located under the Templates search bar.

Validation Criteria

Device Type

Choose the device type from the drop-down list.

Template Detail

DHCP Option 82 Remote Id field
format

Choose AP-MAC, AP-MAC-SSID, AP-ETHMAC, or AP-NAME-SSID from the drop-down
list.

DHCP Proxy Select the check box to enable DHCP proxy. When DHCP proxy is enabled on the controller,
the controller unicasts DHCP requests from the client to the configured servers. At least
one DHCP server must be configured on either the interface associated with the WLAN or
on the WLAN itself. DHCP proxy is enabled by default.

DHCP Timeout

Enter the DHCP Timeout in seconds, after which the DHCP request times out. The default
setting is 5. Allowed values range from 5 to 120 seconds.

DHCP Timeout is applicable for Controller Release 7.0.114.74 and | ater.

Wireless Controllers > System > Dynamic Interface

The following table describes the fields in Configuration > Networ k Devices > Controllers> Dynamic

Interface page.

Table 7: Configuration > Network Devices > Controllers > Dynamic Interface

Field

Description

Template Basic

Name

Enter a name for the template.

Description

Enter an optional description for the template.
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. Wireless Controllers > System > Dynamic Interface

Field

Description

Tags

Enter one or more tags. Tags are used to group templates. There are two ways you can tag
atemplate:

« Create the tags when you create the template.
 Use the Tag icon located under the Templates search bar.

Validation Criteria

Device Type Choose the device type from the drop-down list.
Template Detail

Interface Address

Guest LAN Select this check box to mark the interface as wired.
Quarantine Select this check box to quarantine a VLAN.
Netmask Enter the net mask address of the interface.

Physical Information

LAG Mode

Select this check box to enable the Link Aggregation (LAG).

Primary Port Number

Enter aprimary port number.

Primary and Secondary port numbers are present only in the Cisco 4400 Series Wireless
Controllers.

Secondary Port Number Enter a secondary port to be used by the interface when the primary port is down. When the
primary port isreactivated, the Cisco 4400 Series Wireless Controller transfersthe interfaces
back to the primary port.

AP Management Select this check box to enable access point management.

DHCP Information

Primary DHCP Server

Enter the | P address of the primary DHCP server.

Secondary DHCP Server Enter the | P address of the secondary DHCP server.

DHCP Proxy Mode Choosethe DHCP proxy modetype from the drop-down list. The possible values are: Global,
Enabled, and Disabled.

Enable DHCP Option 82 Select this check box to enable the DHCP relay agent information option.

Enable DHCP Option 82- Link Select

Select this check box to enable the DHCP Option 82 - Link Select.

Link Select relay source

Choose avalue from the Link Select replay source drop-down list.

Enable DHCP Option 82-VPN Select

Select this check box to enable the DHCP Option 82-VPN Select.

VPN Select-VRF Name

Select VRF Name.

VPN Select-VPN ID

Select VPN ID.
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Wireless Controllers > System > General - System Field Descriptions .

Field

Description

Access Control List

ACL Name

From the ACL Name drop-down list, choose a name from the list of defined names.

mDNS Profile

From the mDNS Profile drop-down list, choose the mDNS profile. The default option is
none.

Wireless Controllers > System > General - System Field Descriptions

The following table describes the fields in Configuration > Network Devices > Wireless Controllers>
System > General - System page.

Table 8: Wireless Controllers > System > General - System Field Descriptions

Field

Description

802.3x Flow Control Mode

Disable or enable.

802.3 Bridging

Disable or enable.

Web Radius Authentication

Choose PARP, CHAP, or MD5-CHAP.

» PAP—Password A uthentication Protocol. Authentication method where user information
(username and password) is transmitted in clear text.

» CHAP—Challenge Handshake Authentication Protocol. Authentication method where
user information is encrypted for transmission.

» MD5-CHAP—Message Digest 5 Challenge Handshake A uthentication Protocol. With
MD5, passwords are hashed using the Message Digest 5 algorithm.

AP Primary Discovery Timeout

Enter a value between 30 and 3600 seconds.

Theaccess point maintainsalist of backup controllersand periodically sends primary discovery
requeststo each entry inthelist. When configured, the primary discovery request timer specifies
the amount of timethat a controller has to respond to the discovery request of the access point
before the access point assumes that the controller cannot be joined and waits for a discovery
response from the next controller in the list.

CAPWAP Transport Mode

Layer 3 or Layer 2. See the Lightweight Access Point Protocol Transport Mode section for
more information.

Current LWAPP Operating Mode

Automatically populated.

Broadcast Forwarding

Disable or enable.
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. Wireless Controllers > System > General - System Field Descriptions

Field

Description

LAG Mode

Choose Disableif you want to disable LAG.

Link aggregation (LAG) isapartial implementation of the 802.3ad port aggregation standard.
It bundles al of the controller distribution system portsinto a single 802.3ad port channel,
thereby reducing the number of |P addresses needed to configure the ports on your controller.
When LAG is enabled, the system dynamically manages port redundancy and load balances
access points transparently to the user.

LAG isdisabled by default on the Cisco 5500 and 4400 series controllers but enabled by
default on the Cisco WiSM and the controller in the Catalyst 3750G Integrated WirelessLAN
Controller Switch.

Ethernet Multicast Support

* Disable—Select to disable multicast support on the controller.

* Unicast—Select if the controller, upon receiving amulticast packet, forwards the packets
to all the associated access points. FlexConnect supports only unicast mode.

 Multicast—Select to enable multicast support on the controller.

Aggressive Load Balancing

Disable or enable. See the Aggressive L oad Balancing section for more information on load
balancing.

Peer to Peer Blocking Mode

» Disable—Same-subnet clients communicate through the controller.

* Enable—Same-subnet clients communicate through a higher-level router.

Over Air Provision AP Mode

Disable or enable.

Over-the-air provisioning (OTAP) is supported by Cisco 5500 and 4400 series controllers. If
thisfeatureisenabled on the controller, all associated access pointstransmit wireless CAPWAP
or LWAPP neighbor messages, and new access points receive the controller | P address from
these messages. Thisfeatureisdisabled by default and should remain disabled when all access
points are installed.

Disabling OTAP on the controller does not disable it on the access point. OTAP cannot be
disabled on the access point.

AP Fallback

Disable or enable.

Enabling AP Fallback causes an access point which lost a primary controller connection to
automatically return to service when the primary controller returns.

AP Failover Priority

Disable or enable.

To configure failover priority settings for access points, you must first enable the AP Failover
Priority feature. See the AP Failover Priority section for more information.

AppleTalk Bridging

Disable or enable.
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Features and Technologies Field Descriptions .

Field

Description

Fast SSID change

Disable or enable.

When fast SSID changing is enabled, the controller allows clients to move between SSIDs.

When the client sends a new association for adifferent SSID, the client entry in the controller
connection tableiscleared before the client isadded to thenew SSID. When fast SSID changing
is disabled, the controller enforces adelay before clients are allowed to move to anew SSID.

If enabled, the client connects instantly to the controller between SSIDs without having
appreciable loss of connectivity.

Primary Controller Mode

Disable or enable.

Because the primary controller is normally not used in a deployed network, the primary
controller setting is automatically disabled upon reboot or OS code upgrade.

Wireless Management

Disable or enable.

ACL Counters

Disable or enable. The number of hits are displayed in the ACL Rule page.

Multicast Mobility Mode

Disable or enable.

Default Mobility Domain Name

Enter domain name.

Mobility Anchor Group Keep Alive
Interval

Enter the amount of delay time allowed between tries for a client attempting to join another
access point. Seethe Mobility Anchor Group Keep Alive Interval section for moreinformation.
Tip When you hover your mouse cursor over the parameter text box, the valid range
for that field appears.

Mobility Anchor Group Keep Alive
Retries

Enter number of allowable retries.

Tip When you hover your mouse cursor over the parameter text box, the valid range

for that field appears.

RF Network Name

Enter network name.

User Idle Timeout (seconds)

Enter timeout in seconds.

ARP Timeout (seconds)

Enter timeout in seconds.

Features and Technologies Field Descriptions

The following topics contain descriptions of the fields found in the Features and Technol ogies templates:

» Application Visibility Field Descriptions

* Controller Templates Field Descriptions

* Interfaces Templates Field Descriptions

» Network Analysis Module Field Descriptions
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. Application Visibility Field Descriptions

* Security Templates Field Descriptions

Application Visibility Field Descriptions

The Application Visibility feature allows you to monitor the traffic sent toward the Internet. You can monitor
the traffic flow and generate reports based on the traffic flow.

The following table describes the fields in Configuration > Templates > Features and Technologies >
Application Visibility & Control > Application Visibility.

Table 9: Application Visibility

Field Description

Template Detail

Apply to Interface Role Choose an interface role from the drop-down list. For information about creating the interface role,
see the “Controlling User Access’ section in the User Guide for the Cisco Prime Network Control
System WAN 1.1.

Traffic Statistics

On/Off Click Off if you do not want to collect the statistics pertaining to data packets.
We recommend that you:

* Configure the required minimal set of filters.

* Collect only traffic statistics for sites that run only 1Pv4 traffic.

IPs, Subnets Select an option to generate the report on 1Pv4, 1Pv6, or both IPv4 and IPv6 traffic.

HTTP URL Visibility

On/Off Click Off if you do not want to collect the statisticson HTTP URL visibility.

IPs, Subnets Select a specific set of |Pv4 addresses or subnetsto be monitored and decide whether to generate the
report for IPv6 traffic.

Applications Select a specific set of applications that should be monitored (there could be up to 32 monitored
applications). By default, all the enterprise related HT TP-based applications are included in the list.

Advanced Options Select the Sampling Rate and Direction from the drop-down list. To reduce the performance impact
on the device, select only the relevant traffic to be monitored.

Application Response Time

On/Off Click Off if you do not want to collect the Application Response Time metrics.

IPs, Subnets Select a specific set of |Pv4 addresses or subnets to be monitored and decide whether to generate the
report for IPv6 traffic.

Applications Select a specific set of applications that should be monitored (there could be up to 32 monitored
applications). By default, all the enterprise related HT TP-based applications are included in the list.
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Controller Templates Field Descriptions .

Field

Description

Voice/Video Metrics

On/Off Click Off if you do not want to collect the metrics on voice/video traffic.

IPs, Subnets Select a specific set of |Pv4 addresses or subnets to be monitored and decide whether to generate the
report for IPv6 traffic.

Applications Select a specific set of applications that should be monitored (there could be up to 32 monitored

applications). By default, all the enterprise related RTP enterprise-rel ated applications are monitored.

Controller Templates Field Descriptions

Controller 802.11

Altering configurations across alarge number of controllers can be tedious and time-consuming, and templates
save you time by applying the necessary configurations and by ensuring consistency across controllers. When
you areimplementing new servicesor anew site, use these controller templatesto define controller parameters
and settings, which you can later deploy to a specified number of wireless LAN controllers.

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies> Controller.

* Controller 802.11

* Controller >80211aor nor ac

* Controller >80211borgorn

* Controller > CLI > General

« Controller > FlexConnect > FlexConnect AP Groups
* Controller > IPv6

* Controller > Location

« Controller > Management

« Controller > Mesh > Mesh Settings

* Controller > PMIP

« Controller >Security

« Controller > System

« Controller > WLANs > WLAN Configuration

 Controller > mDNS

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > 802.11.

« Controller > 802.11 > Band Select
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. Controller > 802.11 > Band Select

* Controller > 802.11 > Load Balancing
* Controller > 802.11 > Media Stream

* Controller > 802.11 > Preferred Call

* Controller > 802.11 > RF Profiles

Controller > 802.11 > Band Select

The following table describes the Template Detail fields found in Configuration > Templates > Features
and Technologies > Controller > 802.11 > Band Select.

Table 10: Controller > 802.11 > Band Select

Field Description

Probe Cycle Count Enter avalue from 1 to 10 for the probe cycle count. The cycle count sets the number of suppression
cyclesfor anew client. The default cycle count is 2.

Scan Cycle Period Threshold | Enter avalue from 1 to 1000 milliseconds for the scan cycle period threshold. This setting determines
the time threshold during which new probe reguests from a client come from anew scanning cycle.
The default cycle threshold is 200 milliseconds.

Age Out Suppression Enter avalue from 10 to 200 seconds for the age-out suppression. Age-out suppression sets the
expiration time for pruning previously known 802.11b/g clients. The default value is 20 seconds.
After thistime elapses, clients become new and are subject to probe response suppression.

Age Out Dual Band Enter avalue from 10 to 300 seconds for the age-out dual band. The age-out period setsthe expiration
time for pruning previously known dual-band clients. The default valueis 60 seconds. After thistime
elapses, clients become new and are subject to probe response suppression.

Acceptable Client RSSI Enter avalue between —20 and —-90 dBm for the acceptable client Received Signal Strength Indicator
(RSSI). Thisfield setsthe minimum RSS! for a client to respond to a probe. The default value is—80
dBm.

Controller > 802.11 > Load Balancing

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller >802.11 > L oad Balancing.

Table 11: Controller > 802.11 > Load Balancing

Field Description

Client Window Size | Enter avaue from 1 to 20. The page size becomes part of the agorithm that determines whether an access
point is too heavily loaded to accept more client associations:

load-balancing page + client associations on AP with lightest load = load-balancing threshold

Max Denial Count |Enter avalue from 0 to 10. The denial count sets the maximum number of association denials during load
balancing.
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Controller > 802.11 > Media Stream .

Controller > 802.11 > Media Stream

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > 802.11 > Media Stream.

Table 12: Controller > 802.11 > Media Stream

Field

Description

Media Stream Name

Enter the name of the media stream.

Multicast Destination Start | P

Enter the start | P address of the media stream to be multicast.

Multicast Destination End |P

Enter the end IP address of the media stream to be multicast. Start IP and End IP can be |Pv4 or
IPv6 multicast address, starting from controller Version 7.2.x.

Maximum Expected Bandwidth

Enter the maximum bandwidth that a media stream can use.

Average Packet Size

Enter the average packet size that a media stream can use.

RRC Periodical Update

Enter the Resource Reservation Control (RRC) calculationsthat are updated periodically; if disabled,
RRC calculations are done only once when a client joins a media stream.

RRC Priority

Enter the priority of RRC with the highest at 1 and the lowest at 8.

Traffic Profile Violation

Choose the Traffic Profile Violation from the drop-down list. The drop-down list appearsif the
stream is dropped or put in the best effort queue if the stream violates the QoS video profile.

Policy

Choose the Policy from the drop-down list. The drop-down list appearsif the mediastream is
admitted or denied.

Controller > 802.11 > Preferred Call

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >802.11 > Preferred Call.

Table 13: Controller > 802.11 > Preferred Call

Field Description

Number Id Enter avalue to identify the preferred number. You can have a maximum of six preferred call numbers. The
valid rangeisfrom 1 to 6. The default valueis 1.

Number

Preferred Enter the preferred call number.

Controller > 802.11 > RF Profiles

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >802.11 > RF Prfiles.
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Table 14: Controller > 802.11 > RF Profiles
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Field

Description

Template Name

Enter the name of the template.

Profile Name Enter the name of the current profile.
Description Enter the Description of the template.
Radio Type Choose the radio type of the access point from the drop-down list.

Minimum Power Level Assignment (-10
to 30 dBm)

Enter avalue from -10 to 30dBm for the minimum power level assignment. The default
valueis-10 dBM.

Maximum Power Level Assignment (-10
to 30 dBm)

Enter avalue from -10 to 30dBm for the maximum power level assignment. The default
valueis 30 dBM.

Power Threshold v1(-80 to -50 dBm)

Enter avalue from -80 to -50dBm for the power threshold v1. The default valueis-70
dBM.

Power Threshold v2(-80 to -50 dBm)

Enter a value from -80 to -50dBm for the power threshold v2.The default value is-67
dBM.

Data Rates

Select the data rates from the drop-down lists to specify the rates at which data can be
transmitted between the access point and the client. These data rates are available;

+ 802.11a—6, 9, 12, 18, 24, 36, 48, and 54 Mbps.
» 802.11b/g—1, 2, 5.5, 6, 9, 11, 12, 18, 24, 36, 48, or 54 Mbps.

For each data rate, you must also choose one of these options:

» Mandatory—Clients must support this datarate to associate to an access point on the
controller.

* Supported—Any associated clients that support this data rate might communicate
with the access point using that rate. However, the clients are not required to be able
to use this rate to associate.

* Disabled—The clients specify the data rates used for communication.

Controller > 80211a or n or ac

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies> Controller > 80211a or n or ac.

» Controller > 80211aor n or ac > dotl1a-RRM > DCA

» Controller > 80211aor n or ac > dotl1a-RRM > Intervals

 Controller > 80211aor n or ac > dotl1la-RRM > TPC

« Controller > 80211aor n or ac > dot11a-RRM > Thresholds

» Controller > 80211aor n or ac > 802.11h
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Controller > 80211a or n or ac > dot11a-RRM > DCA .

* Controller > 80211aor n or ac > CleanAir

* Controller > 80211aor n or ac > EDCA Parameters

« Controller > 80211aor n or ac > High Throughput (802.11n)
* Controller > 80211aor n or ac > Media Parameters > General
* Controller > 80211aor n or ac > Media Parameters > Video

* Controller > 80211aor n or ac > Media Parameters > Voice

* Controller > 80211aor n or ac > Parameters

« Controller > 80211aor n or ac > Roaming Parameters

Controller > 80211a or n or ac > dot11a-RRM > DCA

The Radio Resource Management (RRM) Dynamic Channel Assignment (DCA) page alows you to choose
the DCA channels as well as the channel width for this controller.

RRM DCA supports 802.11n 40-MHz channel width in the 5-GHz band. The higher bandwidth allows radios
to achieve higher instantaneous data rates.

Note

Choosing alarger bandwidth reduces the nonoverlapping channels that could potentially reduce the overall
network throughput for certain deployments.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller >80211aor n or ac > dotlla-RRM > DCA.

Table 15: Controller > 80211a or n or ac > dot11a-RRM > DCA

Field

Description

Assignment Mode

From the drop-down list, choose one of three modes:
* Automatic—Thetransmit power is periodically updated for all access pointsthat permit thisoperation.
* On Demand—Transmit power is updated when you click Assign Now.

« Disabled—No dynamic transmit power assignments occur, and values are set to their global default.

Avoid Foreign AP
Interference

Select the enable check box to have RRM consider interference from foreign Cisco access points (those
non-Cisco access points outside RF/mobility domain) when assigning channels. Unselect this check box
to have RRM ignore thisinterference. In certain circumstances with significant interference energy (dB)
and load (utilization) from foreign access points, RRM might adjust the channel assignment to avoid
these channel s (and sometimes adjacent channels) in access points closeto theforeign access points. This
adjustment increases capacity and reduces variability for the Cisco WLAN Solution.

Avoid Cisco AP Load

Select the enable check box to have controllers consider the traffic bandwidth used by each access point
when assigning channels to access points. Unselect this check box to have RRM ignore thisvalue. In
certain circumstances and with denser deployments, there might not be enough channels to properly
create perfect channel reuse. In these circumstances, RRM can assign better reuse patternsto those access
points that carry more traffic load.
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. Controller > 80211a or n or ac > dot11a-RRM > Intervals

Field

Description

Avoid non 802.11 Noise

Select the enable check box to have access points avoid channels that have interference from nonaccess
point sources, such as microwave ovens or Bluetooth devices. Unselect this check box to have RRM
ignorethisinterference. In certain circumstances with significant interference energy (dB) from non-802.11
noi se sources, RRM might adjust the channel assignment to avoid these channel s (and sometimes adjacent
channels) in access points close to the noise sources. This adjustment increases capacity and reduces
variability for the Cisco WLAN Solution.

Signal Strength
Contribution

Alwaysenabled (not configurable). Signal Strength Contribution constantly monitorstherelative location
of all access points within the RF/mobility domain to ensure near-optimal channel reuse. The net effect
isanincrease in Cisco WLAN Solution capacity and a reduction in co-channel and adjacent channel
interference.

Event Driven RRM

Select the enable check box to disable spectrum event-driven RRM. By default, Event Driven RRM is
enabled. Event Driven RRM is used when a CleanAir-enabled access point detects a significant level of
interference.

Sensitivity Threshold

If Event Driven RRM is enabled, this field displays the threshold level at which event-driven RRM is
triggered. It can have avalue of either Low, Medium, or High. When the interference for the access point
rises above the threshold level, RRM initiates alocal Dynamic Channel Assignment (DCA) run and
changes the channel of the affected access point radio if possible to improve network performance. Low
represents a decreased sensitivity to changes in the environment while High represents an increased
sensitivity.

Controller > 80211a or n or ac > dot11a-RRM > Intervals

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > dot11a-RRM > Intervals.

Table 16: Controller > 80211a or n or ac > dot11a-RRM > Intervals

Field

Description

Neighbor Packet Frequency Enter theinterval at which you want strength measurementstaken for each access point. The default

is 300 seconds.

Channel Scan Duration

Enter the interval at which you want noise and interference measurements taken for each access
point. The default is 300 seconds.

Load Measurement Interval Enter the interval at which you want load measurements taken for each access point. The default

is 300 seconds.

Note This parameter cannot be applied to Cisco WLC Release 4.3 or later.

Coverage Measurement Interval | Enter the interval at which you want coverage measurements taken for each access point. The

default is 300 seconds.
Note This parameter cannot be applied to Cisco WLC Release 4.3 or later.
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Controller > 80211a or n or ac > dot11a-RRM > TPC .

Controller > 80211a or n or ac > dot11a-RRM > TPC

The controller dynamically controls access point transmit power based on real-timewirelessLAN conditions.
Normally, power can be kept low to gain extra capacity and reduce interference. The controller attemptsto
balance the transmit power of the access points according to how the access points are seen by their third
strongest neighbor.

The transmit power control (TPC) algorithm both increases and decreases the power of an access point in
response to changes in the RF environment. In most instances, TPC seeks to lower the power of an access
point to reduce interference, but in the case of a sudden change in the RF coverage—for example, if an access
point fails or becomes disabled—TPC can also increase power on surrounding access points. Thisfeatureis
different from Coverage Hole Detection. Coverage Hole Detection is primarily concerned with clients, while
TPC istasked with providing enough RF power to achieve desired coverage levels while avoiding channel
interference between access points.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > dot11a-RRM > TPC.

Table 17: Controller > 80211a or n or ac > dot11a-RRM > TPC

Field

Description

TPC Version

Choose TPCv1 or TPCv2 from the drop-down list.
Note The TPCv2 option is applicable only for controller Version 7.2.x or later.

Dynamic Assignment

From the Dynamic Assignment drop-down list, choose one of three modes:

» Automatic—The transmit power is periodically updated for all access points that permit this
operation.

* On Demand—Transmit power is updated when you click Assign Now.

« Disabled—No dynamic transmit power assignments occur, and values are set to their global
default.

Maximum Power Assignment | Indicates the maximum power assigned. Range: -10 to 30 dB. Default: 30 dB.

Minimum Power Assignment | Indicates the minimum power assigned. Range: -10 to 30 dB. Default: 30 dB.

Dynamic Tx Power Control | Click the check box if you want to enable Dynamic Transmission Power Control.

Transmitted Power Threshold | Enter a transmitted power threshold from -50 to -80.

Control Interval

Shows the transmitted power control interval in seconds (read-only).

Controller > 80211a or n or ac > dot11a-RRM > Thresholds

Use this option to create or modify atemplate for setting various RRM thresholds such as load, interference,
noise, and coverage.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller >80211aor n or ac > dotlla-RRM > Thresholds.

Field Reference for Configuration Pages .
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Note

You must disable the 802.11a/n/ac network before applying these RRM threshold values.

Table 18: Controller > 80211a or n or ac > dot

11a-RRM > Thresholds

Field

Description

Min Failed Clients

Enter the minimum number of failed clients currently associated with the controller.

Coverage Level

Enter the target range of coverage threshold (dB).

Signal Strength

When the Coverage Level field isadjusted, the value of the Signal Strength (dBm) automatically
reflects this change. The Signal Strength field provides information regarding what the signal
strength is when adjusting the coverage level.

Data RSS| Enter the Data RSS| (—60 to —-90 dBm). This number indicates the value for the minimum
Received Signal Strength Indicator (RSSI) for data required for the client to associate to an
access point.

Voice RSS| Enter the Voice RSSI (—60 to —90 dBM). This number indicates the value for the minimum
Received Signal Strength Indicator (RSSI) required for voice for the client to associate to an
access point.

Max. Clients Enter the maximum number of clients able to be associated with the controller.

RF Utilization Enter the percentage of threshold for thisradio type.

Interference Threshold

Enter an interference threshold from 0 to 100 percent.

Noise Threshold

Enter a noise threshold from -127 to 0 dBm. When the controller is outside of this threshold, it
sends an alarm to Prime Infrastructure.

Coverage Exception Level Per AP

Enter the coverage exception level percentage. When the coverage drops by this percentage from
the configured coverage for the minimum number of clients, a coverage holeis generated.

Controller > 80211a or n or ac > 802.

11h

802.11h informs client devices about channel changes and can limit the transmit power of the client device.
Create or modify atemplate for configuration 802.11h parameters (such as power constraint and channel
controller announcement) and applying these settings to multiple controllers.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller >80211a or n or ac > 802.11h.

Table 19: Controller > 80211a or n or ac > 802.11h

Field

Description

Power Constraint Select the

channel.

Power Constraint check box if you want the access point to stop transmission on the current
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Controller > 80211a or n or ac > CleanAir .

Field

Description

Channel Announcement

Select the Channel Announcement check box to enable channel announcement. Channel announcement
isamethod in which the access point announceswhenit is switching to anew channel and the new channel
number.

Controller > 80211a or n or ac > CleanAir

Usethisoption to create or modify atemplate for configuring CleanAir parametersfor the 802.11a/n/ac radio.
You can configure the template to enable or disable CleanAir. You can aso configure the type of interfering
devicesto include for reporting and aarms.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > CleanAir.

Table 20: Controller > 80211a or n or ac > CleanAir

Field

Description

Report Interferers

Select the Report interferers check box to enable the CleanAir system to report and detect
sources of interference, or unselect it to prevent the controller from reporting interferers. The
default value is unselected.

Interferers |gnored/Selected for
Reporting

Make sure that any sources of interference that need to be detected and reported by the CleanAir
system appear in the Interferences to Detect box and any that do not need to be detected appear
in the Interferersto Ignore box. Use the > and < buttons to move interference sources between
these two boxes. By default, all interference sources are ignored.

Persistent Device Propagation

Select the Per sistent Device Propagation check box to enable propagation of information about
persistent devices that can be detected by CleanAir. Persistent device propagation enables
designating information about interference types and propagating this information to the
neighboring access points. Persistent interferers are present at the location and interfere with the
WLAN operations even if they are not detectable at all times.

Air Quality Alarm

Select the Air Quality Alarm check box to enablethetriggering of air quality alarms, or unselect
the box to disable this feature.

Air Quality Alarm Threshold

If you selected the Air Quality Alarm check box, enter avalue from 1 to 100 in the Air Quality
Alarm Threshold field to specify the threshold at which you want the air quality alarm to be
triggered. When the air quality falls below the threshold level, the alarm is triggered. A value of
1 represents the worst air quality, and 100 represents the best. The default valueis 1.

Air Quality Unclassified Category
Alarm

Select the Air Quality Unclassified Category Alarm check box to enable the alarmsto be
generated for unclassified interference category. CleanAir can detect and monitor unclassified
interferences. Unclassified interference are interference that are detected but do not correspond
to any of the known interference types.

Air Quality Unclassified Category
Severity Threshold

If you selected the Air Quality Unclassified Category Alarm check box, enter avalue from 1
to99inthe Air Quality Unclassified Category Severity Threshold text box to specify the threshold
at which you want the unclassified category alarm to be triggered. The default is 20.
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. Controller > 80211a or n or ac > EDCA Parameters

Field

Description

Interferers For Security Alarm | Select the Interferers For Security Alarm check box to trigger interferer alarms when the

controller detects specified device types, or unselect it to disable this feature. The default value
is unselected.

Security Alarms

Interferers Ignored/Selected for | Make sure that any sources of interference that need to trigger interferer alarms appear under

Interferers Selected for Security Alarms and any that do not need to trigger interferer alarms
appear in the Interferersignored for Security Alarms. Use the > and < buttons to move
interference sources between these two boxes. By default, al interferer sourcesfor security aarms
are ignored.

Controller > 80211a or n or ac > EDCA Parameters

Enhanced distributed channel access (EDCA) parameters are designed to provide preferential wireless channel
access for voice, video, and other quality of service (QoS) traffic.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > EDCA Parameters.

Table 21: Controller > 80211a or n > EDCA Parameters

Field

Description

EDCA Profile

Choose one of the following options from the EDCA Pr ofile drop-down list:

* WM M —Enables the Wi-Fi Multimedia (WMM) default parameters. Thisis the default value. Choose
this option when voice or video services are not deployed on your network.

» Spectralink Voice Priority—Enables Spectralink voice priority parameters. Choose this option if
Spectralink phones are deployed on your network to improve the quality of calls.

* Voice Optimized—Enables EDCA voice-optimized profile parameters. Choose this option when voice
services other than Spectralink are deployed on your network.

* Voice & Video Optimized—Enables EDCA voice- and video-optimized profile parameters. Choose this
option when both voice and video services are deployed on your network.
Note Video services must be deployed with admission control (ACM). Video services without ACM are
not supported.
Note You must shut down the radio interface before configuring EDCA parameters.

Low Latency MAC

Enable low latency MAC only if al clients on the network are WMM compliant.

Controller > 80211a or n or ac > High Throughput (802.11n)

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > 80211a or n or ac > High Throughput (802.11n).
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Controller > 80211a or n or ac > Media Parameters > General .

Table 22: Controller > 80211a or n or ac > High Throughput (802.11n)

Field Description

802.11n Network Status Enabled | Select the 802.11n Network Status Enabled check box to enable high throughpuit.

Selected MCS Indexes Choose which level of data rate you want supported. Modulation coding schemes (MCS) are
similar to 802.11adatarate. The defaults are 20 MHz and short guarded interval. When you sel ect
the Supported check box next to anumbered Data Rate, the chosen numbers appear in the Selected
MCS Indexes field at the bottom of the column.

Controller > 80211a or n or ac > Media Parameters > General

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller >80211aor n or ac > Media Parameters> General.

Table 23: Controller > 80211a or n or ac > Media Parameters > General

Field Description

Maximum M ediaBandwidth (0to 85%) | Specify the percentage of maximum bandwidth allowed. This option isonly available
when CAC is enabled.

Controller > 80211a or n or ac > Media Parameters > Video

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > Media Parameters> Video.

Table 24: Controller > 80211a or n or ac > Media Parameters > Video

Field Description

Admission Control (ACM) Select the check box to enable admission control.

Maximum Bandwidth Allowed Specify the percentage of maximum bandwidth allowed. Thisoptionisonly availablewhen
CAC isenabled.

Reserved Roaming Bandwidth Specify the percentage of reserved roaming bandwidth. This option is only available when
CAC isenabled.

CAC Method If Admission Control (ACM) is enabled, specify the CAC method as either |oad-based or

static. Load-based CAC incorporates a measurement scheme that takes into account the
bandwidth consumed by all traffic types from itself, from co-channel access points, and by
co-located channel interference. Load-based CAC a so covers the additional bandwidth
consumption resulting from PHY and channel impairment.

Unicast Video Redirect Select the Unicast Video Redirect check box to enable all nonmedia stream packetsin
video queue are redirected to the best effort queue. If disabled, all packets with video
marking are kept in video queue.

Client Minimum Phy Rate Specify the physical datarate required for the client to join a media stream from the Client
Minimum Phy Rate drop-down list.
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. Controller > 80211a or n or ac > Media Parameters > Voice

Field

Description

Multicast Direct Enable

Select the M ulticast Direct Enable check box to set the Media Direct for any WLAN with
Media Direct enabled on aWLAN on this radio.

Maximum Number of Streams per Specify the maximum number of streams per Radio to be allowed.

Radio

Maximum Number of Streams per Specify the maximum number of streams per Client to be allowed.

Client

Best Effort QOS Admission Select the Best Effort QOS Admission check box to redirect new client requests to the

best effort queue. This happens only if al the video bandwidth has been used. If thisis
disabled and maximum video bandwidth has been used, then any new client request is
rejected.

Controller > 80211a or n or ac > Media Parameters > Voice

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac> Media Parameter s > Voice.

Table 25: Controller > 80211a or n or ac > Media Parameters > Voice

Field

Description

Admission Control (ACM)

Select the check box to enable admission control. For end users to experience acceptable audio

quality during a Vol P phone call, packets must be delivered from one endpoint to another with low
latency and low packet loss. To maintain QoS under differing network loads, call admission control
(CAC) isrequired. CAC on an access point allows it to maintain controlled QoS when the network
is experiencing congestion and keep the maximum all owed number of callsto an acceptable quantity.

CAC Method

If Admission Control (ACM) is enabled, specify the CAC method as either |oad-based or static.

L oad-based CAC incorporates ameasurement schemethat takesinto account the bandwidth consumed
by all traffic typesfrom itself, from co-channel access points, and by co-located channel interference.
Load-based CAC a so coversthe additional bandwidth consumption resulting from PHY and channel
impairment.

Maximum Bandwidth

Specify the percentage of maximum bandwidth allowed. This option is only available when CAC

Allowed isenabled.

Reserved Roaming Bandwidth | Specify the percentage of reserved roaming bandwidth. This option isonly available when CAC is
enabled.

Expedited Bandwidth Select the check box to enable expedited bandwidth as an extension of CAC for emergency calls.
You must have an expedited bandwidth | E that is CCXv5 compliant so that a TSPEC request isgiven
higher priority.

SIPCAC Select the check box to enable SIP CAC. SIP CAC should be used only for phonesthat support status
code 17 and do not support TSPEC-based admission contral.

SIP Codec Specify the codec name you want to use on this radio. The available options are G.711, G.729, and

User Defined.
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Controller > 80211a or n or ac > Parameters .

Field

Description

SIP Call Bandwidth

Specify the bandwidth in kilobits per second that you want to assign per SIP call on the network.
Thisfield can be configured only when the SIP Codec selected is User Defined.

SIP Sample Interval

Specify the sampleinterval in milliseconds that the codec must operatein.

Metric Collection

Select the check box to enable metric collection. Traffic stream metricsare aseries of statistics about
VolIP over your wireless LAN that inform you of the QoS of the wireless LAN. For the access point
to collect measurement values, traffic stream metrics must be enabled. When thisis enabled, the
controller begins collecting statistical data every 90 seconds for the 802.11b/g interfaces from all
associated access points. If you are using Vol P or video, this feature should be enabled.

Controller > 80211a or n or ac > Parameters

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > Parameters.

Table 26: Controller > 80211a or n or ac > Parameters

Field Description

802.11a Network Status | Select the check box to enable 802.11a/n network status.

Client Link Usethis drop-down list to enable Clientlink on all access point 802.11a/n radios that support ClientLink.
Otherwise, choose Disable.

Beacon Period Enter the amount of time between beaconsin milliseconds. Thevalid rangeisfrom 20 to 1000 milliseconds.

DTIM Period Enter the number of beacon intervalsthat might el apse between transmission of beacon frames containing
atraffic indicator message (TIM) element whose delivery count text box is 0. This value is transmitted
inthe DTIM period field of beacon frames. When client devices receive a beacon that containsaDTIM,
they normally wake up to check for pending packets. Longer intervals between DTIMS let clients sleep
longer and preserve power. Conversely, shorter DTIM periods reduce the delay in receiving packets but
use more battery power because clients wake up more often.

Fragmentation Threshold | Determine the size at which packets are fragmented (sent as several pieces instead of as one block). Use
alow setting in areas where communication is poor or where there is agreat deal of radio interference.

802.11e Max Bandwidth | Enter the percentage for 802.11e maximum bandwidth.

Mode Select the check box to enable Cisco Compatible Extension (CCX) Location Measurement. When enabl ed,
this enhances the location accuracy of clients.

Interval Enter the interval at which CCX Location Measurement signals are broadcast, in seconds. The CCX

location measurement interval of the Cisco Compatible Extension can only be changed when measurement
modeis enabled.
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. Controller > 80211a or n or ac > Roaming Parameters

Field

Description

Data Rate Dropdowns | Select the negotiation type for each datarate. The client and controller negotiate data rates between them.

If the datarate is set to Mandatory, the client must support it to use the network. If adatarateis set as
Supported by the controller, any associated client that also supports that same rate might communicate
with the access point using that rate. However, it is not required that a client uses all the rates marked
supported to associate. For each rate, adrop-down list of Mandatory or Supported is available. Each data
rate can also be set to Disable to match client settings.

Channel List

From this drop-down list in the Noise/Interference/Rogue Monitoring Channels section, choose either all
channels, country channels, or DCA channelsbased on thelevel of monitoring you want. Dynamic Channel
Allocation (DCA) automatically selects areasonably good channel allocation amongst a set of managed
devices connected to the controller.

Controller > 80211a or n or ac > Roaming Parameters

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >80211a or n or ac > Roaming Parameters.

Table 27: Controller > 80211a or n or ac > Roaming Parameters

Field Description

Mode Use the Mode drop-down list to choose one of the configurable modes. Default values or Custom values. If
you select Default, the roaming parameters are unavailable for editing and have the default values displayed
in the text boxes. Select Custom to edit the roaming parameters.

Minimum RSSI Enter avalue for the minimum Received Signal Strength Indicator (RSSI) required for the client to associate

to an access point. If the average received signal power of the client dips below this threshold, reliable
communication is usually impossible. Therefore, clients must already have found and roamed to another
access point with astronger signal before the minimum RSSI valueisreached. Range: -80to -90 dBm. Default:
-85 dBm.

Roaming Hysteresis

Enter avalue to indicate how strong the signal strength of a neighboring access point must be for the client
toroamto it. Thisfield isintended to reduce the amount of ping-ponging between access pointsif the client
is physically located on or near the border between two access points. Range: 2 to 4 dB. Default: 2 dB.

Adaptive Scan
Threshold

Enter the RSSI value from the associated access point of the client, below which the client must be able to
roam to a neighboring access point within the specified transition time. Thisfield also provides a power-save
method to minimize the time that the client spends in active or passive scanning. For example, the client can
scan dlowly when the RSS! is above the threshold and scan more rapidly when below the threshold. Range:
-70to-77 dB. Default: -72 dB.

Note The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with highest expected client speed and Roaming Hysteresis, these parameters
make it possible to design awireless LAN network that supports roaming simply by ensuring a
certain minimum overlap distance between access points.
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Controller > 80211b or g or n .

Field Description

Transition Time Enter the maximum time allowed for the client to detect a suitable neighboring access point to roam to and
to complete the roam, whenever the RSSI from the associated access point of the client is below the scan
threshold. Range: 1 to 10 seconds. Default: 5 seconds.

Note The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with highest expected client speed and Roaming Hysteresi s, these parameters
make it possible to design awireless LAN network that supports roaming simply by ensuring a
certain minimum overlap distance between access points.

Controller > 80211b or g or n

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > 80211b or gor n.

« Controller >802.11b or g or n > dot11b-RRM > DCA

* Controller >802.11b or g or n > dot11b-RRM > Intervals

* Controller > 802.11b or g or n > dot11b-RRM > Thresholds

* Controller > 802.11b or g or n > dot11b-RRM > TPC

* Controller > 80211aor n or ac > CleanAir

* Controller >802.11b or g or n > EDCA Parameters

« Controller > 802.11b or g or n > High Throughput (802.11n), on page 26
« Controller >802.11b or g or n > Media Parameters

« Controller > 802.11b or g or n > Parameters

* Controller > 802.11b or g or n > Roaming Parameters

Controller >802.11b or g or n > dot11b-RRM > DCA

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM > DCA, see Controller > 80211aor n or ac > dotlla-RRM > DCA

Controller > 802.11b or g or n > dot11b-RRM > Intervals

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
>802.11b or gor n>dot11b-RRM > Intervals, see Controller > 80211aor nor ac > dot11la-RRM > Intervals

Controller > 802.11b or g or n > dot11b-RRM > TPC

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM > TPC, see Controller > 80211aor n or ac > dot11la-RRM > TPC.

Controller > 802.11b or g or n > dot11b-RRM > Thresholds

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > dot11b-RRM > Thresholds, see Controller > 80211aor n or ac > dot11a-RRM >
Thresholds
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. Controller > 802.11b or g or n > CleanAir

Controller > 802.11b or g or n > CleanAir

For a description of the fields on Configuration > Templates > Features and Technologies > Controller
> 802.11b or g or n > CleanAir, see Controller > 80211aor n or ac > CleanAir.

Controller > 802.11b or g or n > EDCA Parameters

Usethisoption to create or modify atemplatefor configuring 802.11b/g/n EDCA parameters. EDCA parameters
designate preconfigured profiles at the MAC layer for voice and video.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller >802.11b or g or n > EDCA Parameters.

Table 28: Controller > 80211b or g or n > EDCA Parameters

Field

Description

EDCA Profile

Profiles include Wi-Fi Multimedia (WMM), Spectralink Voice Priority (SVP), Voice Optimized, and Voice &
Video Optimized. WMM isthe default EDCA profile.

Note You must shut down the radio interface before configuring EDCA Parameters.

Note Disabling WMM or changing the EDCA profile from WMM on the device will disable the 11n rates
when the AP is rebooted.

Low Latency MAC

Enable this option only if DSCP marking is correct for media (RTP) and signaling packets.

Controller > 802.11b or g or n > High Throughput (802.11n)

Usethis option to create or modify atemplate for configuring high-throughput parameters such asMCS (data
rate) settings and indexes and for applying these 802.11n settings to multiple controllers.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller >802.11b or g or n > High Throughput(802.11n).

Table 29: Controller > 80211b or g or n > High Throughput(802.11n)

Field

Description

802.11n Network Status | Select the check box to enable high throughput.

MCS (DataRate) Settings | Choose which level of datarate you want supported. MCS is modulation coding schemesthat are similar

to 802.11adatarate. The values 20 MHz and short guarded interval are used as defaults. When you select
the Supported check box, the chosen numbers appear in the Selected MCS Indexes page.

Controller > 802.11b or g or n > Media Parameters

Use this option to create or modify atemplate for configuring 802.11b/g/n voice parameters such as Call
Admission Control and traffic stream metrics.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller >802.11b or g or n > Media Parameters.
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Controller > 802.11b or g or n > Media Parameters .

Table 30: Controller > 80211b or g or n > Media Parameters

Field

Description

General

Maximum Media Bandwidth (O to
85%)

Specify the percentage maximum of bandwidth allowed. This option is only available when
CAC isenabled.

Video

Admission Control (ACM)

Select the check box to enable admission control.

Maximum Bandwidth

Specify the percentage of maximum bandwidth allowed. This option is only available when
CAC isenabled.

Reserved Roaming Bandwidth

Specify the percentage of reserved roaming bandwidth. This option is only available when
CAC isenabled.

Unicast Video Redirect

Select the Unicast Video Redirect check box to enable all nonmedia stream packetsin the
video queueto be redirected to the best effort queue. If disabled, al packetswith video marking
are kept in video queue.

Client Minimum Phy Rate

Choose the physical data rate required for the client to join a media stream from the Client
Minimum Phy Rate drop-down list.

Multicast Direct Enable

Select the Multicast Direct Enable check box to set the Media Direct for any WLAN with
Media Direct enabled on aWLAN on thisradio.

Maximum Number of Streams per
Radio

Specify the maximum number of streams per radio to be allowed.

Maximum Number of Streams per
Client

Specify the maximum number of streams per client to be allowed.

Best Effort QOS Admission Select the Best Effort QOS Admission check box to redirect new client requests to the best
effort queue. This happens only if all the video bandwidth has been used. If disabled and
maximum video bandwidth has been used, then any new client request is rejected.

Voice

Admission Control (ACM)

Select the check box to enable admission control. For end users to experience acceptable
audio quality during a Vol P phone call, packets must be delivered from one endpoint to
another with low latency and low packet |oss. To maintain QoS under differing network loads,
Call Admission Control (CAC) isrequired. CAC on an access maintains a controlled QoS
when the network is experiencing congestion and keep the maximum allowed number of calls
to an acceptable quantity.

CAC Method

If Admission Control (ACM) is enabled, specify the CAC method as either |oad-based or
static. Load-based CAC incorporates a measurement scheme that takes into account the
bandwidth consumed by all traffic types from itself, from co-channel access points, and by
co-located channel interference. Load-based CAC aso covers the additional bandwidth
consumption resulting from PHY and channel impairment.
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Field

Description

Maximum Bandwidth Allowed

Enter the percentage of maximum bandwidth allowed. This option is only available when
CAC isenabled.

Reserved Roaming Bandwidth

Enter the percentage of reserved roaming bandwidth. Thisoptionisonly availablewhen CAC
isenabled.

Expedited Bandwidth Select the check box to enable expedited bandwidth as an extension of CAC for emergency
cals. You must have an expedited bandwidth | E that is CCXv5 compliant so that a TSPEC
request is given higher priority.

SIPCAC Select the check box to enable SIP CAC. SIP CAC should be used only for phonesthat support
status code 17 and do not support TSPEC-based admission control.

SIP Codec Choose the codec name you want to use on this radio from the SIP Codec drop-down list.

The available options are G.711, G.729, and User Defined.

SIP Call Bandwidth

Enter the bandwidth in kil obits per second that you want to assign per SIP call on the network.
Thisfield can be configured only when the SIP Codec selected is User Defined.

SIP Sample Interval

Enter the sample interval in milliseconds that the codec must operate in.

Max Number of Calls per Radio

Enter the maximum number of calls per radio.

Metric Collection

Select the check box to enable metric collection. Traffic stream metrics are aseries of statistics
about VoIP over your wireless LAN that inform you of the QoS of the wireless LAN. For the
access point to collect measurement values, traffic stream metrics must be enabled. When
thisis enabled, the controller begins collecting statistical data every 90 seconds for the
802.11b/g interfaces from all associated access points. If you are using Vol P or video, this
feature should be enabled.

Controller > 802.11b or g or n > Parameters

Use this option
channel status,
controller(s).

to create or modify atemplate for configuring 802.11b/g/n parameters (such as power and
datarates, channel list, and CCX location measurement) and/or applying these settings to

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller >802.11b or g or n > Parameters.

Table 31: Controller > 802.11b or g or n > Parameters

Field Description
Policy Name Enter the name of the security policy in force.
Beam Forming Choose Enable or Disable from the drop-down list. Beam forming refers to a general signal processing

technique used to control the directionality of the reception or transmission of asignal.

Threshold

Transmitted Power Enter the transmitted power threshold. The valid range is from -50 to -80.
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Controller > 802.11b or g or n > Parameters .

Field

Description

Beacon Period

Therate at which the SSID is broadcast by the access point (the amount of time between beacons). The
valid range is from 100 to 600 milliseconds.

DTIM Period

The number of beacon intervals that might elapse between transmission of beacon frames containing a
traffic indicator message (TIM) element whose delivery count field is 0. Thisvalueistransmitted in the
DTIM period field of beacon frames. When client devices receive a beacon that containsa DTIM, they
normally “wake up” to check for pending packets. Longer intervals between DTIMs let clients sleep
longer and preserve power. Conversely, shorter DTIM periods reduce the delay in receiving packets but
use more battery power because clients wake up more often.

The DTIM period is not applicable in controller Version 5.0.0.0 and later.

Fragmentation Threshold

Determine the size at which packets are fragmented (sent as several piecesinstead of as one block). Use
alow setting in areas where communication is poor or where there is agreat deal of radio interference.
The default value is 2346.

802.11e Max Bandwidth

Percentage for 802.11e max bandwidth. The default value is 100.

Dynamic Assignment

From the Dynamic Assignment drop-down list, choose any one of the following dynamic transmit power
assignment modes:

« Automatic—The transmit power is periodically updated for all access points that permit this
operation.

¢ On Demand—Transmit power is updated when you click Assign Now.

« Disabled—No dynamic transmit power assignments occur and values are set to their global default.

Thedefault is Automatic. The power level sand avail able channel s are defined by the country code setting
and are regulated on a country by country basis.

Dynamic Tx Power
Control

Select this check box to enable DTPC support. If this option is enabled, the transmit power level of the
radio is advertised in the beacons and the probe responses.

Assignment Mode

From the Assignment M ode drop-down list, choose any one of the foll owing dynamic channel assignment
modes:

« Automatic—The channel assignment is periodically updated for all access points that permit this
operation.

« On Demand—Channel assignments are updated when desired.

« Disabled—No dynamic channel assignments occur and values are set to their global default.

The default is Automatic.
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. Controller > 802.11b or g or n > Parameters

Field

Description

Avoid Foreign AP
Interference

Enable this Radio Resource Management (RRM) foreign 802.11 interference-monitoring field to have
Radio Resource Management consider interference from foreign (non-Cisco access points outside the
RF/mobility domain) access points when assigning channels to Cisco access points. Disable thisfield to
have Radio Resource Management ignore this interference.

In certain circumstances with significant interference energy (dB) and load (utilization) from Foreign
access points, Radio Resource Management might adjust the channel assignment to avoid these channels
(and sometimes adjacent channels) in Cisco access points close to the Foreign access points to increase
capacity and reduce variability for the Cisco WLAN Solution.

Avoid Cisco AP Load

Enable this Radio Resource Management (RRM) bandwidth-sensing field to have controllers consider
the traffic bandwidth used by each access point when assigning channels to access points. Disable this
field to have Radio Resource Management ignore this value.

In certain circumstances and with denser deployments, there might not be enough channels to properly
create perfect channel reuse. In these circumstances, Radio Resource Management can assign better
reuse patterns to those APs that carry more traffic load.

Avoid non 802.11 Noise

Enable this Radio Resource Management (RRM) noise-monitoring field to have access points avoid
channels that have interference from non-Access Point sources, such as microwave ovens or Bluetooth
devices. Disable thisfield to have Radio Resource Management ignore this interference.

In certain circumstances with significant interference energy (dB) from non-802.11 noise sources, Radio
Resource Management might adjust the channel assignment to avoid these channels (and sometimes
adjacent channels) in access points close to the noise sources to increase capacity and reduce variability
for the Cisco WLAN Solution.

Signal Strength
Contribution

This check box is always enabled (not configurable). Radio Resource Management (RRM) constantly
monitors the relative location of all access points within the RF/mobility domain to ensure near-optimal
channel reuse. The net effect isan increase in Cisco WLAN Solution capacity and areductionin
co-channel and adjacent channel interference.

Data Rates

The datarates set are negotiated between the client and the controller. If the datarateis set to Mandatory,
the client must support it to use the network. If adatarateis set as Supported by the controller, any
associated client that also supports that same rate might communi cate with the access point using that
rate. But it isnot required that aclient be ableto use all the rates marked Supported to associate 6, 9, 12,
18, 24, 36, 48, and 54 Mbps.

For each rate, adrop-down list selection of Mandatory or Supported is available. Each data rate can also
be set to Disabled to match client settings.

Channel List

Choose between all channels, country channels, or DCA channels based on the level of monitoring you
want. Dynamic Channel Allocation (DCA) automatically selects a reasonably good channel allocation
among a set of managed devices connected to the controller.

Mode

Enable or disable the broadcast radio measurement request. When enabled, this parameter enhances the
location accuracy of clients.

Interval

Interval in seconds between measurement regquests.

The Cisco Compatible Extension location measurement interval can be changed only when measurement
mode is enabled.
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Controller > 802.11b or g or n > Roaming Parameters .

Controller > 802.11b or g or n > Roaming Parameters

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller >802.11b or g or n > Roaming Parameters.

Table 32: Controller > 802.11b or g or n > Roaming Parameters

Field Description

Mode Choose Default Values or Custom Values from the drop-down list. If you select Default Values, the roaming
parameters are unavailable and the default values are displayed.

Minimum RSSI Enter avalue for the minimum Received Signal Strength Indicator (RSSI) required for the client to associate

toan accesspoint. If the client average received signal power dips below thisthreshold, reliable communication
isusualy impossible. Therefore, clients must already have found and roamed to another access point with a
stronger signal before the minimum RSS| value is reached. Range: -80 to -90 dBm. Default: -85 dBm.

Roaming Hysteresis

Enter avalueto indicate how strong the signal strength of aneighboring access point must bein order for the
client toroamtoit. Thisfield is intended to reduce the amount of ping ponging between access points if the
client isphysically located on or near the border between two access points. Range: 2 to 4 dB. Default: 2 dB.

Adaptive Scan
Threshold

Enter the RSSI value, from a client associated access point, below which the client must be able to roam to
aneighboring access point within the specified transition time. Thisfield a so provides a power-save method
to minimize the time that the client spends in active or passive scanning. For example, the client can scan
slowly when the RSS! is above the threshold and scan more rapidly when below the threshold. Range: -70
to-77 dB. Default: -72 dB.

Note The Scan Threshold and Transition Time parameters guarantee aminimum level of client roaming
performance. Together with the highest expected client speed and roaming hysteresis, these
parameters make it possible to design awireless LAN network that supports roaming simply by
ensuring a certain minimum overlap distance between access points.

Transition Time

Enter the maximum time allowed for the client to detect a suitable neighboring access point to roam to and
to complete the roam whenever the RSSI from the client associated access point is below the scan threshold.
Range: 1 to 10 seconds. Default: 5 seconds.

Note The Scan Threshold and Transition Time parameters guarantee a minimum level of client roaming
performance. Together with the highest expected client speed and roaming hysteresis, these
parameters make it possible to design awireless LAN network that supports roaming simply by
ensuring a certain minimum overlap distance between access points.

Controller > CLI > General

Usethisoptionto create templates containing aset of CLI commands and apply them to one or more controllers
from Prime Infrastructure. These templates are meant for provisioning features in multiple controllers for
which there is no SNMP support or custom Prime Infrastructure user interface. The template contents are
simply acommand array of strings. No support for substitution variables, conditionals, and the like exist.

The CLI sessions to the device are established based on user preferences. The default protocol is SSH.
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. Controller > FlexConnect > FlexConnect AP Groups

\)

Note |f the Controller Telnet credentials check fails or the Controller CLI template fails with an invalid username
and password even though the correct username and password are configured on the controller, check whether
the controller has exceeded the number of CLI connectionsit can accept. If the connections have exceeded
the maximum limit, then either increase the maximum allowed CL | sessions or terminate any preexisting CLI
sessions on the controller, and then retry the operation.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > CL1 > General.

Table 33: Controller > CLI > General

Field Description

Commands Enter the series of CLI commands.

Refresh Config after Apply Select the Refresh Config after Apply check box to perform arefresh config on
the controller after the CLI template is applied successfully.

Save Config to Flash after apply Select the Save Config to Flash after apply check box to save the configuration.

Reboot Controller after apply

Select the Reboot Controller after apply check box to reboot the controller.

Ignore errorson Apply Templateto Controllers| Select thelgnoreerrorson Apply Templateto Controllerstoignoreall theerrors

while applying the template.

Controller > FlexConnect > FlexConnect AP Groups

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > FlexConnect > FlexConnect AP Groups.

Table 34: Controller > FlexConnect > FlexConnect AP Groups

Field

Description

General

Primary RADIUS

The primary RADIUS authentication servers for this AP group. If a RADIUS authentication
server is not present on the controller, Prime Infrastructure configured RADIUS server does

not apply.

Port Number

Enter the port number. of the primary RADIUS server.

Shared Secret

Enter the shared secret in the text box.

Confirm Shared Secret

Re-enter the shared secret.

Secondary RADIUS

The secondary RADIUS authentication serversfor this AP group. If aRADIUS authentication
server is not present on the controller, Prime Infrastructure configured RADIUS server does

not apply.
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Controller > FlexConnect > FlexConnect AP Groups .

Field

Description

FlexConnect AP

An access point Ethernet MAC address cannot exist in more than one FlexConnect group on
the same controller. If more than one group isapplied to the same controller, select the Ether net
MAC check box to unselect an access point from one of the groups. You can save this change
or apply it to controllers.

FlexConnect Configuration

Enables loca authentication for a FlexConnect group.

Make sure that the Primary RADIUS Server and Secondary RADIUS Server fields
are set to None on the General tab.

Note

FlexConnect Local Authentication

Enables local authentication for this FlexConnect group. The default value is unsel ected.

Note When you attempt to usethisfeature, awarning messageindicatesthat it isalicensed
feature.
Note You can click the Users configured in the group link that appears at the bottom

of the page to view thelist of FlexConnect users. You can create FlexConnect users
only after you save the FlexConnect AP Group.

EAP Type

Allows a FlexConnect access point to authenticate clients using LEAP.

To allow a FlexConnect access point to authenticate clients using EAP-FAST, select the
EAP-FAST check box. To use manual PAC provisioning, enter the key used to encrypt and
decrypt PACsin the EAP-FAST Key and Confirm EAP-FAST Key text boxes.

Auto Key Generation

Allows PACsto be sent automatically to clientsthat do not have one during PAC provisioning.

EAP-FAST Key

The authority identifier of the EAP-FAST server. The identifier must be 32 hexadecimal
characters.

EAP-FAST Authority ID

The authority identifier of the EAP-FAST server in text format. You can enter up to 32
hexadecimal characters.

EAP-FAST Authority Info

The authority information of the EAP-FAST server.

EAP-FAST Pac Timeout

The number of seconds for the PAC to remain viable in the edit box. The valid rangeis 2 to
4095 seconds.

Image Upgrade

FlexConnect AP Upgrade

Select to upgrade the FlexConnect access points.

Subordinate M aximum Retry Count

The maximum retries for the subordinate to undertake to start the download from the primary
in the FlexConnect group. This option is available only if you select the FlexConnect AP
Upgrade check box.

Note You can add an access point as a primary access point only if the FlexConnect AP

Upgr ade check box is enabled on the General tab.

VLAN-ACL Mapping

Use the edit table on this tab to add VLAN-ACL mappings.

VLAN ID

Thevalid VLAN ID rangeis 1 to 4094.

Ingress ACL

Choose an Ingress ACL.
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Field

Description

Egress ACL

Choose an Egress ACL.

WLAN-ACL Mapping

Use the edit table on this tab to add WLAN-ACL mappings.

WLAN ID

WLAN ID.

WLAN Profile Name

Choose aWLAN profile.

WebAuth ACL

Choose a WebAuth ACL.

Local Split

Use the edit table on this tab to add or select Local-Split ACLs.

WLAN Profile Name

Choose aWLAN profile name from the list.

Local-Split ACL Choose alocal-split ACL.

Web Policies Use the edit table on this tab to add or select Web Policy ACLs.

Web-Policy ACL Choose aWeb Policy ACL. You can add up to a maximum of 16 Web-Policy ACLSs.
Central DHCP Use the edit table on thistab to add or select Central DHCP for each WLAN profile.

WLAN Profile Name

Choose aWLAN profile name from the list.

Central DHCP Choose Enable to enable central DHCP for this profile.
Override DNS Choose Enable to enable DNS override for this profile.
NAT-PAT Choose Enabl e to enable network address and port address translation for this profile.

Controller > IPv6

The following topics contain field descriptions for pages found in Configuration > Templates > Features

and Technologies > Controller > [ Pv6.

« Controller > |Pv6 > Neighbor Binding Timers
* Controller > IPv6 > RA Guard
« Controller > IPv6 > RA Throttle Policy

Controller > IPv6 > Neighbor Binding Timers

The following table describes the Template Detail fieldsin Configuration > Templates > Features and

Technologies > Controller > 1Pv6 > Neighbor Binding Timers.
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Controller > IPv6 > RA Guard .

Table 35: Controller > IPv6 > Neighbor Binding Timers

Field

Description

Down Lifetime Interval

Thisfield enables the down lifetime. If you have selected this check box, specify the valuein the Down
Lifetime Interval text box. Thisdown lifetimeinterval indicates the maximum time, in seconds, an entry
learned from adown interface is kept in the binding table before the entry is deleted or proof is received
that the entry isreachable. The rangeis 0 to 86400 seconds, and the default valueis 0.

Reachable Lifetime
Interval

Thisfield enables the reachable lifetime. If you have selected this check box, specify the valuein the
Reachable Lifetime Interval text box. The reachable lifetime interval indicates the maximum time, in
seconds, an entry is considered reachable without getting a proof of reachability (direct reachability
through tracking, or indirect reachability through Neighbor Discovery protocol [NDP] inspection). After
that, the entry is moved to stale.The range is 0 to 86400 seconds, and the default valueis 0.

Stale Lifetime Interval

Thisfield enables the stale lifetime. If you have selected this check box, specify the value in the Stale
Lifetime Interval text box. The stale lifetime interval indicates the maximum time, in seconds, a stale
entry iskept in the binding table before the entry is deleted or proof isreceived that the entry isreachable.
Therangeis 0 to 86400 seconds, and the default value is 0.

Controller > IPv6 > RA Guard

RA Guard isaUnified Wireless solution used to drop RA from wireless clients. It is configured globally, and
by default it is enabled. You can create or modify atemplate for configuring 1Pv6 Router Advertisement
parameters.

Controller > IPv6 > RA Throttle Policy

Use this option to limit the amount of multicast Router Advertisements (RA) circulating on the wireless
network. You can create or modify atemplate for configuring IPv6 Router Advertisement parameters such
as RA Throttle Policy, Throttle Period, and other options.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller> | Pv6 > RA Throttle Policy.

Table 36: Controller > IPv6 > RA Throttle Policy

Field Description

RA Throttle Policy | Enables the RA throttle policy.

Throttle Period Duration of thethrottle period in seconds. Therangeis 10 to 86400 seconds.

Max Through The number of RA that passes through over a period in seconds.

<<not present>>

Interval Option | Indicates the behavior in case of RA with an interval option.

<<not present>>

Allow At-least Indicates the minimum number of RA not throttled per router.

<<not present>>
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Field Description

Allow At-most I ndicates the maximum number of RA not throttled per router.

<<not present>>

Controller > Location

The following topics describe the fields on the Configuration > Templates > Features and Technologies
> Controller > Location page.

« Controller > Location > Global BLE Configuration
* Controller > Location > Location Configuration > General

« Controller > Location > L ocation Configuration > Advanced

Controller > Location > Global BLE Configuration

The following table describes the fields on Configuration > Templates > Features and Technologies >
Controller > Location > Global BLE Configuration.

Table 37: Controller > Location > Global BLE Configuration

Field Description

Beacon Interval | Enter the BLE transmission interval in hertz (Hz).

Beacon Id Fixed Beacon Ids. For CUWN devices, the fixed Beacon Id index are from 1 to 5 and for CUWN-1OS and UA
devices, the Beacon |d index are from O to 4.

uuid A unique identifier defined by the Beacon administrator.

Tx Power A calibrated indicator of the RSSI of the transmitted measured at a 1m distance.

(dBM)

Beacon Status | Beacon status. Enable or Disable

Controller > Location > Location Configuration > General

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Location > L ocation Configuration > General.

Table 38: Controller > Location > Location Configuration > General

Field Description

RFID Tag Data Collection Select the check box to enable tag collection. Before the mobility services engine can collect asset
tag data from controllers, you must enable the detection of active RFID tags using the config rfid
status enable command on the controllers.
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Field Description

Calibrating Client Select the check box to enable calibration for the client. Controllers send regular S36 or S60 requests
(depending on the client capability) by way of the access point to calibrating clients. Packets are
transmitted on al channels. All access pointsirrespective of channel (and without achannel change)
gather RSSI data from the client at each location. These additional transmissions and channel
changes might degrade contemporaneous voice or video traffic. To use all radios (802.11a/b/g/n)
available, you must enable multiband in the Advanced tab.

Normal Client Select the check box to have anoncalibrating client. No S36 requests are transmitted to the client.
S36 and S60 are client drivers compatible with specific Cisco Compatible Extensions. S36 is
compatible with CCXv2 or later. S60 is compatible with CCXv4 or later. For details, see Cisco
Context Aware and Location FAQ.

Tags, Clients and Rogue Specify how many seconds should elapse before notification of the found tag, client, rogue AP, or

APS/Clients rogue client.

For Clients Enter the number of seconds after which RSSI measurements for clients should be discarded.

For Calibrating Clients Enter the number of seconds after which RSSI measurements for calibrating clients should be
discarded.

For Tags Enter the number of seconds after which RSSI measurements for tags should be discarded.

For Rogue APs Enter the number of seconds after which RSSI measurement for rogue access points should be
discarded.

Controller > Location > Location Configuration > Advanced

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > Location > L ocation Configuration > Advanced.

Table 39: Controller > Location > Location Configuration > Advanced

Field Description

RFID Tag Data Timeout Enter avalue in seconds to set the RFID tag data timeout.

Calibrating Client Multiband | Select the check box to send S36 and S60 packets (where applicable) on al channels. Calibrating
clients must be enabled on the General tab.

Controller > Management

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > Management.

« Controller > Management > Legacy Syslog
« Controller > Management > Local Management User
« Controller > Management > Telnet SSH

* Controller > Management > Trap Control
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« Controller > Management > Trap Receiver

Controller > Management > Legacy Syslog

\)

Note Legacy Syslog appliesto controllers Version 5.0.6.0 and earlier.

For basic information about creating this template, see the Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure User Guide.

Controller > Management > Local Management User
Use this option to configure local users, their privilege level, and password.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > Management > L ocal Management User.

Table 40: Controller > Management > Local Management User

Field Description

User Name Enter atemplate username.

Password Enter a password for thislocal management user template.

Confirm Password Reenter the password.

Access Level Use the Access Level drop-down list to choose either Read Only or Read Write.

Update Telnet Credentials | Select the Update Telnet Credentials check box to update the user credentials in Prime Infrastructure
for Telnet/SSH access.

Note If the template is applied successfully and the Update Telnet Credentials option is enabled,
the applied management user credentials are used in Prime Infrastructure for Telnet/SSH
credentials to that applied controller.

Controller > Management > Telnet SSH

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > Management > Telnet SSH.

Table 41: Controller > Management > Telnet SSH

Field Description

Session Timeout Enter the number of minutes a Telnet session is allowed to remain inactive before being logged off. A
zero means there is no timeout. The valid range is 0 to 160, and the default is 5.

Maximum Sessions Enter the number of simultaneous Telnet sessions allowed. The valid rangeis 0 to 5, and the default is
5. New Telnet sessions can be allowed or disallowed on the DS (network) port. New Telnet sessions
are aways allowed on the service port.
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Controller > Management > Trap Control .

Field

Description

Allow New Telnet Session

Select Yesto allow new Telnet sessions on the DS port or select No to disallow them. New Telnet
sessions can be allowed or disallowed on the DS (network) port. New Telnet sessionsare alwaysallowed
on the service port. The default is Yes.

Allow New SSH Session

Select Yesto allow Secure Shell Telnet sessions or select No to disallow them. The default is Yes.

Controller > Management > Trap Control

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Management > Trap Control.

Table 42: Controller > Management > Trap Control

Field Description
Select All Traps Select this check box to enable all of the traps on this page.
SNMP Authentication The SNMPv2 entity has received a protocol message that is not properly authenticated. When a user

who is configured in SNMP V3 mode tries to access the controller with an incorrect password, the
authentication fails and a failure message is displayed. However, no trap logs are generated for the
authentication failure.

Link (Port) Up/Down

Select the Link (Port) Up/Down check box to change the state to up or down.

Multiple Users Select the M ultiple User s check box to allow two usersto log in with the same login ID.

Spanning Tree Select the Spanning Tree check box to enable spanning tree traps. See the STP specification for
descriptions of individual parameters.

Rogue AP Select the Rogue AP check box to send atrap with the MAC address whenever arogue access point

is detected or when arogue access point was detected earlier and no longer exists.

Controller Config Save

Select the Controller Config Save check box to send a notification when the configuration is
modified.

802.11 Association

Select the 802.11 Association check box to send atrap when aclient isassociated to aWLAN. This
trap does not guarantee that the client is authenticated.

802.11 Disassociation

Select the 802.11 Disassociation check box to send the disassociate notification when the client
sends a disassociation frame.

802.11 Deauthentication

Select the 802.11 Deauthentication check box to send the deauthenticate notification when the
client sends a deauthentication frame.

802.11 Failed Authentication

Select the 802.11 Failed Authentication check box to send the authenticate failure notification when
the client sends an authentication frame with a status code other than successful.

802.11 Failed Association

Select the 802.11 Failed Association check box to send the associate failure notification when the
client sends an association frame with a status code other than successful.

Excluded

Select the Excluded check box to send the associate failure notification when aclient is excluded.
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. Controller > Management > Trap Control

Field

Description

AP Regjister

Select the AP Register check box to send anctification when aaccess point associates or disassociates
with the controller.

AP Interface Up/Down

Select the AP Interface Up/Down check box to send a notification when a access point interface
(802.11a/n or 802.11b/g/n) status goes up or down.

Load Profile Select the L oad Profile check box to send a notification when the load profile state changes between
PASSand FAIL.
Noise Profile Select the Noise Pr ofile check box to send a notification when the noise profile state changes between

PASS and FAIL.

Interference Profile

Select the | nter ference Profile check box to send a natification when the interference profile state
changes between PASS and FAIL.

Coverage Profile

Select the Cover age Pr ofile check box to send anotification when the coverage profil e state changes
between PASS and FAIL.

Channel Update

Select the Channel Update check box to send a notification when the dynamic channel algorithm
of an access point is updated.

Tx Power Update

Select the Tx Power Update check box to send a notification when the dynamic transmit power
agorithm of an access point is updated.

User Auth Failure

Select the User Auth Failure check box to send atrap to inform you that a client RADIUS
authentication failure has occurred.

RADIUS Server No Response

Select the RADIUS Server No Response check box to send atrap to indicate that no RADIUS
server(s) are responding to authentication requests sent by the RADIUS client.

ESP Authentication Failure

Select the check box to send a | Psec packets with invalid hashes were found in an inbound ESP SA.

ESP Replay Failure

Select the ESP Authentication Failure check box to send a notification when | Psec packets with
invalid sequence numbers were found in an inbound ESP SA.

Invalid SPI

Select the Invalid SPI check box to send a notification when a packet with an unknown SPI is
detected from the specified peer with the specified SPI using the specified protocol.

IKE Negotiation Failure

Select the check box | KE Negotiation Failure to send a notification when an attempt to negotiate
aphase 1 IKE SA fails. The notification counts are also sent as part of the trap, along with the current
value of the total negotiation error counters.

IKE Suite Failure

Select the IKE Suite Failure check box to send a notification when a attempt to negotiate a phase
2 SA suite for the specified selector fails. The current total failure counts are passed as well as the
notification type counts for the notify involved in the failure.

Invalid Cookie Select the I nvalid Cookie check box to send a notification when |SAKMP packets with invalid
cookies are detected from the specified source, intended for the specified destination. The initiator
and responder cookies are aso sent with the trap.

WEP Decrypt Error Select the WEP Decrypt Error check box to send a notification when the controller detectsa WEP

decrypting error.
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Field Description

Signature Attack Select the Signature Attack check box to enable the 802.11 security trap.

Controller > Management > Trap Receiver

If you have monitoring devices on your network that receive SNMP traps, you can use this page to add atrap
receiver template.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Management > Trap Receiver.

Table 43: Controller > Management > Trap Receiver

Field Description

IP Address | Enter the IP address of the server.

Admin Select this check box to enable the administrator status if you want SNMP traps to be sent to the receiver.
Status

Controller > Mesh > Mesh Settings
Use this option to configure an access point to establish a connection with the controller.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Mesh > Mesh Settings.

Table 44: Controller > Mesh > Mesh Settings

Field Description

RootAP to MeshAP Range The Root AP to Mesh AP Rangeis 12000 feet by default. Enter the optimum distance (in feet) that
should exist between the root access point and the mesh access point. This global field appliesto
all access points when they join the controller and all existing access pointsin the network.

Client Accesson Backhaul Link | The Client Access on Backhaul Link check box is not selected by default. When this option is
enabled, mesh access points can associate with 802.11a/n wireless clients over the 802.11a/n
backhaul. This client association is in addition to the existing communication on the 802.11a/n
backhaul between the root and mesh access points.

Note This feature applies only to access points with two radios.

Background Scanning Select the Background Scanning check box to enable background scanning or unselect it to disable
the feature. The default value is disabled. Background scanning allows Cisco Aironet 1510 Access
Points to actively and continuously monitor neighboring channels for more optimal paths and
parents.

Mesh DCA Channels TheMesh DCA Channelscheck box isnot selected by default. Select this option to enable backhaul
channel deselection on the Controller using the DCA channel list configured in the Controller. Any
change to the channelsin the Controller DCA list is pushed to the associated access points. This
feature applies only to the 1524SB mesh access points. For more information on this feature, see
the Controller Configuration Guide.
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Field

Description

Globa Public Safety

Select the Global Public Safety check box to enable global public safety.

Mesh RAP Downlink

Choose either 2.4GHz or 5GHz radios for RAP downlink backhaul from the Mesh RAP

Backhaul Downlink Backhaul drop-down list.

Security Mode From the Security Mode drop-down list, choose EAP (Extensible Authentication Protocol) or PSK
(pre-shared key).

Controller > PMIP

Proxy Mobile IPv6 is a network-based mobility management protocol that supports a mobile node by acting
as the proxy for the mobile node in any 1P mobility-related signaling. The mobility entitiesin the network
track the movements of the mobile node and initiate the mobility signaling and set up the required routing

state.

The main functional entities are the Local Mobility Anchor (LMA) and Mobile Access Gateway (MAG). The
LMA maintainsthe reachability state of the mobile node and isthe topological anchor point for the IP address
of the mobile node. The MAG performs the mobility management on behalf of a mobile node. The MAG

resides on the access link where the mobile nodeis anchored. The controller implementsthe MAG functionality.

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies> Controller > PMIP.

« Controller > PMIP > Global Config

* Controller > PMIP > LMA Config

 Controller > PMIP > PMIP Profile

Controller > PMIP > Global Config

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > PMIP > Global Config.

Table 45: Controller > PMIP > Global Config

Field

Description

Domain Name

The name of the domain.

Maximum Bindings Allowed

Maximum number of binding updates that the controller can send to the MAG. Thevalid range
isfrom 0O to 40000.

Binding Lifetime

Lifetime of the binding entriesin the controller. The valid range is from 10 to 65535 seconds.
The default value is 65535. The binding lifetime should be a multiple of 4 seconds.

Binding Refresh Time

Refresh time of the binding entriesin the controller. The valid rangeisfrom 4 to 65535 seconds.
The default value is 300 seconds. The binding refresh time should be a multiple of 4 seconds.

Binding Initial Retry Timeout

Initial timeout between the proxy binding updates (PBUs) when the controller does not receive
the proxy binding acknowledgments (PBAS). The valid range is from 100 to 65535 seconds.
The default value is 1000 seconds.
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Controller > PMIP > LMA Config .

Field

Description

Binding Maximum Retry Timeout

Maximum timeout between the proxy binding updates (PBUs) when the controller does not
receive the proxy binding acknowledgments (PBAS). The valid range is from 100 to 65535
seconds. The default value is 32000 seconds.

Replay Protection Timestamp

Maximum amount of time difference between the timestamp in the received proxy binding
acknowledgment and the current time of the day. Thevalid rangeisfrom 1 to 255 milliseconds.
The default value is 7 milliseconds.

Minimum BRI Retransmit Timeout

Minimum amount of time that the controller waits before retransmitting the BRI message. The
valid range is from 500 to 65535 seconds.

Maximum BRI Retransmit Timeout

M aximum amount of timethat the controller waits before retransmitting the Binding Revocation
Indication (BRI) message. The valid range is from 500 to 65535 seconds. The default valueis
2000 seconds.

BRI Retries

Maximum number of times that the controller retransmits the BRI message before receiving
the Binding Revocation Acknowledgment (BRA) message. The valid rangeis from 1 to 10.
The default valueis 1.

Controller > PMIP > LMA Config

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > PMIP > LMA Config.

Table 46: Controller > PMIP > LMA Config

Field Description

LMA Name Name of the LMA connected to the controller.

Address

LMA IP IP address of the LM A connected to the controller.

Controller > PMIP > PMIP Profile

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > PMIP > PMIP Profile.

Table 47: Controller > PMIP > PMIP Profile

Field Description

PMIP Profile Enter the profile name, then click Add.

Network Accessldentifier | Name of the Network Access Identifier (NAI) associated with the profile.

LMA Name Name of the LMA with which the profileis to be associated.

Access Point Node Name of the access point node connected to the controller.
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Controller >Security

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > Security.

« Controller > Security > AAA LDAP Servers

« Controller > Security > AAA > RADIUS Acct Servers

* Controller > Security > AAA > RADIUS Auth Servers

« Controller > Security > AAA > TACACS+ Servers

« Controller > Security > Local EAP > EAP-FAST Parameters

« Controller > Security > Local EAP > Genera - Local EAP

* Controller > Security > Local EAP > Local EAP Profiles

* Controller > Security > Wireless Protection Policies > Friendly Access Point
« Controller > Security > Wireless Protection Policies > Ignored Rogue AP
« Controller > Security > Wireless Protection Policies > Rogue AP Rules

* Controller > Security > Wireless Protection Policies > Rogue Policies

« Controller > Security > Access Control Lists

« Controller > Security > CPU Access Control List

« Controller > Security > File Encryption

* Controller > Security > IP Groups

« Controller > Security > 1Pv6 Groups

« Controller > Security > Protocol Groups

« Controller > Security > URL ACLs

Controller > Security > AAA LDAP Servers

This section explains how to configure a Lightweight Directory Access Protocol (LDAP) server as abackend
database, similar to aRADIUS or local user database. An LDAP backend database allows the controller to
query an LDAP server for the credentials (username and password) of a particular user. These credentials are
then used to authenticate the user. For example, local EAP might use an LDAP server asits backend database
to retrieve user credentials.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Security > AAA > LDAP Servers.

Table 48: Controller > Security > AAA LDAP Servers

Field Description
Server Address Enter the | P address of the server.
Port Number Port number of the controller to which the access point is connected.
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Controller > Security > AAA > RADIUS Acct Servers .

Field

Description

Bind Type

Choose Authenticated or Anonymous. If you choose Authenticated, you must enter a bind username and
password aswell. A bind is a socket opening that performs alookup. Anonymous bind requests are rejected.

Server User Base DN

Enter the distinguished name of the subtree in the LDAP server that contains alist of al the users.

Server User Attribute

Enter the attribute that contains the username in the LDAP server.

Server User Type

Enter the ObjectType attribute that identifies the user.

Retransmit Timeout

Enter the number of seconds between retransmissions. Thevalid rangeisfrom 2 to 30 seconds, and the default
vaueis 2 seconds.

Admin Status

Select the Enable check box if you want the LDAP server to have administrative privileges.

Controller > Security > AAA > RADIUS Acct Servers

This page alows you to add a RADIUS accounting template or make modifications to an existing RADIUS
accounting template.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Security > AAA > RADIUS Acct Servers.

Table 49: Controller > Security > AAA > RADIUS Acct Servers

Field Description
Server Address Enter the server address.
Port Number Enter the port address.

Shared Secret Format

Choose either ASCI | or Hex.

Note Regardless of the format you choose, for security reasons, only ASCII isvisibleon
thewirelessLAN controller (and Prime Infrastructure). For thisreason, you cannot
use atemplate to replicate the configuration on a second controller during auto
provisioning. You should set the key format again in the template in case a
discovered template is applied to another device.

Shared SecretConfirm Shared Secret | Enter and confirm the RADIUS shared secret used by the server you specified.
Admin Status Select the Enable check box if you want to establish administrative privileges for the server.
Network User Select if you want to enable the network user authentication. If this option is enabled, this

entry is considered as the RADIUS authenticating server for the network user.

Retransmit Timeout

Specify the time in seconds after which the RADIUS authentication request times out and a
retransmission by the controller occurs. You can specify a value from 2 to 30 seconds.

IPsec Enable

Select the Enable check box to enable | P security.
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. Controller > Security > AAA > RADIUS Auth Servers

Controller > Security > AAA > RADIUS Auth Servers

Usethisoptionto add aRADIUS authenti cation templ ate or make modificationsto an existing template. After
these server templates are configured, controller users who log in to the controller through the CLI or GUI
are authenticated.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Security > AAA > RADIUS Auth Servers.

Table 50: Controller > Security > AAA > RADIUS Auth Servers

Field Description
Server Address Enter the server address.
Port Number Enter the port address.

Shared Secret Format

Choose either ASCI | or hex.

Note Regardless of the format you choose, for security reasons, only ASCII isvisible onthe WLC
(and Prime Infrastructure). For this reason, you cannot use atemplate to replicate the
configuration on a second controller during auto provisioning. You should set the key format
again in the template in case a discovered template is applied to another device.

Shared Secret Enter the RADIUS shared secret used by your specified server.

Confirm Shared Secret | Reenter the RADIUS shared secret used by your specified server.

Key WRAP Select the check box if you want to enable key wrap. If this check box is enabled, the authentication
request is sent to RADIUS servers that have following key encryption key (KEK) and message
authenticator code keys (MACK) configured. When enabled, the following fiel ds appear:

* Shared Secret Format: Enter ASCII or hexadecimal.

Note Regardless of the format you choose, for security reasons, only ASCII isvisible onthe WLC
(and Prime Infrastructure). For this reason, you cannot use atemplate to replicate the
configuration on a second controller during auto provisioning. You should set the key format
again in the template in the event a discovered template is applied to another device.

» KEK Shared Secret: Enter the KEK shared secret.
* MACK Shared Secret: Enter the MACK shared secret.

Note Each time the controller is notified with the shared secret, the existing shared secret is
overwritten with the new shared secret.

Admin Status Select if you want to enable administration privileges.

Support for RFC 3576 | Select if you want to enable support for RFC 3576. RFC 3576 is an extension to the Remote Authentication

Did In User Service (RADIUS) protocal. It allows dynamic changes to a user session and includes
support for disconnecting users and changing authorizations applicable to a user session. With these
authorizations, support is provided for Disconnect and Change-of-Authorization (CoA) messages.
Disconnect messages immediately terminate a user session, whereas CoA messages modify session
authorization attributes such as data filters.
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Controller > Security > AAA > RADIUS Auth Servers .

Field

Description

Network User

Select if you want to enable network user authentication. If thisoption isenabled, thisentry isconsidered
asthe RADIUS authenticating server for the network user.

Management User

Select if you want to enable management authentication. If thisoption isenabled, thisentry is considered
asthe RADIUS authenticating server for the management user.

Retransmit Timeout

Specify thetimein seconds after which the RADIUS authenti cation request times out and aretransmission
is attempted by the controller. You can specify avalue from 2 to 30 seconds.

IPsec

If you click to enable the I P security mechanism, additional | P security fields are added to the page.

IPsec Authentication

Choose which | P security authentication protocol to use. The optionsare HMAC-SHA1, HMAC-MD5,
and None.

Message A uthentication Codes (MAC) are used between two parties that share a secret key to validate
information transmitted between them. HMAC (Hash MAC) is a mechanism based on cryptographic
hash functions and can be used in combination with any iterated cryptographic hash function. HMAC-MD5
and HMAC-SHA 1 are two constructs of the HMAC using the MD5 hash function and the SHA1 hash
function. HMAC also uses a secret key for calculation and verification of the message authentication
values

IPsec Encryption

Select the | P security encryption mechanism to use:

« DES—Data Encryption Standard is a method of data encryption using a private (secret) key. DES
applies a 56-hit key to each 64-bit block of data.

* Triple DES—Data Encryption Standard that applies three keysin succession.

« AES 128 CBC—Advanced Encryption Standard uses keyswith alength of 128, 192, or 256 bitsto
encrypt blocks with alength of 128, 192, or 256 bits. AES 128 CBC uses a 128-hit data path in
Cipher Clock Chaining (CBC) mode.

* None—No I P security encryption mechanism.

IKE Authentication

The Internet Key Exchange (IKE) authentication is not an editable text box. Internet Key Exchange
protocol (IKE) is used as a method of distributing the session keys (encryption and authentication), as
well as providing away for the VPN endpoints to agree on how data should be protected. IKE keeps
track of connections by assigning a bundle of security associations (SAs) to each connection.

IKE Phase 1

Choose either aggressive or main. This setsthe IKE protocol. IKE phase 1 is used to negotiate how IKE
is protected. Aggressive mode passes more information in fewer packets, with the benefit of a slightly
faster connection, at the cost of transmitting the identities of the security gatewaysin the clear.

Lifetime

Set the timeout interval (in seconds) when the session expires.

IKE Diffie Hellman
Group

Set the IKE Diffie-Hellman group. The options are group 1 (768 bits), group 2 (1024 bits), or group 5
(1536 hits). Diffie-Hellman techniques are used by two devices to generate a symmetric key where you
can publicly exchange values and generate the same symmetric key.

Although al three groups provide security from conventional attacks, Group 5 is considered more secure
because of its larger key size. However, computations involving Group 1-based or Group 2-based keys
might occur slightly faster because of their smaller prime number size.
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. Controller > Security > AAA > TACACS+ Servers

Controller > Security > AAA > TACACS+ Servers

Use this option to add a TACACS+ server or make modifications to an existing TACACS+ server template.
After these server templates are configured, controller users who log in to the controller through the CL1 or
GUI are authenticated.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Security > AAA > TACACS+ Servers.

Table 51: Controller > Security > AAA > TACACS+ Servers

Field Description
Server Type Select one or more server types by selecting their respective check boxes. The following server typesare
available:
« authentication—Server for user authentication/authorization.
« authorization—Server for user authorization only.
» accounting—Server for RADIUS user accounting.
Server Address Enter the | P address of the server.
Port Number Enter the port number of the server. The default is 49.

Shared Secret Format

Choose either ASCI | or hex.

Regardless of which format you choose, for security reasons, only ASCII isvisible on the WLC (and
Prime Infrastructure). For thisreason, you cannot use atemplate to replicate the configuration on asecond
controller during auto provisioning. Set the key format again in the template in the event a discovered
template is applied to another device.

Shared Secret Enter the TACACS+ shared secret used by your specified server.
Confirmed Shared Secret | Reenter the TACACS+ shared secret used by your specified server.
Admin Status Select if you want the LDAP server to have administrative privileges.

Retransmit Timeout

Enter thetime, in seconds, after which the TACACS+ authenti cation request times out and aretransmission
is attempted by the controller.

Controller > Security > Local EAP > EAP-FAST Parameters

This authentication type (Flexible Authentication via Secure Tunneling) uses a three-phased tunnel
authentication process to provide advanced 802.1X EAP mutual authentication. A username, password, and
PAC are used to perform mutual authentication with the RADIUS server through the access point. This page
allows you to add an EAP-FAST template or make modifications to an existing EAP-FAST template.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Security > Local EAP > EAP-FAST Parameters.

. Field Reference for Configuration Pages



| Field Reference for Configuration Pages
Controller > Security > Local EAP > General - Local EAP .

Table 52: Controller Security Local EAP EAP_FAST Parameters

Field Description

Timeto Live for the PAC Enter the number of daysfor the PAC to remain viable. Thevalid rangeis 1 to 1000 days, and
the default setting is 10 days.

Authority ID Enter the authority identifier of the local EAP-FAST server in hexadecimal characters. You
can enter up to 32 hexadecimal characters, but you must enter an even number of characters.

Authority Info Enter the authority identifier of the local EAP-FAST server in text format.

Server Key and Confirm Server Key | Enter the key (in hexadecimal characters) used to encrypt and decrypt PACs.

Anonymous Provision Select to enable anonymous provisioning. This feature allows PACs to be sent automatically
to clients that do not have one during PAC provisioning. If you disable this feature, PACs
must be manually provisioned.

Controller > Security > Local EAP > General - Local EAP

This page allows you to specify atimeout value for local EAP. You can then add or make changesto an
existing local EAP general template.

)

Note If any RADIUS serversare configured on the controller, the controller triesto authenticate the wireless clients
using the RADIUS serversfirst. Local EAPisattempted only if no RADIUS serversarefound, either because
the RADIUS serverstimed out or no RADIUS serverswere configured. If four RADIUS serversare configured,
the controller attempts to authenticate the client with the first RADIUS server, then the second RADIUS
server, and then local EAP. If the client attempts to then reauthenticate manually, the controller tries the third
RADIUS server, then the fourth RADIUS server, and then local EAP.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Security > Local EAP > General - Local EAP.

Table 53: Controller > Security > Local EAP > General - Local EAP

Field Description

Local Auth Active Timeout Enter the amount of time (in seconds) that the controller
attemptsto authenticate wireless clientsusing local EAP
after any pair of configured RADIUS serversfail. The
valid rangeis 1 to 3600 seconds, and the default setting
is 1000 seconds.

Note Enter the values specified below if you are using EAP-FAST,
manual password entry, one-time password, or 7920/7921 phones.
You must increase the 802.1x timeout values on the controller
(default=2 seconds) for the client to obtain the PAC using
automatic provisioning. The recommended and default timeout
on the Cisco ACS server is 20 seconds. Roaming fails if these
values are not set the same across multiple controllers.
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. Controller > Security > Local EAP > Local EAP Profiles

Field Description
Local EAP Identity Request Timeout 1

Loca EAP Identity Request Maximum Retries 20

Local EAP Dynamic WEP Key Index 0

Local EAP Request Timeout 20

Local EAP Request Maximum Retries 2

EAPOL-Key Timeout

1000 (in milliseconds)

EAPOL-Key Max Retries 2

Max Login Ignore Identity Response Choose Enable to limit the number of devices that can

be connected to the controller with the same username.

Controller > Security > Local EAP > Local EAP Profiles

Thispageallowsyouto add alocal EAP profile template or make modificationsto an existing template. L ocal
EAPisan authentication method that all ows users and wirel ess clientsto be authenticated locally. It is designed
for use in remote offices that want to maintain connectivity to wireless clients when the backend system
becomesdisrupted or the external authentication server goesdown. When you enablelocal EAP, the controller
serves as the authentication server and the local user database, thereby removing dependence on an external
authentication server. Local EAP retrieves user credentialsfrom thelocal user database or the LDAP backend
database to authenticate users.

Note

The LDAP backend database supports only these local EAP methods; EAP-TLS and EAP-FAST with
certificates. LEAP and EAP-FAST with PACs are not supported for use with the LDAP backend database.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Security > Local EAP > Local EAP Profiles.

Table 54: Controller > Security > Local EAP > Local EAP Profiles

Field

Description

EAP Profile Name

User-defined identification.
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Controller > Security > Wireless Protection Policies > Friendly Access Point .

Field

Description

Select Profile Methods

Choose the desired authentication type:

» LEAP—This authentication type leverages Cisco Key Integrity Protocol (CKIP) and
Multi-Modal Hashing (MM H) messageintegrity check (MIC) for dataprotection. A username
and password are used to perform mutual authentication with the RADIUS server through the
access point.

» EAP-FAST—This authentication type (Flexible Authentication via Secure Tunneling) uses a
three-phased tunnel authentication process to provide advanced 802.1X EAP mutual
authentication. A username, password, and PAC (protected access credential) are used to
perform mutual authentication with the RADIUS server through the access point.

» TLS—Thisauthentication type uses adynamic session-based WEP key derived from the client
adapter and RADIUS server to encrypt data. It requires a client certificate for authentication.

* PEAP—This authentication type is based on EAP-TLS authentication but uses a password
instead of aclient certificate for authentication. PEAP uses a dynamic session-based WEP
key derived from the client adapter and RADIUS server to encrypt data.

Certificate | ssuer

Determinewhether Cisco or another vendor i ssued the certificate for authentication. Only EAP-FAST
and TLSrequire a certificate.

Check Against CA Certificates

Select if you want the incoming certificate from the client to be validated against the certificate
authority (CA) certificates on the controller.

Verify Certificate CN ldentity

Select if you want the common name (CN) in the incoming certificate to be validated against the
common name of the CA certificate.

Check Against Date Validity

Select if you want the controller to verify that the incoming device certificate is still valid and has
not expired.

Local Certificate Required

Select if alocal certificate is required.

Client Certificate Required

Select if aclient certificate is required.

Controller > Security > Wireless Protection Policies > Friendly Access Point

Thistemplate allows you to import friendly internal access points. Importing these friendly access points
prevents nonlightweight access points from being falsely identified as rogues.

\}

Note Friendly Internal access pointswere previously referred to as Known APs.

The Friendly AP page identifies the MAC address of an access point, status, any comments, and whether or
not the alarm is suppressed for this access point.

Friendly access points can be added by either importing the access point or manually entering the access point
information:

 To import an access point using the Import feature:

* Select the Import from File check box.
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Step 1
Step 2
Step 3
Step 4
Step 5

Field Reference for Configuration Pages |

« Enter the file path or click Browse to navigate to the correct file.

\)

Note Usealinebreak to separate MAC addressesin thefilethat you import. For example, enter the MAC addresses
as follows:00:00:11:22:33:4400:00:11:22:33:4500:00:11:22:33:46

To manually add an access point, follow these steps:

Unselect the Import from File check box.

Enter the M AC address for the access point.

Choose Internal access point from the Status drop-down list.

Enter acomment regarding this access point, if necessary.

Select the Suppress Alarms check box to suppress al alarms for this access point.

Controller > Security > Wireless Protection Policies > Ignored Rogue AP

Step 1
Step 2
Step 3

Thelgnored Rogue AP Template page allows you to create or modify atemplate for importing ignored access
points. Access pointsin the Ignored AP list are not identified as rogues.

An Ignored Rogue AP template does not get applied to any controller. It suppresses the rogue AP/Adhoc
alarm if Ignored Rogue AP Template has the rogue MAC address when the controller reports the Rogue AP
to Prime Infrastructure and this MAC address is added to the Rogue AP Ignore-List on the controller.

I gnored rogue access points can be added by either importing the access point or manually entering the access
point information:

To import an ignored rogue access point using the Import feature. <<Import feature is Not present>>
Select the Import from File check box. <<Not present>>

Enter the file path or use the Browse button to navigate to the correct file. The import file must beaCSV filewith MAC
address (one MAC Address per line).<<Not present>>

Note For example, enter the MAC addresses as follows:00:00:11:22:33:4400:00:11:22:33:4500:00:11:22:33:46

What to do next

To manually add an ignored rogue access point unselect the Import from File check box. <<Not present>>

Controller > Security > Wireless Protection Policies > Rogue AP Rules

Rogue access point rules allow you to define rules to automatically classify rogue access points. Prime
Infrastructure applies the rogue access point classification rules to the controllers. These rules can limit the
appearance of arogue on maps based on RSS! level (weaker rogue access points are ignored) and time limit
(arogue access point is not flagged unlessiit is seen for the indicated period of time).

The rogue access point rules also help reduce false alarms.

Rogue classes include the following types:
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» Malicious Rogue—A detected access point that matches the user-defined malicious rules or has been
manually moved from the Friendly AP category.

« Friendly Rogue—Known, acknowledged, or trusted access point or a detected access point that matches
user-defined friendly rules.

« Unclassified Rogue—A detected access point that does not match the malicious or friendly rules.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Security > Wireless Protection Policies > Rogue AP Rules.

Table 55: Controller > Security > Wireless Protection Policies > Rogue AP Rules

Field Description

Rule Type Choose Malicious or Friendly from the drop-down list. A rogueis considered maliciousif a
detected access point matches the user-defined malicious rules or has been manually moved from
the Friendly AP category. A rogueisconsidered friendly if it isaknown, acknowledged, or trusted
access point or a detected access point that matches the user-defined Friendly rules.

Match Type Choose Match All Conditions or Match Any Condition.
Open Authentication Select the check box to enable open authentication.
Match Managed AP SSID Select the check box to enable the matching of a managed AP SSID.

Note Managed SSIDs are the SSIDs configured for the WLAN and known to the system.

Match User Configured SSID | Select the check box to enable the matching of user-configured SSIDs.

Note User-configured SSIDs are the SSI Dsthat are manually added. Enter the user-configured
SSIDs (one per line) in the Match User Configured SSID text box.

Minimum RSSI Select the check box to enable the Minimum RSSI threshold limit.

Note Enter the minimum RSSI threshold level (dB) inthetext box. The detected access point
isclassified as maliciousif it is detected above the indicated RSSI threshold.

Time Duration Select the check box to enable the Time Duration limit.

Note Enter the time duration limit (in seconds) in the text box. The detected access point is
classified asmaliciousif it isviewed for alonger period of time than the indicated time
limit.

Minimum Number Rogue Select the check box to enable the Minimum Number Rogue Clients limit. Enter the minimum
Clients number of rogue clients allowed. The detected access point is classified asmaliciousif the number

of clients associated to the detected access point is greater than or equal to the indicated value.

Controller > Security > Wireless Protection Policies > Rogue Policies
This page enables you to configure the rogue policy (for access points and clients) applied to the controller.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Security > Wireless Protection Policies > Rogue Policies.

Field Reference for Configuration Pages .



Field Reference for Configuration Pages |

. Controller > Security > Wireless Protection Policies > Rogue Policies

Table 56: Controller > Security > Wireless Protection Policies > Rogue Policies

Field

Description

Rogue L ocation Discovery Protocol

Determine whether or not the Rogue L ocation Discovery Protocol (RLDP) is connected to the
enterprise wired network. Choose one of the following:

« Disable—Disables RLDP on all access points.
e All APs—Enables RLDP on al access points.

* Monitor Mode APs—Enables RLDP only on access points in monitor mode.
Note With RLDR, the controller instructs a managed access point to associate with the
rogue access point and sends a specia packet to the controller. If the controller
receives the packet, the rogue access point is connected to the enterprise network.
This method works for rogue access points that do not have encryption enabled.

Expiration Timeout for Rogue AP
and Rogue Client Entries

Enter the expiration timeout (in seconds) for rogue access point entries.

Rogue Detection Report Interval

Enter the time interval in seconds at which the APs should send the rogue detection report to
the controller. A valid rangeis from 10 to 300 seconds, and the default value is 10 seconds.
Thisfeature is applicable to APs that are in monitor mode only.

Rogue Detection Minimum RSS|

Enter the minimum RSSI value that arogue should have for the APsto detect and for the rogue
entry to be created in the controller. A valid range is from -70 to -128 dBm, and the default
valueis-128 dBm. Thisfeatureis applicable to all the AP modes.

There can be many rogues with very weak RSS| values that do not provide any valuable
information in the rogue analysis. Therefore, you can use this option to filter the rogues by
specifying the minimum RSS! value at which the APs should detect rogues.

Rogue Detection Transient Interval
(Enter 0 to Disable)

Enter the timeinterval at which arogue has to be consistently scanned for by the AP after the
first time the rogue is scanned. By entering the transient interval, you can control the time
interval at which the AP should scan for rogues. The APs can filter the rogues based on their
transient interval values. The valid range is from 120 to 1800 seconds, and the default value
is0. Thisfeature is applicable to APs that are in monitor mode only

Validate Rogue Clients against
AAA

Select to enable the AAA validation of rogue clients.

Detect and Report Adhoc Networks

Select to enable detection and reporting of rogue clients participating in ad hoc networking.

Rogue on Wire

Automatically contains rogues that are detected on the wired network.

Using our SSID

Automatically contains rogues that are advertising your network’s SSID. If you |leave this
parameter unselected, the controller only generates an alarm when such arogue is detected.

Valid Client on Rogue AP

Automatically contains arogue access point to which trusted clients are associated. If you leave
this parameter unsel ected, the controller only generates an alarm when such arogueis detected.
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Controller > Security > Access Control Lists

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > Security > Access Control Lists.

Table 57: Controller > Security > Access Control Lists

Field Description

ACL Type | IPv6 is supported from controller Version 7.2.x.

Related Topics
* To create reusable grouped | P addresses, see Controller > System

« To create anew protocol group, see Controller > Security > Protocol Groups

Controller > Security > CPU Access Control List

N\

Note CPU ACL configuration with IPv6 is not supported in this release because all |P addresses of controllerson
interfaces use |Pv4 except the virtual interface.

Use the existing ACL s established in the Creating a FlexConnect Access Control List Template (see Cisco
Prime Infrastructure User Guide) to set traffic controls between the Central Processing Unit (CPU) and
Network Processing Unit (NPU).

Controller > Security > File Encryption

This page enables you to add afile encryption template or make modifications to an existing file encryption
template.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > Security > File Encryption.

Table 58: Controller > Security > File Encryption

Field Description

Encryption KeyConfirm Encryption Key | Enter an encryption key text string of exactly 16 ASCII characters.

Controller > Security > IP Groups

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Controller > Security > |P Groups.

To create IPv6 groups, see Controller > Security > | Pv6 Groups
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Table 59: Controller > Security > IP Groups

Field Description
IP Address Enter an 1Pv4 address format.
NetmaskNotation Netmask allows you to set the subnet mask in dotted-decimal notation rather than the CIDR notation

for the | P address property. A range of | P addresses defined so that only machines with |P addresses
within the range are allowed to access an Internet service.

CIDR Notation Classless InterDomain Routing (CIDR) notation is a protocol that allows the assignment of ClassC
| P addresses in multiple contiguous blocks. Use this protocol to add alarge number of clients that
exist in a subnet range by configuring a single client object.

List of IP All the IP address groups are listed. One | P address group can have a maximum of 128 |P address
Addresses/Netmasks and netmask combinations. To define a new 1P address group, choose Add. To view or modify an
existing | P address group, click the URL of the IP address group. The I P address group page opens.

Note For the IP address of any, an any group is predefined.

Use the Move Up and Move Down buttons to rearrange the order of the list items. Use the Delete
button to delete any | P address or netmask.

Related Topic
To create |Pv6 groups, see Controller > Security > IPv6 Groups

Controller > Security > IPv6 Groups

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > 1Pv6 Groups.

Table 60: Controller > Security > IPv6 Groups

Field Description
IP Address Enter an |Pv6 address format.
Prefix Length Prefix for IPv6 addresses, ranging from O to 128.

List of IP Addresses/Netmasks| All the I P address groups are listed. One | P address group can have a maximum of 128 |P address
and netmask combinations. To define a new 1P address group, choose Add. To view or modify an
existing IP address group, click the URL of the |P address group. The | P address group page opens.

Note For the IP address of any, an any group is predefined.

Use the Move Up and Move Down buttons to rearrange the order of the list items. Use the Delete
button to delete any I P address or netmask.

Related Topics
To create |Pv4 groups, see Controller > System
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Controller > Security > Protocol Groups

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > Protocol Groups.

Table 61: Controller > Security > Protocol Groups

Field Description

Rule Name Therule nameis provided for the existing rules, or you can now enter aname for anew rule. ACLs are
not required to have rules defined. When a packet matches al the fields of arule, the action for thisrule
is exercised.

Protocol Choose a protocol from the drop-down list:

» Any—All protocols

» TCP—Transmission Control Protocol

» UDP—User Datagram Protocol

» ICMP—Internet Control Message Protocol

» ESP—IP Encapsulating Security Payload

* AH—Authentication Header

» GRE—Generic Routing Encapsulation

* |P—Internet Protocol

* Eth Over IP—Ethernet over Internet Protocol
* Other Port OSPF—Open Shortest Path First

» Other—Any other IANA protocol (http://www.iana.org/)

Some protocol choices (such as TCP or UDP) cause additional Source Port and Dest Port GUI elements
to appear.

Source Port Enter the source port. Can be Any, HTTRP, HTTPS, Telnet, RADIUS, DHCP Server, DHCP Client, DNS,
L2TP, PPTP control, FTP control, SMTP, SNMP, LDAP, Kerberos, NetBIOSNS, NetBIOS DS, NetBIOS
SS, MS Dir Server, Other, and Port Range.

Dest Port Enter the destination port. If TCP or UDP is selected, can be Any, HTTP, HTTPS, Telnet, RADIUS,
DHCP Server, DHCP Client, DNS, L2TP, PPTP control, FTP control, SMTP, SNMP, LDAP, Kerberos,
NetBIOS NS, NetBIOS DS, NetBIOS SS, MS Dir Server, Other, and Port Range.

DSCP (Differentiated Choose Any or Specific from the drop-down list. If Specificis selected, enter the DSCP (0 through 255).
Services Code Point) DSCP is a packet header code that can be used to define the quality of service across the Internet.

Controller > Security > URL ACLs

URL filtering feature allows you to control access to Internet websites. It does so by permitting or denying
access to specific websites based on information contained in a URL access control list (ACL). The URL
filtering then restricts access based on the ACL list.
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Using location based filtering, APs are grouped under various AP groupsand WLAN profiles separate trusted
and non-trusted clients within the same SSID. This forces re-authentication and new VLAN when a trusted
client moves to anon-trusted AP or vice-versa.

The Wireless Controller (WLC) supports up to 64 ACLs and each ACL can contain up to 100 URLS. These
ACLs are configured to either allow or deny requests, and can be associated with different interfaces (ex:
WLAN, LAN), thusincreasing effective filtering. Policies can be implemented locally on aWLAN or an AP
group that is different from the applied global policy.

The number of rules (URLS) supported in each ACL variesfor different WL Cs:
* Cisco 5508 WL C and WiSM2 support 64 rulesin per URL ACL.
* Cisco 5520, 8510, and 8540 WL Cs support 100 rules per URL ACL.
* Redtrictions for URL Filtering and NAT.
« Not supported on Cisco 2504 WL Cs, VWL C, and Mobility Express.
* Supports WLAN Central Switching and not Local switching.
« Not supported in Flex mode with local switching.
* URL nameislimited to 32 charactersin length.
* No AV C Profile for the matched URLs. ACL Actions support for the Matched URLSs.

* Allowed list and Blocked list can be created using the “*” implicit rulein the ACL to alow or deny
reguests respectively.

* HTTPS URLSs are not supported.

» ACL may fail to filter in the following situations:

» URL is across fragmented packets.
* |P packets are fragmented.
* Direct IP address or proxy setup used instead of URL.

* These are currently not supported. If any URL matches with these conditions, it will not be considered
for filtering.

 Wildcard URL s (ex: www.uresour* |oc.com)
* Sub-URL (ex: www.uresour* loc.com/support)

* Sub-Domain (ex: reach.url.com or subl.url.com)

« If thereis any duplicate URL present while creating the template, then the duplicate URL Ruleis not
considered

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > Security > URL ACLSs.
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Controller > System .

Table 62: Controller > Security > URL ACLs

Field Description
URL In the URL Name text box, enter the URL address.
RuleAction | Select Allow or Deny from the drop-down list.

Controller > System

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Controller > System.

* Controller > System > AP 802.1X Supplicant Credentials
« Controller > System > AP Username Password

« Controller > System > DHCP

« Controller > System > Dynamic Interface

* Controller > System > General

* Controller > System > Global CDP Configuration

« Controller > System > QoS Profiles

« Controller > System > SNMP Community

* Controller > System > Traffic Stream Metrics QoS

* Controller > System > User Roles

Controller > System > AP 802.1X Supplicant Credentials

Use this option to configure 802.1X authentication between lightweight access points and the switch. The
access point actsasan 802.1X supplicant and is authenticated by the switch using EAP-FA ST with anonymous
PAC provisioning. You can set global authentication settings that all access pointsinherit as they join the
controller. All access points that are currently joined to the controller and any that join in the future are
included.

For basic information about creating this template, see Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure User Guide

Controller > System > AP Username Password

Use this option to create or modify atemplate for setting an access point username and password. All access
points inherit the password as they join the controller and these credentials are used to log in to the access
point viathe console or Telnet/SSH.

The AP Username Password page enables you to set a global password that all access points inherit as they
join a controller. When you are adding an access point, you can aso choose to accept this global username
and password or override it on a per-access point basis.

Also, in controller software Release 5.0, after an access point joins the controller, the access point enables
console port security and you are prompted for your username and password whenever you log in to the access
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point console port. When you log in, you are in nonprivileged mode and you must enter the enable password
to use the privileged mode.

For basic information about creating this template, see Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure User Guide.

Controller > System > DHCP

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > System > DHCP.

Table 63: Controller > System > DHCP

Field Description

DHCP Option 82 Remote Id | Thisfield provides additional security when DHCPisused to allocate network addresses. Specifically,
field format it enablesthe controller to act asa DHCP relay agent to prevent DHCP client requests from untrusted
sources. The controller can be configured to add option 82 information to DHCP requests from
clients before forwarding the requests to the DHCP server.

DHCP Proxy Select the DHCP Proxy check box to enable DHCP proxy on aglobal basisrather than onaWLAN
basis.
When DHCP proxy is enabled on the controller, the controller unicasts DHCP requests from the

client to the configured servers. At least one DHCP server must be configured on either theinterface
associated with the WLAN or on the WLAN itself.

DHCP Timeout (For Controller Version 7.0.114.74 and later) Enter the DHCP timeout, in seconds.

Controller > System > Dynamic Interface

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > System > Dynamic | nterface.

Table 64: Controller > System > Dynamic Interface

Field Description

Guest LAN Select to mark the interface as wired.

Quarantine Enable/disable to quarantine a VLAN. Select the check box to enable.

Netmask Enter the netmask address of the interface.

LAG Mode Select this check box to enable or disable LAG Mode. If LAG mode is selected with this interface, then

the settings can be applied only to the L AG-enabled controllers.

Primary Port Number | Enter the port currently used by the interface.

Secondary Port Number | Enter a secondary port to be used by the interface when the primary port is down. When the primary port
isreactivated, the Cisco 4400 Series Wireless LAN controller transfers the interfaces back to the primary
port.

Primary and secondary port numbers are present only in the Cisco 4400 Series Wireless LAN controllers.
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Field Description

AP Management Select this check box to enable access point management.

Primary DHCP Server | Enter the IP addresses of the primary DHCP servers.

Secondary DHCP Server | Enter the | P addresses of the secondary DHCP servers.

ACL Name Choose a name from the list of defined names.

From the Add Format Type drop-down list in the Add Interface Format Type group box, choose either
Device Info or File. If you choose device info, you must configure the device-specific fields for each
controller. If you choose File, you must configure CSV device-specific fields (Interface Name, VLAN

I dentifier, Quarantine VLAN Identifier, |P Address, and Gateway) for al the managed controllers specified
in the CSV file (see the following table).

The sample CSV files are as follows.

Table 65: Sample CSV Files

ip_address interface_name | vlan_id | quarantine_ | interface_ gateway
vlan_id ip_address

209.165.200.224 | dyn-1 1 2 209.165.200.228 | 209.165.200.229
209.165.200.225 | interface-1 4 2 209.165.200.230 | 209.165.200.231
209.165.200.226 | interface-2 5 3 209.165.200.232 | 209.165.200.233
209.165.200.227 | dyna-2 2 3 209.165.200.234 | 209.165.200.235
Thefirst row of the CSV fileisused to describe the columnsincluded. The CSV files can contain the following
fields:

* ip_address

« interface_name

* vlan_id

e quarantine_vlan id

« interface ip_address

* gateway
If you choose Apply to Controllers, you advance to the Apply To page where you can configure device-specific
fields for each controller.

Use the Add and Remove options to configure device-specific fields for each controllers. If you click Edit,
adialog box appears with the current parameter input.

Make the necessary changes in the dialog box, then click OK.
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Note

If you changetheinterfacefields, the WL ANs are temporarily disabled, therefore you might lose connectivity

for some clients. Any changes to the interface fields are saved only after you successfully apply them to the

controller(s).

\}

Note

If you remove an interface here, it is removed only from this template and not from the controllers.

Controller > System > General

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > System > General - System.

Table 66: Controller > System > General - System Template

Field

Description

802.3x Flow Control Mode

Enable or disable flow control mode.

802.3 Bridging

Enable or disable 802.3 bridging. This 802.3 bridging option is not available for Cisco 5500
and Cisco 2106 series controllers.

Web Radius Authentication

Choose the desired Web RADIUS authentication. You can choose to use PAP, CHAP, or
MD5-CHAP for authentication between the controller and the client during the user credential
exchange.

AP Primary Discovery Timeout

Specify the number of seconds for the AP Primary Discovery Timeout. The default is 120
seconds, and the valid range is 30 to 3600 seconds.

Back-up Primary Controller |P
Address

Back-up Primary Controller Name

Back-up Secondary Controller IP
Address

Back-up Secondary Controller
Name

Specify the back-up primary and secondary controller details.

CAPWAP Transport Mode

Specify Layer 2 or Layer 3 transport mode. When set to Layer 3, the lightweight access point
uses | P addresses to communicate with the access points; these | P addresses are collected from
amandatory DHCP server. When set to Layer 2, the lightwei ght access point uses proprietary
code to communicate with the access points.

Controllers through Version 5.2 use LWAPP and the new controller version uses CAPWAP,

Broadcast Forwarding

Choose to enable or disable broadcast forwarding. The default is disabled.
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Field

Description

LAG Mode

Choose Enable or Disable from the LAG Mode drop-down list. Link aggregation allows you
to reduce the number of | P addresses needed to configure the ports on your controller by grouping
all the physical ports and creating a link aggregation group (LAG).

If LAG isenabled on acontroller, any dynamic interfaces that you have created are deleted to
prevent configuration inconsistenciesin the interface database. When you make changesto the
LAG configuration, the controller has to be rebooted for the changes to take effect.

Interfaces cannot be created with the Dynamic AP Manager flag set. Also, you cannot create
more than one LAG on a controller.

Peer to Peer Blocking Mode

Chooseto enable or disable peer-to-peer blocking mode. If you choose Disable, any same-subnet
clients communicate through the controller. If you choose Enable, any same-subnet clients
communicate through a higher-level router.

Over-the-Air Provisioning AP
Mode

From the Over-the-Air AP Provision Mode drop-down list, choose enable or disable.

AP Fallback

AP Failover Priority

From the AP Fallback drop-down list, choose enable or disable. Enabling fallback causes an
access point that lost a primary controller connection to automatically return to service when
the primary controller returns.

When acontroller fails, the backup controller configured for the access point suddenly receives
anumber of discovery and join requests. This might cause the controller to reach a saturation
point and reject some of the access points. By assigning priority to an access point, you have
some control over which access points are rejected. In afailover situation when the backup
controller is saturated, the higher priority access points can join the backup controller if the
lower priority access points are disoined. Choose enable from the AP Failover Priority
drop-down list if you want to alow this capability.

Apple Talk Bridging

Choose to enable or disable AppleTalk bridging.
This AppleTak bridging option is not available on Cisco 5500 series controllers.

Fast SSID Change

Choose to enable or disable the Fast SSID Change option. If the option is enabled, the client
connects instantly to the controller between SSIDs without having much loss of connectivity.
Normally, each client is connected to a particular WLAN identified by the SSID. If the client
moves out of reach of the connected access point, the client has to reconnect to the controller
using adifferent access point. Thisnormal process consumes sometime asthe DHCP (Dynamic
Host Configuration Protocol) server hasto assign an | P address to the client.

Becausethe primary controller isnormally not used in adeployed network, the primary controller
setting is automatically disabled upon reboot or operating system code upgrade. You might
want to enable the controller as the primary controller from the Primary Controller Mode
drop-down list.

Primary Controller Mode

Chooseto enable or disable accessto the controller management interface from wireless clients.
Because of |Psec operation, management viawirelessis only available to operatorslogging in
across WPA or Static WEP.

Wireless Management

Wireless management is not available to clients attempting to log in viaan IPsec WLAN.
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Field

Description

Symmetric Tunneling Mode

Choose to enable or disable symmetric tunneling mode. With symmetric mobility tunneling,
the controller providesinter-subnet mobility for clients roaming from one access point to another
within awirelessLAN. The client traffic on the wired network isdirectly routed by the foreign
controller. If arouter has Reverse Path Forwarding (RPF) enabled (which provides additional
checks on incoming packets), the communication is blocked. Symmetric mobility tunneling
allowstheclient traffic to reach the controller designated as the anchor, even with RPF enabled.

All controllersin amobility group must have the same symmetric tunneling mode.

For symmetric tunneling to take effect, you must reboot.

ACL Counters

Usethe ACL Counters drop-down list to enable or disable ACL counters. The values per ACL
rule can be viewed for each controller.

Default Mobility Domain Name

Enter the operator-defined RF mobility group namein the Default Mobility Domain Name text
box.

Mohility Anchor Group Keep Alive
Interval

Specify the delay between tries for clients attempting to join another access point. With this
guest tunneling N+1 redundancy feature, the time it takes for a client to join another access
point following a controller failure is decreased because afailure is quickly identified, the
clients are moved away from the problem controller, and the clients are anchored to another
controller.

When you hover your mouse cursor over the field, the valid range of values appear.

Mobility Anchor Group Keep Alive
Retries

Specify the number of queriesto anchor before the client declaresit unreachable.

RF Network Name

Enter the RF network group namefrom 8 to 19 characters. Radio Resource Management (RRM)
neighbor packets are distributed among access points within an RF network group. The Cisco
access points only accept RRM neighbor packets sent with this RF network name. The RRM
neighbor packets sent with different RF network names are dropped.

User Idle Timeout

Specify the time out for idle clients. The factory default is 300 seconds. When the timeout
expires, the client loses authentication, briefly disassociates from the access point, reassociates,
and reauthenticates.

Specify the timeout in seconds for the address resolution protocol. The factory default is 300
seconds.

ARP Timeout

Specify the timeout in seconds.

Globa TCP Adjust MSS

Select the Global TCP Adjust M SS check box to start checking the TCP packets originating
from the client, for the TCP SYN/ TCP ACK packets and MSS value and reset it to the
configured value on the upstream and downstream side.

Disable local access

When this check box is selected, the AP will not broadcast local SSIDs or allow access to any
of the Ethernet ports.

Out of Box

Select this check box to create out-of-box RF profilesfor both the radios along with out-of -box
AP group.
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Field

Description

Web Auth Proxy Redirect Mode | Choose enable or disable Web Auth Proxy Redirect Mode if amanual proxy configuration is

configured on the browser of the client; all web traffic going out from the client is destined for
the PROXY IP and PORT configured on the browser.

Web Auth Proxy Redirect Port Enter the Web Auth Proxy Redirect Port. The default ports are 8080 and 3128. Therangeis

from O to 65535.

AP Retransmit Count

Enter the AP Retransmit Count and Intervals. The AP Retransmit Count default valueis5 and
therangeisfrom 3 to 8. The AP Retransmit Interval default valueis 3. Therangeisfrom 2 to

AP Retransmit Interval

5.

Global IPv6 Config

From the Global IPV6 Config drop-down list, choose Enabled or Disabled.

Control

Dot1x System Authentication Choose Dot1x System Authentication Control check box to enable or disable 802.1x

HTTP Profiling Port

Enter the HTTP profiling port number. This allows custom http port configuration.

Controller > System > Global CDP Configuration

Cisco Discovery Protocol (CDP) is a device-discovery protocol that runs on all Cisco network egquipment.
Each device sends identifying messages to a multicast address, and each device monitors the messages sent
by other devices. CDP is enabled on the Ethernet and radio ports of the bridge by defaullt.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > System > Global CDP Configuration.

Table 67: Controller > System > Global CDP Configuration Template

Field

Description

CDP on controller

Choose enable or disable CDP on the controller. This configuration cannot be applied on WiSM2
controllers.

Global CDP on APs

Choose to enable or disable CDP on the access points.

Refresh-time Interval

Enter the time in seconds at which CDP messages are generated. The default is 60.

Holdtime

Enter the time in seconds before the CDP neighbor entry expires. The default is 180.

CDP Advertisement Version

Enter which version of the CDP protocol to use. The default isv1.

Ethernet Interface Slot

Select the slots of Ethernet interfaces for which you want to enable CDP. CDP for Ethernet Interfaces
fields are supported for Controller Version 7.0.110.2 and later.

Radio Interface Slot

Select the dlots of Radio interfaces for which you want to enable CDP. CDPfor Radio Interfacesfields
are supported for Controller Version 7.0.110.2 and later.
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The followi
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ng table describes the Template Detail fieldsin Configuration > Templates > Features and

Technologies > Controller > System > QoS Profiles.

Table 68: Controller > System > QoS Profiles Template

Field

Description

Per-User Bandwidth Contracts

Note All have adefault of 0 or Off.

Average Data Rate

The average data rate for non-UDP traffic.

Global CDP on APs

The peak datarate for non-UDP traffic.

Average Real-time Rate

The average data rate for UDP traffic.

Burst Real-time Rate

The peak datarate for UDP traffic.

Over-the-Air QoS

Note The Air QoS configurations are applicable for controller Version 7.0 and earlier.

Maximum QoS RF Usage per AP

The maximum air bandwidth available to clients. The default is 100%.

QoS Queue Depth

Thedepth of queuefor aclassof client. The packetswith agreater value are dropped at the access
point.

Wired QoS Protocol

Wired QoS Protocol

Choose 802.1P to activate 802.1P priority tags or None to deactivate 802.1P priority flags.

802.1P Tag

Choose 802.1P priority tag for awired connection from O to 7. Thistag is used for traffic and
CAPWAP packets.

Controller > System > SNMP Community

Use this option to create or modify atemplate for configuring SNMP communities on controllers. SNMP
communities only apply to SNMPv1 and v2¢c. SNMPv3 uses usernames and passwords.

For basic information about creating this template, see the Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure User Guide.

When you enter the SNMP Community information, if you set the Access Maode option to Read Only, then
after applying this template, Prime Infrastructure will only have read access to the controller.

Controller > System > Traffic Stream Metrics QoS

Traffic stream metrics are a series of statistics about Vol P over your wireless LAN and informs you of the
QoSof thewirelessLAN. These statistics are different than the end-to-end statistics provided by Vol P systems.
End-to-end statistics provide information on packet loss and latency covering all the links comprising the call
path. However, traffic stream metrics are statistics for only the WLAN segment of the call. Because of this,
system administrators can quickly determine whether audio problems are being caused by the WLAN or by
other network elements participating in acall. By observing which access points have impaired QoS, system
administrators can quickly determine the physical areawhere the problem is occurring. Thisisimportant
when lack of radio coverage or excessive interference is the root problem.
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Four QoS values (packet latency, packet jitter, packet loss, and roaming time), which can affect the audio
quality of voice calls, are monitored. All the wireless LAN components participate in this process. Access
points and clients measure the metrics, access points collect the measurements and then send them to the
controller. The access points update the controller with traffic stream metric information every 90 seconds,
and 10 minutes of datais stored at one time. The Prime Infrastructure queries the controller for the metrics
and displays them in the Traffic Stream Metrics QoS Status. These metrics are compared to threshold values
to determinetheir statuslevel and if any of the statistics are displaying astatuslevel of fair (yellow) or degraded
(red), the administrator investigates the QoS of the wireless LAN.

For the access points to collect measurement val ues, traffic stream metrics must be enabled on the controller.

The Traffic Stream Metrics QoS Controller Configuration page shows several QoS values. An administrator
can monitor voice and video quality of the following:

 Upstream delay

* Upstream packet loss rate

« Roaming time

» Downstream packet |oss rate

» Downstream delay
Packet Loss Rate (PLR) affects the intelligibility of voice. Packet delay can affect both the intelligibility and
conversational quality of the connection. Excessive roaming time produces undesired gaps in audio.
There are three levels of measurement:

« Normal: Normal QoS (green)

* Fair: Fair QoS (yellow)

« Degraded: Degraded QoS (red)
System administrators should employ some judgment when setting the green, yellow, and red alarm levels.
Some factors to consider are:

« Environmental factors including interference and radio coverage that can affect PLR.

» End-user expectations and system administrator requirements for audio quality on mobile devices (lower
audio quality can permit greater PLR).

« Different codec types used by the phones have different tolerance for packet 10ss.

* Not al callsare mobile-to-mobile; therefore, some have less stringent PL R requirementsfor the wireless
LAN.

Controller > System > User Roles

Use this option to create or modify atemplate for configuring user roles. User roles determine how much
bandwidth the network can use. Four QoS levels (Platinum, Bronze, Gold, and Silver) are available for the
bandwidth distribution to Guest Users. Guest Users are associated with predefined roles (Contractor, Customer,
Partner, Vendor, Visitor, Other) with respective bandwidth configured by the Admin. These roles can be
applied when adding a new Guest User.

For basic information about creating this template, see the Creating Feature-Level Configuration Templates
section in the Cisco Prime Infrastructure User Guide.
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Controller > WLANs > WLAN Configuration
WLAN templates allow you to define various WLAN profiles for application to different controllers.

\}

Note You can configure multiple WLANSs with the same SSID. This feature enables you to assign different Layer
2 security policies within the same wireless LAN. When you deploy the WLAN Configuration templates, the
controllers configured with Interface/Interface Group, selected RADIUS servers, LDAP servers, ACL name
with rules, and Ingress interface appear in the Template Deployment - Prepare and Schedule page.

These restrictions apply when configuring multiple WLANs with the same SSID:

* WLANswith the same SSID must have unique Layer 2 security policies so that clients can make a
WLAN selection based on information advertised in the beacons and probes. These are the available
Layer 2 security policies:

» None (open WLAN)
* Static WEP or 802.1
* CKIP

* WPA/WPA2

* Broadcast SSID must be enabled on the WL ANsthat share an SSID so that the access points can generate
probe responses for these WLANS.

* FlexConnect access points do not support multiple SSIDs.

The following topics describe the fields on Configuration > Templates > Features and Technologies >
Controller > WLANs>WLAN Configuration:

* Controller > WLANs > WLAN Configuration > General

« Controller > WLANs > WLAN Configuration > Security

* Controller > WLANs > WLAN Configuration > QoS

* Controller > WLANs > WLAN Configuration > Advanced
* Controller > WLANs > WLAN Configuration > HotSpot

Controller > WLANs > WLAN Configuration > General

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Controller > WLANs> WLAN Configuration > General.

. Field Reference for Configuration Pages



| Field Reference for Configuration Pages

Controller > WLANs > WLAN Configuration > Security .

Table 69: Controller > WLANs > WLAN Configuration > General

Field Description
Wired LAN Select the check box to indicate whether or not thisWLAN isawired LAN.
Note Specify if you want guest usersto have wired guest access from an Ethernet connection
designated and configured for guest access. Wired guest access ports might be availablein a
guest office or specific portsin aconference room and accounts are added to the network using
the Lobby Ambassador portal. (The egress or ingress interface configurations are applicable
for wired LAN only.
Use the Type drop-down list to choose the type of the wired LAN.
* Guest LAN—Indicates that thiswired LAN isaguest LAN. If you select the Guest LAN option,
you need to select an Egress interface that has not already been assigned to any guest LAN.
* Remote LAN—Indicates that thiswired LAN isaremote LAN.
Profile Name Enter aname in the Profile Name text box that identifies the WLAN or the guest LAN. Do not use any
spaces in the name entered.
SSID Enter the name of the WLAN SSID. An SSID is not required for aguest LAN.
WLANSs with the same SSID must have unique Layer 2 security policies so that clients can make a
WLAN selection based on information advertised in the beacons and probes.
Status Select the Enable check box for the Status field.

Configure Wlan Id

Select the check box to give the WLAN an identifier.
Use the Wlan | d text box to enter the WLAN identifier (an integer).

Security Policies

M odifications you make in the Security tab appear after you save the template.

Radio Policy

Set the WLAN policy to apply to All (802.11a/b/g/n), 802.11aonly, 802.11g only, 802.11b/g only, or
802.11a/g only.

Interface/I nterface Group

Choose the available names of interfaces created by the Controller > Interfaces module.

Multicast VLAN Select the Enable check box to enable the multicast VLAN feature.
From the Multicast VLAN Interface drop-down list, choose the appropriate interface name. Thislist is
automatically populated when you enable the multicast VLAN feature.

Broadcast SSID Select to activate SSID broadcasts for this WLAN.

Controller > WLANs > WLAN Configuration > Security

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > WLANs> WLAN Configuration > Security.
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Table 70: Controller > WLANs > WLAN Configuration > Security

Field Description
Layer 2
None No Layer 2 security selected.

» FT Enable—Select the check box to enable fast transition (FT) between access points.

Note Fast transition is not supported with FlexConnect mode.
Over the DS—Select the check box to enable or disable the fast transition over a distributed system (DS).

Reassociation Timeout—Time in seconds after which fast transition reassociation times out. The default is 20
seconds, and the valid rangeis 1 to 100.

To enable Over the DS or Reassociation Timeout, you should enable fast transition.

802.1X WEP 802.1X data encryption type:
* 40/64 hit key
* 104 bit key
* 152 bit key

Static WEP Static WEP encryption fields:

*» Key sizes: Not set, 40/64, 104, and 152 bit key sizes.

» Key Index: 1to 4.

« Encryption Key: Encryption key required.

» Key Format: ASCII or HEX.

* Allowed Shared Key Authentication—Select the check box to enable shared key authentication.

Regardless of the format you choose, for security reasons, only ASCI| isvisible on the WLC (and the Prime
Infrastructure). For this reason, you cannot use atemplate to replicate the configuration on a second controller
during auto provisioning. You should set the key format again in the template in case a discovered template is
applied to another device.

Static Usethis setting to enable both static WEP and 802.1X policies. If thisoption is sel ected, static WEP and 802.1X
WEP-802.1X fields are displayed at the bottom of the page.
Static WEP encryption fields:

» Key sizes: Not set, 40/64, 104, and 152 bit key sizes.

* Key index: 1to 4.

* Encryption Key: Enter encryption key.

» Key Format: ASCII or HEX.

« Allowed Shared Key Authentication—Select the check box to enable.
« 802.1 Data Encryption: 40/64 bit key, 104 bit key, 152 bit key.
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Field

Description

CKIP

Cisco Key Integrity Protocol (CKIP). A Cisco access point advertises support for CKIP in beacon and probe
response packets. CKIP can be configured only when Aironet |E is enabled on the WLAN.

Note CKIPisnot supported on 10xx APs.
When selected, these CKIP fields are displayed.
» Key size: Not set, 40, or 104.
* Key Index: 1to4
« Encryption Key: Specify encryption key.
» Key Format: ASCII or HEX.
Note Regardless of the format you choose, for security reasons, only ASCII isvisible on the WLC (and
Prime Infrastructure). For this reason, you cannot use atemplate to replicate the configuration on a

second controller during auto provisioning. You should set the key format again in the template in
case adiscovered template is applied to another device.

MMH Mode—Select the check box to enable.
Key Permutation—Select the check box to enable.

MAC Filtering

Select to filter clients by MAC address.

Note The ability to join a controller without specification within aMAC filter list is only supported on
mesh access points.

Note For releases prior to 4.1.82.0, mesh access points do not join the controller unless they are defined
inthe MAC filter list.

You might want to disable the MAC filter list to allow newly added access points to join the controller. Before
enabling the MAC filter list again, you should enter the MAC addresses of the new access points.

Authentication

Choose the desired type of authentication key management. The choices are 802.1X, CCKM, or PSK.

Key Management Note If you choose PSK, you must enter the shared key and type (ASCII or hexadecimal).
Note Regardless of the format you choose, for security reasons, only ASCII isvisible on the WLC (and
Prime Infrastructure). For this reason, you cannot use atemplate to replicate the configuration on a
second controller during auto provisioning. You should set the key format again in the templatein
case adiscovered template is applied to another device.
Layer 3
Layer 3 Security | Choose between None and VPN Pass Through.

Note The VPN passthrough option is not available for the 2106 or 5500 series controllers.
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Field

Description

Web Policy

You can modify the default static WEP (web authentication) or assign specific web authentication (login, logout,
login failure) pages and the server source.

1. To change the static WEP to passthrough, select the Web Policy check box and choose the Passthrough
option from the drop-down list. This option allows users to access the network without entering ausername
or password.

An Email Input check box appears. Select this check box if you want users to be prompted for their email

address when attempting to connect to the network.

1. Select the WebAuth on MAC Filter Failure radio button so that when clients fail on MAC filter, they are
automatically switched to WebAuth.

Note The WebAuth on Mac Filter Failure option works only when the Layer 2 Mac Filtering option is

enabled.

1. To specify custom web authentication pages, unselect the Global WebAuth Configuration Enable check
box.

When the Web Auth Type drop-down list appears, choose one of the following options to define the web login

page for the wireless guest users:

« Default I nternal—Displays the default web login page for the controller. Thisis the default value.

 Customized Web Auth—Displays custom web login, login failure, and logout pages. When the customized
option is selected, three separate drop-down lists for login, login failure, and logout page selection appear.
You do not need to define acustomized pagefor al three of the options. Choose None from the appropriate
drop-down list if you do not want to display a customized page for that option.

 These optional login, login failure, and logout pages are downloaded to the controller as webauth.tar files.

 Exter nal—Redirects users to an external server for authentication. If you choose this option, you must
also enter the URL of the external server in the URL text box.

Note External web auth is not supported for 2106 and 5500 series controllers.

* You can select specific RADIUS or LDAP serversto provide external authentication in the Security >
AAA page.

Note The RADIUS and LDAP servers must be already configured to have selectable optionsin the
Security > AAA page. You can configure these serversin the RADIUS Authentication Servers
page and TACACS+ Authentication Servers page.

If you selected External as the Web Authentication Type, choose Security > AAA, and choose up to three
RADIUS and L DAP servers using the drop-down lists.

Repeat this processif a second (anchor) controller is being used in the network.

AAA Server
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Field

Description

Radius Server
Overwrite
Interface

Select to send the client authentication request through the dynamic interface that is set on the WLAN. When
you enable the Radius Server Overwrite Interface option, the WLC sources all RADIUS traffic for aWLAN
using the dynamic interface configured on that WLAN.

Note You cannot enable Radius Server Overwrite Interface when Diagnostic Channel is enabled.
Note The Radius Server Overwrite Interface option is supported in controller Version 7.0.x and later.

Select the Enable check box, then use the drop-down listsin the RADIUS and L DAP servers section to choose
authentication and accounting servers. This selects the default RADIUS server for the specified WLAN and
overrides the RADIUS server that is configured for the network. If all three RADIUS servers are configured
for aparticular WLAN, server 1 has the highest priority, and so on.

If no LDAP servers are chosen here, Prime Infrastructure uses the default LDAP server order from the database.

Interim Update

Select to enable interim update for RADIUS Server Accounting. If you have selected this check box, specify
the Interim Interval value. The range is 180 to 3600 seconds, and the default valueis 0.

Note The Interim Interval can be entered only when Interim Update is enabled.

Loca EAP
Authentication

Select the L ocal EAP Authentication check box if you have an EAP profile already configured that you want
to enable. Local EAP is an authentication method that allows users and wireless clients to locally authenticate.
It isdesigned for usein remote offices that want to maintain connectivity to wireless clients when the backend
system becomes disrupted or the external authentication server goes down.

Allow AAA
Override

When you enable AAA Override, and aclient has conflicting AAA and controller WLAN authentication fields,
client authentication is performed by the AAA server. Aspart of thisauthentication, the operating system moves
clients from the default Cisco WLAN Solution to aVLAN returned by the AAA server and predefined in the
controller interface configuration (only when configured for MAC filtering, 802.1X, and/or WPA operation).
In all cases, the operating system also uses QoS and ACL provided by the AAA server, aslong asthey are
predefined in the controller interface configuration. (This VLAN switching by AAA overrideisaso referred
to asidentity networking.)

For instance, if the corporate WLAN primarily uses a management interface assigned to VLAN 2, and if AAA
overridereturns aredirect to VLAN 100, the operating system redirects al client transmissionsto VLAN 100,
regardless of the physical port to which VLAN 100 is assigned.

When AAA override isdisabled, al client authentication defaults to the controller authentication parameter
settings, and authentication is only performed by the AAA server if the controller WLANS do not contain any
client-specific authentication parameters.

The AAA override values might come from a RADIUS server, for example.

Controller > WLANs > WLAN Configuration > QoS

The following table describes the Template Detail fieldsin Design > Configuration > Feature Design >
Features and Technologies > Controller > WLANs>WLAN Configuration > QoS.
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Table 71: Controller > WLANs > WLAN Configuration > QoS

Field

Description

Quality of Service (QoS)

Choose Platinum (voice), Gold (video), Silver (best effort), or Bronze (background). Services
such as Vol P should be set to gold while nondiscriminating services such as text messaging can
be set to bronze.

Override Per-User Rate
Limits

Datarateson a per-user basis

Average Data Rate

Definethe average datarate for TCP traffic per user or per SSID by entering the ratein kbpsin the
Average Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile.

Burst Data Rate

Define the peak datarate for TCP traffic per user or per SSID by entering the rate in kbpsin the
Burst Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile. The Burst
Data Rate should be greater than or equal to the Average Data Rate. Otherwise, the QoS policy
may block traffic to and from the wireless client.

Average Real-Time Rate

Define the average rea -time rate for UDP traffic per user or per SSID by entering the rate in kbps
in the Average Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the
profile.

Burst Real-Time Rate

Define the peak real-time rate for UDP traffic per user or per SSID by entering the rate in kbpsin
the Burst Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the profile.
The Burst Real-Time Rate should be greater than or equal to the Average Real-Time Rate. Otherwise,
the QoS policy may block traffic to and from the wireless client.

Override Per-SSID Rate
Limits

Datarateson a per SSID basis

Average Data Rate

Define the average data rate TCP traffic per user or per SSID by entering the rate in kbpsin the
Average Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile.

Burst Data Rate

Define the peak datarate for TCP traffic per user or per SSID by entering the rate in kbpsin the
Burst Data Rate text box. A value of 0 imposes no bandwidth restriction on the profile. The Burst
Data Rate should be greater than or equal to the Average Data Rate. Otherwise, the QoS policy
may block traffic in the WLANS.

Average Real-Time Rate

Define the average rea -time rate for UDP traffic per user or per SSID by entering the rate in kbps
in the Average Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the
profile.

Burst Real-Time Rate

Define the peak real-time rate for UDP traffic per user or per SSID by entering the rate in kbpsin
the Burst Real-Time Rate text box. A value of 0 imposes no bandwidth restriction on the profile.
The Burst Real-Time Rate should be greater than or equal to the Average Real-Time Rate. Otherwise,
the QoS policy may block traffic in the WLANS.

WMM Policy

Choose Disabled, Allowed (so clients can communicate with the WLAN), or Required (to make
it mandatory for clientsto have WMM enabled for communication).
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Controller > WLANs > WLAN Configuration > Advanced .

Field

Description

7920 AP CAC

Select to enable support on Cisco 7920 phones.

If youwant WLAN to support older versions of the software on 7920 phones, select the 7920 Client
CAC check box to enableit. The Call Admission Control (CAC) limit is set on the access point
for newer versions of software.

Controller > WLANs > WLAN Configuration > Advanced

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > WLANs>WLAN Configuration > Advanced.

Table 72: Controller > WLANs > WLAN Configuration > Advanced

Field

Description

FlexConnect Loca
Switching

Select to enable FlexConnect local switching. If you enable FlexConnect local switching, the FlexConnect
access point handles client authentication and switches client data packets locally.

FlexConnect local switching is only applicable to the Cisco 1130/1240/1250 series access points. It is not
supported with L2TP or PPTP authentications, and it is not applicable to WLAN IDs 9 to 16.

VLAN ID—Enter avalid value between 1 to 4094 for VLAN Id. Thisfield shows up only when you select
Guest LAN from the LAN Type drop-down list in the WLAN Configuration > General tab.

FlexConnect Local
Auth

Select to enable FlexConnect local authentication.

Local authentication is useful where you care unable to maintain the criteria of a remote office setup of
minimum bandwidth of 128 kbps with the roundtrip latency no greater than 100 ms and the maximum
transmission unit (MTU) no smaller than 500 bytes. In local switching, the authentication capabilities are
present in the access point itself. Thuslocal authentication reduces the latency reguirements of the branch
office.

Note Local authentication can only be enabled on the WLAN of a FlexConnect AP that isin local
switching mode.

Local authentication is not supported in the following scenarios:

« Guest authentication cannot be performed on a FlexConnect local authentication enabled WLAN.

* RRM information is not available at the controller for the FlexConnect local authentication enabled
WLAN.

» Local RADIUS is not supported.

 Once the client has been authenticated, roaming is supported after the WL C and the other FlexConnects
in the group are updated with the client information.

Learn Client IP
Address

When you enable hybrid-REAP local switching, the L earn Client | P Address check box isenabled by default.
However, if the client is configured with Fortress Layer 2 encryption, the controller cannot learn the client

I P address, and the controller periodically dropsthe client. Disable this option so that the controller maintains
the client connection without waiting to learn the client | P address. The ability to disable this option is supported
only with hybrid-REAP local switching; it is not supported with hybrid-REAP central switching.
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Field

Description

Diagnostic Channel

Choose to enable the diagnostic channel feature or leave it disabled. The diagnostic channel feature allows
you to troubleshoot problems regarding client communication withaWLAN. When initiated by aclient having
difficulties, the diagnostic channel providesthe most robust communication methods with the fewest obstacles
to communication.

Aironet |E

Select to enable support for Aironet information elements (IEs) for this WLAN. If Aironet |E support is
enabled, the access point sends an Aironet |E 0x85 (which contains the access point name, load, number of
associated clients, and so on) in the beacon and probe responses of this WLAN, and the controller sends
Aironet |Es 0x85 and 0x95 (which contains the management |1P address of the controller and the IP address
of the access point) in the reassociation responseif it receives Aironet |E 0x85 in the reassociation request.

IPv6

Select the | Pv6 check box. You can configure IPv6 bridging and 1Pv4 web auth on the same WLAN.

Session Timeout

Select to set the maximum time a client session can continue before requiring reauthorization.

Coverage Hole
Detection

Choose to enable or disable coverage hold detection (CHD) on this WLAN. By default, CHD is enabled on
all WLANsonthecontroller. If you disable CHD onaWLAN, acoverage holealert isstill sent to the controller,
but no other processing is done to mitigate the coverage hole. This feature is useful for guest WLANs where
highly mobile guests are connected to your network for short periods of time.

Override Interface
ACL

The Override Interface ACL drop-down list provides alist of defined access control lists (ACLs). Upon
choosing an ACL from thelist, the WLAN associates the ACL to the WLAN. Selecting an ACL is optional,
and the default for thisfield is None.

Peer to Peer
Blocking

You can configure peer-to-peer blocking per WLAN rather than applying the statusto all WLANSs. From the
Peer to Peer Blocking drop-down list, choose one of the following:

« Disable—Peer-to-peer blocking is disabled, and traffic is bridged locally whenever possible.
» Drop—The packet is discarded.

* Forward Up Stream—The packet is forwarded on the upstream VLAN, and the decision is made about
what to do with the packet.
Note For locally switched clients, the Forward Up Stream is same as Drop from 7.2.x version of
controllers.

If FlexConnect local switching is enabled for the WLAN, which prevents traffic from passing through the
controller, this drop-down list is dimmed.

Note Peer-to-peer blocking does not apply to multicast traffic.

Wi-Fi Direct Clients
Policy

Choose one of the following options:

« Disabled—Disables the Wi-Fi Direct Clients Policy for the WLAN and deauthenticates all Wi-Fi Direct
capable clients. The default is Disabled.

» Allow—Allows the Wi-Fi Direct clients to associate with an infrastructure WLAN.

* Not-Allow—Disallows the Wi-Fi Direct clients from associating with an infrastructure WLAN.

Note Wi-Fi Direct Client Policy is applicable to WLANSs that have APs in local mode only.

Note The Wi-Fi Direct Clients Policy is applicable for controller Version 7.2.x. and | ater.
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Field

Description

Client Exclusion

Select the check box if you want to enable automatic client exclusion. If you enable client exclusion, you
must also set the timeout value in seconds for disabled client machines. Client machines are excluded by
MAC address, and their status can be observed. A timeout setting of 0 indicates that administrative control
isrequired to reenable the client.

Note When session timeout is not set, it implies that an excluded client remains and does not timeout
from the excluded state. It does not imply that the exclusion feature is disabled.

Passive Client

Enter the maximum number of clientsto be associated in aWLAN in the Maximum Clients text box. The
valid rangeisfrom 0 to 7000. The default value is 0.

Note A value of 0 allows unlimited number of clients to be associated with aWLAN.

Static IP Tunneling

Enable dynamic anchoring of static IP clients by selecting the Static | P Tunneling check box.

Media Session
Snooping

This feature enables access points to detect the establishment, termination, and failure of voice calls and then
report them to the controller and Prime Infrastructure. It can be enabled or disabled per WLAN.

When media session snooping is enabled, the access point radios that advertise thisWLAN snoop for Session
Initiation Protocol (SIP) voice packets. Any packets destined to or originating from port number 5060 are
considered for further inspection. The access point tracks whether Wi-Fi Multimedia(WMM) and non-WMM
clients are establishing acall, already on an active call, or in the process of ending a call and then notify the
controller of any major call events.

KTS based CAC

Select the KTS based CAC check box to enable KTS-based CAC support per WLAN.

WL C supports TSPEC-based CAC and SIP-based CAC. But there are certain phonesthat work with different
protocolsfor CAC, which are based onthe KTS (Key Telephone System). For supporting CAC with KTS-based
SIP clients, WL C should understand and process the bandwidth request message from those clientsto all ocate
the required bandwidth on the AP radio, in addition to handling and sending certain other messages, as part
of this protocol.

Note The KTS CAC configurationisonly supported by Cisco 5508, 7500, WISM2, and 2500 controllers
that run controller software Release 7.2.x. Thisfeature is not supported by Cisco 4400 series
controllers.

NAC State

Choose SNM P NAC or Radius NAC. SIP errors that are discovered generate traps that appear on the client
troubleshooting and alarms screens. The controller can integrate with the NAC appliance in out-of-band mode,
where the NAC appliance remains in the data path only until clients have been analyzed and cleaned.
Out-of-band mode reduces the traffic load on the NAC appliance and enables centralized NAC processing.
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Field

Description

Scan Defer Priority

Off-Channel Scanning Defer is essential to the operation of RRM, which gathersinformation about aternate
channel choices such as noise and interference. Additionally, Off-Channel Scanning Defer is responsible for
rogue detection. Devices that need to defer Off-Channel Scanning Defer should use the same WLAN as often
as possible. If there are many of these devices (and the possibility exists that Off-Channel Defer scanning
could be completely disabled by the use of this feature), you should implement an alternative to local AP
Off-Channel Scanning Defer, such as monitor access points, or other access points in the same location that
do not have this WLAN assigned.

Assignment of a QoS policy (bronze, silver, gold, and platinum) to aWLAN affects how packets are marked
on the downlink connection from the access point regardless of how they were received on the uplink from
the client. UP=1,2 isthe lowest priority, and UP=0,3 is the next higher priority. The marking results of each
QoS policy are asfollows:

* Bronze marks all downlink traffic to UP=1.

* Silver marks all downlink traffic to UP=0.

* Gold marks all downlink traffic to UP=4.

* Platinum marks all downlink traffic to UP=6.

Set the Scan Defer Priority by clicking the priority argument, and set the time in milliseconds in the Scan
Defer Interval text box. Valid values are 0 to 60000. The default value is 100 milliseconds.

DTIM Period

In 802.11a/n and 802.11b/g/n networks, lightweight access points broadcast a beacon at regular intervals,
which coincides with the Delivery Traffic Indication Map (DTIM). After the access point broadcasts the
beacon, it transmits any buffered broadcast and multicast frames based on the value set for the DTIM period.
This feature allows power-saving clients to wake up at the appropriate time if they are expecting broadcast
or multicast data.

Normally, the DTIM valueisset to 1 (transmit broadcast and multicast frames after every beacon) or 2 (transmit
after every other beacon). For instance, if the beacon period of the 802.11a/n or 802.11b/g/n network is 100
ms and the DTIM valueis set to 1, the access point transmits buffered broadcast and multicast frames 10
times per second. If the beacon period is 100 ms and the DTIM valueis set to 2, the access point transmits
buffered broadcast and multicast frames 5 times per second. Either of these settings might be suitable for
applications, including Vol P, that expect frequent broadcast and multicast frames.

However, the DTIM value can be set ashigh as 255 (transmit broadcast and multicast frames after every 255th
beacon) if all 802.11a/n or 802.11b/g/n clients have power save enabled. Because the clients have to listen
only when the DTIM period is reached, they can be set to listen for broadcasts and multicasts less frequently,
resulting in longer battery life. For instance, if the beacon period is 100 msand the DTIM valueis set to 100,
the access point transmits buffered broadcast and multicast frames once every 10 seconds, allowing the
power-saving clients to sleep longer before they have to wake up and listen for broadcasts and multicasts,
resulting in longer battery life.

Many applications cannot tolerate along time between broadcast and multicast messages, resulting in poor
protocol and application performance. We recommend alow DTIM value for 802.11a/n and 802.11b/g/n
networks that support such clients.

Under DTIM Period, enter avalue from 1 to 255 in the 802.11a/n and 802.11b/g/n fields. The default value
is 1 (transmit broadcast and multicast frames after every beacon).
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Field Description
DHCP Server Select the check box to override DHCP server,. Another field appears where you can enter the | P address of
your DHCP server. For some WLAN configurations, thisisrequired. Threevalid configurations are asfollows:
* DHCP Required and avalid DHCP server IP address—All WLAN clients obtain an IP address from the
DHCP server.
« DHCPisnot required and a valid DHCP server address—All WLAN clients obtain an | P address from
the DHCP server or use a static | P address.
* DHCP not required and DHCP server IP address 0.0.0.0—All WLAN clients are forced to use a static
IP address. All DHCP requests are dropped.
You cannot choose to require a DHCP address assignment and then enter a DHCP server | P address.
MFP Signature Select to enable signature generation for the 802.11 management frames transmitted by an access point
Generation associated with this WLAN. Signature generation makes sure that changes to the transmitted management
frames by an intruder are detected and reported.
MFP Client Choose Enabled, Disabled, or Required for configuration of individual WLANS of a controller. If
Protection infrastructure MFP is not enabled, this drop-down list is unavailable.
Note The Enabled parameter isthe same asthe Optional parameter that you choose from the MFP Client
Protection drop-down list in the WL C graphical user interface.
Note Client-side MFP is only available for those WLANSs configured to support Cisco Compatible
Extensions (version 5 or later) clients, and WPA2 must first be configured.
DTIM Period Enter avalue from 1 to 255 beacon intervals. The controller sendsa DTIM packet for this WLAN based on
what is entered as an interval.
Note The DTIM configuration is not appropriate for guest LANS.
Loca Client Select to enable or disable profiling of al the clientsthat are associated with the WLAN.
Profiling Note Client profiling is not supported with FlexConnect local authentication.
Note Client profiling is configurable only when you select the DHCP Address Assignment check box.
PMIP Mobility Choose the mobility type from the following options:

» None—Configures the WLAN with smple IP.
* Mixed—Configures the WLAN with simple P and PMIPv6.
* PMIPv6—Configures the WLAN with only PMIPv6.

Controller > WLANs > WLAN Configuration > HotSpot

Mobile Concierge is a solution that enables 802.1X capable clientsto interwork with external networks. The
Mobile Concierge feature provides service availability information to clients and can help them to associate
available networks.

The services offered by the network can be broadly classified into two protocols:
* 802.11u MSAP
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. Controller > WLANs > WLAN Configuration > HotSpot

* 802.11u HotSpot 2.0

The following guidelines and limitations apply to Mobile Concierge:

» Mobile Conciergeis not supported on FlexConnect Access Points.

« 802.11u configuration upload is not supported. If you perform a configuration upgrade and upload a
configuration on the controller, the HotSpot configuration on the WLANS s lost.

To create Mobile Concierge (802.11u) Groups, choose Configuration > Templates > Features and
Technologies > Controller> WLANs > WLAN Configuration > Hot Spot.

The following table describes the Template Detail fieldsin Configuration > Templates > Features and
Technologies > Controller > WLANs>WLAN Configuration > HotSpot.

Table 73: Controller > WLANs > WLAN Configuration > HotSpot

Field

Description

802.11u Configurations

802.11u General Parameters

802.11u Status

Select to enable 802.11u on the WLAN.

» From the drop-down list, in the HESSID field, enter the Homogenous Extended Service Set
Identifier value. The HESSID is a 6-octet MAC address that identifies the homogeneous ESS.

Internet Access

Select to enable this WLAN to provide Internet services.

Network Type

Choose one of the following network types that best describes the 802.11u you want to configure on
thisWLAN:

* Private Network

« Private Network with Guest Access
« Chargeable Public Network

* Free Public Network

* Emergency Services Only Network
« Personal Device Network

* Test or Experimental

* Wildcard

Network Auth Type

Choose the authentication type that you want to configure for the 802.11u parameters on this network:

« Not configured

« Acceptance of Terms and Conditions
¢ Online Enrollment

* HTTP/HTTPS Redirection

IPv4 Address Type

Choose the IPv4 address type from the drop-down list.

IPv6 Address Type

Choose the IPv6 address type from the drop-down list.

Others
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Controller > WLANSs > WLAN Configuration > HotSpot .

Field

Description

OUI List

Enter the following details:

¢ OUI name
* |[sBeacon
* OUI Index

Select Add to add the OUI (Organizationally Unique Identifier) entry to this WLAN.

« In the group box,

Domain List

Enter the following details:

» Domain Name—The domain name operating in the 802.11 access network.
« Domain Index—Select the domain index from the drop-down list.

Select Add to add the domain entry to this WLAN.

OUI List

Enter the following details:

* Realm Name—The realm name.
* Realm Index—The ream index.

Select Add to add the domain entry to this WLAN.

Service Advertisements

MSAP

Select to enable service advertisements. If you enabled M SAP in the previous step, you must provide
aserver index. Enter the server index for this WLAN. The server index field uniquely identifies an
MSAP server instance serving a venue that is reachable through the BSSID.

MSAP (Mohility Services Advertisement Protocol) isdesigned to be used primarily by mobile devices
that are configured with aset of policiesfor establishing network services. These servicesare available
for devicesthat offer higher-layer services, or network services that are enabled through service
providers. Service advertisements use M SA P to provide servicesto mobil e devices prior to association
to a Wi-Fi access network. Thisinformation is conveyed in a service advertisement. A single-mode
or dual-mode mobile device queries the network for service advertisements before association. The
device's network discovery and the selection function may use the service advertisementsin its
decision to join the network.

Server Index

If you enabled MSAP, you must provide a server index. Enter the server index for thisWLAN. The
server index field uniquely identifies an M SAP server instance serving a venue that is reachable
through the BSSID.

Note MSAP (Mobility Services Advertisement Protocol) is designed to be used primarily by
mobile devicesthat are configured with a set of policiesfor establishing network services.
These servicesare available for devicesthat offer higher-layer services, or network services
that are enabled through service providers. Service advertisements use MSAP to provide
servicesto mobile devices prior to association to a Wi-Fi access network. Thisinformation
isconveyed in aservice advertisement. A single-mode or dual-mode mobile device queries
the network for service advertisements before association. The device's network discovery
and the selection function may use the service advertisementsin its decision to join the
network.

HotSpot 2.0
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. Controller > WLANs > WLAN Configuration > HotSpot

Field Description
HotSpot2 Enable Choose to enable HotSpot2.
Domain ID Enter the Domain ID to be sent in hotspot2.0.

OSEN enable/Open wlan
profile

Enter the WLAN profile Name.

WAN Link Status

Select the link status.

WAN Symmetric Link Status

The symmetric link status. For example, you can configure the uplink and downlink to have different
speeds or same speeds.

Down Link Speed

The downlink speed. The maximum value is 4,194,304 kbps.

Up Link Speed

The uplink speed. The maximum value is 4,194,304 kbps.

Operator Name List

Specify the following:

* Operator Name—Specify the name of the 802.11 operator.
* Operator Index—Select an operator index. Therangeisfrom 1 to 32.

 Language Code—An | SO-14962-1997 encoded string defining the language. This string isa
three character language code.

Select Add to add the operator details.

Port Config List

Specify the following:
* |P Protocol—The | P protocol that you want to enable. The following options are ESP, FTP,
ICMP, and IKEV2.
* Port No—The port number that is enabled on this WLAN.
* Status—The status of the port.

Operator Sign Up List

In the Online Sign Up List group box, specify the following. Online Sign Up (OSU) is the process
by which a mobile device registers with a Service Provider (SP), which enables you to select aplan
to obtain network access and is provisioned with the credentials necessary to securely to connect to
anetwork.

* OSU Index—The OSU Index uniquely identifies an instance of OSU server configuration.

* Select avalue from the OSU Index drop-down list.

« Language—L anguage defined for the OSU index. The language code can be a minimum of 2
and maximum of 3 characters.

» SP Name—Enter the Service Provider (SP) name for the OSU index. The range for SP Name
is1to 255 characters.

« Description—Enter the Service Provider (SP) description for the OSU index. The description
can be amaximum of 255 characters.
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Field Description
Online Sign Up Icon Specify the following:
Filename

* OSU Index— You can add only those OSU index that have configured in the Online Sign Up
List. The OSU Index uniquely identifies an instance of OSU server configuration. Select avalue
from the OSU Index drop-down list.

« Icon Name—Theicon nameispre popul ated. You must download icon image from Configuration
> Network > Network Devices, then select System > Commands path. Configure theicon
configurations before downloading icons to Cisco WLC.

 From the Icon drop-down list, choose the downloaded icon name. You can download the icon
from ftp or tftp server to the controller.

Online Sign Up Other Specify the following:

Configurations * OSU Index—You can add only those OSU index which have been configured in the Online

Sign Up List.
* Primary Method—The primary and secondary value should be different. The primary value
represents the primary server method or the particular OSU index.

» Secondary Method—The secondary val ue represents the secondary server method for the
particular OSU index.

» Uniform Resource Identifier (URI)—This represents the URI for the particular OSU index.
* Network Access Identifier (NAI) —This represents the NAI for the particular OSU index.

Controller > mDNS

Multicast DNS (mDNS) service discovery provides away to announce and discover services on the local
network. mDNS performs DNS queries over |P multicast. mDNS supports zero configuration | P networking.

Follow these guidelines and limitations when creating mDNS templ ates:

* You cannot delete an mDNS service when it is mapped to one or more profiles.

* Thelength of the profile name and the services name can be a maximum 31 characters.

* Thelength of the service string can be a maximum 255 characters.

« You cannot delete the default profile (default-mdns-profile).

* You cannot delete profiles when they are mapped to interfaces, interface-groups, or WLANS.

* You cannot remove mDNS services from a profile when they are mapped to an interface, interface-groups,
or WLANS. You can add new services.

» Whenever you create and apply any mDNS template, it overwrites existing configuration on controller.
* You cannot enable mDNS snooping for WLAN when FlexConnect local switching is enabled.
* You cannot attach mDNS profiles to interfaces when AP Management is enabled.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Controller > mDNS > mDNS.

Table 74: Controller > mDNS > mDNS

Field Description
Services Tab Use thefieldsin this tab to configure the global MDNS parameters and update the Primary Services
database.
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. Interfaces Templates Field Descriptions

Field Description

MDNS Global Snooping | Select the check box to enable snooping of mDNS packets.

Note The controller does not support |Pv6 mDNS packets even when you enable mDNS snooping.

Query Interval(10-120) | The mDNS query interval, in minutes, that you can set. Thisinterval is used by WLC to send periodic
MDNS query messages to services that do not send service advertisements automatically after they are
started. The range isfrom 10 to 120 minutes. The default value is 15 minutes.

Primary Services A list of the supported services that can be queried.

Primary Service Name | Name of the mDNS service.

Service String Unique string associated to an mDNS service. For example, _airplay._tcp.local. isthe service string
associated to AppleTV.
Query Status Select the check box to enable an mDNS query for a service.

Note Periodic mDNS query messageswill be sent by WL C at configured Query Interval for services
only when the query status is enabled; otherwise, service should automatically advertised for
other services where the query statusis disabled (for example AppleTV).

Profiles Tab Usethistab to view the mDNS profiles configured on the controller and create new mDNS profiles. After
creating a new profile, you must map the profile to an interface group, an interface, or aWLAN.

Clients receive service advertisements only for the services associated with the profile. The controller
givesthe highest priority to the profiles associated to interface groups, followed by the interface profiles,
then the WLAN profiles. Each client is mapped to a profile based on the order of priority.

By default, the controller has an mDNS profile, default-mdns-profile. You cannot delete this default

profile.
Profile Name Name of the mDNS profile. You can create a maximum of 16 profiles.
Mapped Services Select the services (using the check boxes) that you want to map to the mDNS profile.

Interfaces Templates Field Descriptions

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Interfaces > Cellular:

* Interfaces > Cellular Profile

* Interfaces > GSM Profile

Interfaces > Cellular Profile

\}

Note To deploy the cellular profile template on any UMTS, GSM, HSPA, HSPA+R7 modem, you should have the
GSM profile Interfaces > GSM Profile on the router.
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The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Interfaces > Cellular > Cellular Profile.

Table 75: Interfaces > Cellular > Cellular Profile

Field Description

Validation Criteria

Device Type Choose the device type from the drop-down list.

Interface Details

Cellular Interface Enter the name of the cellular interface. For fixed platform routers(8xx), it is always Cellular O,
for modular platformsit isof thefollowing form; Cellular dot/sub dot or port. For example, Cellular
o/1/0.

Definethis cellular interface as | Choose one of the following options to configure the cellular interface:

* Primary WAN Interface
» Backup WAN Interface

Primary Interface Enter the primary interface details. Thisfiled appearswhen Definethiscellular interfaceasis set
to Backup WAN Interface.

Route Map Tag Enter a unique name to identify the route map.

Sequence Number Enter a numeric value to define a route map condition.

Action Thefield valueis set to Permit by default.

Access List Enter the details of the access list that is associated with the route map to inspect an interesting

traffic. The ACL must be an extended ACL and can be named ACL aso.

First Hop Interface (Read only) The details are auto populated when a user enters the primary interface.

Target Address Enter the | P address of the server to which connectivity is checked. This server is decided as part
of Service Level Agreement (SLA).

Timeout Value Enter the timeout value in milliseconds for each ping request.

Time Interval Enter the time interval at which the pings are generated.

Dialer Configuration

Persistent Data Connection Choose Yes to enable the persistent data connection.

Associate Dialer Enter the associate dialer. This field appears when Persistent Data Connection is set to yes.

Dider Idle Timeout Enter the diaer idle timeout. This field appears when Per sistent Data Connection is set to no.

Chat-Script Configuration

Chat-Script Name Enter the string value that causes the cellular modem to dial out and initiate the traffic.
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. Interfaces > GSM Profile

Field Description

Timeout Value Enter the timeout value used by the Cisco |10S device to wait for aresponse from the modem. The
call failsin case the Cisco | OS device does not get any expected response or no response from the
cellular modem.

Interfaces > GSM Profile

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Interfaces > Cellular > GSM Prfile.

Table 76: Interfaces > Cellular > GSM Profile

Field Description

Device Type Choose device type from the drop-down list.

Template Detail

Cellular Interface Enter the Cisco wireless WAN interface that support up to 16 profiles, but only one can be active at a

time. Generally profile number 1 is selected by defaullt.

Access Point Name (APN) | Enter the name that identifies the packet data network (PDN), that a mobile data user wants to
communicate with. Generally the APN is shared by the service provider, when a user buys a particular
cellular modem.

Profile Number Select the profile number from the drop-down list.

PDP Type Choosethe Packet Data Protocol (PDP) typefrom the drop-down list. PDP offersa packet data connection
over which the user equipment such as mobiles and the network can exchange I P packets.

The PDP types available are:

« IPv4 (Default)
. PPP

Authentication Choose the type of authentication that is used by your service provider. CHAP authentication is more
secure than PAP authentication.

UsernamePassword For CHAP or PAP authentication, enter the username given to you by your Internet service provider
or network administrator.

Security Templates Field Descriptions

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies > Security.

* Security > VPN Components

* Security > Zone Based Firewall
* Security > DMVPN

* Security > Easy VPN Remote
* Security > Easy VPN Server
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* Security > Easy VPN Server Proxy Setting
* Security > GETV PN-GroupMember

* Security > GETVPN-KeyServer

* Security > ScanSafe

Security > VPN Components

The following topics contain descriptions of the fieldsfound in Configuration > Templates > Featuresand
Technologies > Security > VPN Components:

* Security VPN Components IKE Policies

* Security > VPN Components > IKE Settings

« Security > VPN Components > IPSec Profile

* Security > VPN Components > Pre-shared Keys
* Security > VPN Components > RSA-Keys

* Security > VPN Components > Transform Sets

Security VPN Components IKE Policies

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > VPN Components > |KE Policies.

Table 77: Security > VPN Components > IKE Policies

Field Description
IKE Policies
Priority Enter the priority value of the IKE proposal. The priority value determinesthe order of the IKE proposals compared

by the two negotiating peers when attempting to find a common SA. If the remote | Psec peer does not support the
parameters selected in your first priority policy, the device tries to use the parameters defined in the policy with
the next lowest priority number.

Therangeisfrom 1 to 10000. The lower the number, the higher the priority.

Authentication | Choose one of the following options from the Authentication drop-down list:

* PRE_SHARE—Authentication will be performed using pre-shared keys.
* RSA_SIG—Authentication will be performed using digital signatures.

D-H Group Choosethe Diffie-Hellman (D-H) group used for driving ashared secret between two | Psec peerswithout transmitting
it to each other. A large modulus provides higher security but requires more processing time. The two peers must
have a matching modulus group. Choose one of the following options from Diffie-Hellman Group drop-down list:

» 1—Diffie-Hellman Group 1 (768-bit modulus).
» 2—Diffie-Hellman Group 2 (1024-bit modulus).
« 5—Diffie-Hellman Group 5 (1536-bit modulus; considered good protection for 128-hit keys).
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. Security > VPN Components > IKE Settings

Field

Description

Encryption

Choose one of the encryption algorithms from the Encryption drop-down list:

* AES-128—Encrypts according to the Advanced Encryption Standard (AES) using 128-bit keys.

» AES-192—Encrypts according to the AES using 192-bit keys.

» AES-256—Encrypts according to the AES using 256-bit keys.

» DES—Encrypts according to the Data Encryption Standard (DES) using 56-bit keys.

» 3DES—Encrypts three times using 56-bit keys. 3DES is more secure than DES but requires more processing
for encryption and decryption. However, it is less secure than AES.

Note A 3DESIlicenseisrequired to use this option.

Hash

Choose the hash algorithm drop-down list. The hash a gorithm creates a message digest that is used to ensure
message integrity. The options are:
* SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA is more resistant to brute-force attacks than
MDS5.
» MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses |ess processing time than SHA.

IKE lifetime

Enter the lifetime of the SA, in seconds. When the lifetime is exceeded, the SA expires and must be renegotiated
between thetwo peers. Asagenera rule, the shorter thelifetime (up to apoint), the more secure your | KE negotiations
will be. However, with longer lifetimes, future | Psec security associations can be set up more quickly than with
shorter lifetimes.

Therangeis from 60 to 86400. The default value is 86400.

Security > VPN Components > IKE Settings

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > VPN Components > |KE Settings.

Table 78: Security > VPN Components > IKE Settings

Field Description
IKE Settings
Enable IKE Select the Enable | K E check box to globally enable the IKE. (By default, the IKE is enabled.) You do

not have to enable IKE for individual interfaces, but it can be enabled globally for all theinterfacesin
the router.

If you do not want to use the IKE for your IP Security (1Psec) implementation, you can disablethe IKE
for all your IPsec peers. If you disable the IKE for one peer, you must disableit for all the | Psec peers.

Enable Aggressive Mode | Select the Enable Aggressive M ode check box to enable the Internet Security Association and Key

Management Protocol (ISAKMP) aggressive mode. If you disable the aggressive mode, al the aggressive
mode requests to the device and all the aggressive mode reguests made by the device will be blocked.
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Security > VPN Components > IPSec Profile .

Field

Description

IKE Identity

Choose one option from the IKE identity drop-down list.

An ISAKMP identity is set whenever you specify pre-shared keys or RSA signature authentication. As
ageneral rule, you should set all the peers identitiesin the sameway, either by | P address or by hosthame.
The options are;

* IP Address—Setsthe |ISAKMPidentity to the | P address of theinterface that isused to communicate
to the remote peer during the IKE negotiations.

* DISTINGUISHED NAME—Sets the ISAKMP identity to the distinguished name (DN) of the
router certificate.

* HOSTNAME—Sets the ISAKMP identity to the hostname concatenated with the domain name
(for example, myhost.example.com).

Enable Dead Peer
Detection (DPD)

Enable the gateway to send the Dead Peer Detection (DPD) messages to the peer. DPD is a keepalive
scheme that allows the router to query the liveliness of its IKE peer.

Keepalive Specify the number of seconds between the DPD messages in the DPD Keepalive field. Therangeis
from 10 to 3600.
Retry Specify the number of seconds between retriesif the DPD messagesfail during DPD Retry. The range

isfrom 2 to 60.

Security > VPN Components > IPSec Profile

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > VPN Components > | PSec Profile.

Table 79: Security > VPN Components > IPSec Profile

Field Description

Name Enter anamefor this|Psec profile. When you edit aprofile, you cannot edit the name of the | Psec profile.
Description Add adescription for the I Psec profile that you are adding or editing.

Transform Sets Enter the transform set name. The transform set (see Security > VPN Components > Transform Sets,

page 2-87) encrypts the traffic on the tunnel.

IPSec SA Lifetime (secs)

Enter the IPSec SA Lifetime to establish anew SA after the set period of time elapses. Enter thetimein
seconds. The rangeis from 120 to 86400.

Security > VPN Components > Pre-shared Keys

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > VPN Components > Pre-shared Keys.

Table 80: Security > VPN Components > Pre-shared Keys

Field

Description

|P AddressHost Name

Enter the IP address or the hosthame of the remote peer.
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. Security > VPN Components > RSA-Keys

Field

Description

Subnet Mask

Enter the subnet mask.

Pre-shared Key/Confirm Pre-shared Key | Enter the pre-shared key, and reenter the key to confirm the pre-shared key.

Security > VPN Components > RSA-Keys

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > VPN Components > RSA-Keys.

Table 81: Security > VPN Components > RSA-Keys

Field

Description

Label

Enter the name for the key pair.

Modulus

Enter the key modulus value. If you want a modulus value from 512 to 1024, enter an integer value that isa
multiple of 64. If you want a value higher than 1024, you can enter 1536 or 2048. If you enter a value greater
than 512, key generation may take a minute or longer.

The modulus determines the size of the key. The larger the modulus, the more secure the key, but keys with
large modulus take longer to generate, and encryption/decryption operations take longer with larger keys.

Type

Select the type of the RSA key to be generated. The options are;
« general-keys
* usages-keys
* encryption
* signature

Enable Exportable

Enable thisfield to generate RSA as an exportable key.

Security > VPN Components > Transform Sets

A transform set represents a certain combination of security protocols and algorithms. During the | Psec security
association negotiation, the peers agree to use a particul ar transform set for protecting a particular data flow.
A transform set describes a particular security protocol with its corresponding agorithms.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > VPN Components > Transform Sets.

Table 82: Security > VPN Components > Transform Sets

Field Description

Name Enter a name for the transform set.

ESP Encryption | Choose the ESP encryption algorithm used to encrypt the payload.

ESP Integrity | Choose the ESP integrity algorithm used to check the integrity of the payload.
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Field Description

AH Integrity | Choose the AH integrity from the drop-down list. The options are:

» AH with the MD5 (Message Digest 5) (a Hash-based Message Authentication Code [HMAC] variant)
authentication agorithm.
» AH with the SHA (Secure Hash Algorithm) (an HMAC variant) authentication algorithm.

Compression | Enable or disable the IP compression with the Lempel-Ziv-Stac (LZS) agorithm.

Mode Choose the mode from the drop-down list. The options are:

« Transport—Encrypt data only. Transport mode is used when both endpoints support | Psec. Transport mode
places the authentication header or encapsulated security payload after the original 1P header; thus, only the
IP payload is encrypted. This method allows usersto apply network services such as quality-of-service (QoS)
controls to encrypted packets.

* Tunnel—Encrypt dataand | P header. Tunnel mode provides stronger protection than transport mode. Because
the entire | P packet is encapsulated within AH or ESP, anew |P header is attached, and the entire datagram
can be encrypted. Tunnel mode allows network devices such as arouter to act as an |Psec proxy for multiple
VPN users; tunnel mode should be used in those configurations.

Security > Zone Based Firewall

The following section contains descriptions of the fieldsin Configuration > Templates > Features and
Technologies > Security > Zone Based Firewall:

* Security > Zone Based Firewall > Policy Rules

Security > Zone Based Firewall > Policy Rules

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > Zone Based FireWall > Policy Rules.

Table 83: Security > Zone Based FireWall > Policy Rules

Element Description
Name (Optional) Enter a name for the policy rule.
Source Zone Select the source zone from the list of interface roles. The source zone specifies the name of the interface from

which thetraffic is originating.

Destination Zone | Sel ect the destination zone from thelist of interface roles. The destination zone specifiesthe name of theinterface
to which the traffic is bound.

Source Enter the source | P address of the inspected data. The valid parameters are:

* Any
» Other—If you select the Other option, you can choose a combination of 1P address, Subnets, and Network
Objects.
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Element Description
Destination Enter the destination | P address of the inspected data. The valid parameters are;
*« Any
« Other—If you select the Other option, you can choose a combination of |P address, Subnet, and Network
Objects.
Service Select the service of the inspected data from the object selector. The valid parameters are:

 L3/4 Applications
* ACL-Based Application: TCP, UDP, ICMP

Action Choose an action to perform on the traffic when the rule matches the condition. The rule matches when:

« The traffic Source | P matches the Source Rule condition.
« Thetraffic Destination |P matches the Destination Rule condition and the traffic I nspected Service matches
the Service Rule condition.
The action options are:

« Drop—Traffic that ishandled by the drop action is silently dropped. The system does not send a notification
to the end host.

« Drop and Log—Traffic that is handled by the drop and log action is dropped and a syslog notification is
sent to the end host.

« Inspect—The inspect action offers state-based traffic control, the router maintains the connection or session
information for TCP and UDP traffic.

* Pass—This action allows the router to forward the traffic from one zone to another.

* Pass and Log—This action allows the router to forward traffic from one zone to another while creating a
syslog notification of the forwarded traffic.

Security > DMVPN

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > DMVPN.

Table 84: Security > DMVPN

Field Description

|Psec Information
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Field

Description

IKE Authentication

Authentication
Type

security > DMVPN [}

Select the Preshared Keys or Digital Certificatesradio button.

* Preshared Keys—This alows a secret key to be shared between two peers
and be used by IKE during the authentication phase.

« Digital Certificates—Authentication method in which RSA key pairsare used
to sign and encrypt |KE key management messages. Certificates provide
nonrepudiation of communication between two peers, meaning that it can be
proven that the communication actually took place.

Priority

Enter the priority value of the IKE proposal. The priority value determinesthe order
of the IKE proposals compared by the two negotiating peers when attempting to
find acommon security association (SA). If the remote | Psec peer does not support
the parameters selected in your first priority policy, the device tries to use the
parameters defined in the policy with the next lowest priority number.

Valid values range from 1 to 10000. The lower the number, the higher the priority.
If you leavethisfield blank, Security Manager assignsthelowest unassigned value
starting with 1, followed by 5, and continuing in increments of 5.

Authentication

Choose the authentication type from the drop-down list.

D-H Group Select the Diffie-Hellman (D-H) group. The D-H group isused for deriving ashared
secret between two | Psec peers without transmitting it to each other. A larger
modulus provides higher security but requires more processing time. Thetwo peers
must have a matching modulus group. The options are:
1—Diffie-Hellman Group 1 (768-bit modulus).
2—Diffie-Hellman Group 2 (1024-bit modulus).
5—Diffie-Hellman Group 5 (1536-bit modulus, considered good protection for
128-bit keys, but group 14 is better). If you are using AES encryption, use this
group (or higher). The ASA supports this group as the highest group.

Encryption Choose the encryption algorithm from the drop-down list. The encryption algorithm
is used to establish the Phase 1 SA for protecting phase 2 negotiations:
AES-128—Encrypts according to the AES using 128-bit keys.
AES-192—Encrypts according to the AES using 192-bit keys.
AES-256—Encrypts according to the AES using 256-bit keys.

DES—Encrypts according to the DES using 56-hit keys.

3DES—Encrypts three times using 56-hit keys. 3DES is more secure than DES
but requires more processing for encryption and decryption. However, it isless
secure than AES. A 3DES licenseisrequired to use this option.

Hash Select the algorithm used in the IKE proposal. The hash a gorithm creates amessage

digest that is used to ensure message integrity. The options are;

* SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA ismore
resistant to brute-force attacks than MD5.

» MD5 (Message Digest 5)—Produces a128-hbit digest. MD5 uses|ess processing
time than SHA.
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Spokes

connection between

Field Description
IKE Lifetime Specify the IKE lifetime value from 60 to 86400. The default is 86400. When the
lifetimeis exceeded, the SA expires and must be renegotiated between the two
peers. As ageneral rule, the shorter the lifetime (up to a point), the more secure
your |KE negotiationswill be. However, with longer lifetimes, future | Psec security
associations can be set up more quickly than with shorter lifetimes.
Encryption Policy Name Enter the transform set name. The transform set encrypts the traffic on the tunnel.
ESP Encryption Choose the algorithm used to encrypt the payload from the drop-down list. The
options are;
» ESP with the 128-bit AES encryption agorithm.
« ESP with the 192-bit AES encryption algorithm.
» ESP with the 256-bit AES encryption algorithm.
» ESP with the 168-bit DES encryption algorithm (3DES or Triple DES).
 Null encryption algorithm.
ESP Integrity Choose the integrity algorithm used to check the integrity of the payload from the
drop-down list. The options are:
» ESP with the MD5 (HMAC variant) authentication algorithm.
* ESP with the SHA (HMAC variant) authentication algorithm.
AH Integrity Choose AH integrity from the drop-down list. The options are:
» AH with the MD5 (Message Digest 5) (aHash-based M essage Authentication
Code [HMAC] variant) authentication algorithm.
» AH with the SHA (Secure Hash Algorithm) (an HMAC variant) authentication
agorithm.
Compression Enable the | P compression to compress payload. | P compression with the
Lempel-Ziv-Stac (LZS) algorithm.
Mode Choose the mode to transport the traffic.
Topology and Routing
Information
Spoke — Select the Spoke radio button to configure the router as a spoke in the topol ogy.
Hub — Select the Hub radio button to configure the router as a Hub in the topology.
Select one of the following routing protocols:
* EIGRP—Enter the AS number
* RIPV2
* Other
Create dynamic — Select the Create Dynamic Connection between Spokes check box to configure

the dynamic connection between spokes.
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Field

Description

Multipoint GRE Interface
Information (These fields
appear only under Operate
> Device Work Center)

Select the Tunnéel source
that connects to internet

security > DMVPN [}

Choose the WAN interface that connects to the Internet from the drop-down list.

IP Addressof thisrouter’s
GRE Tunnel Interface

Enter the | P address of the tunnel interface.

Subnet Mask — Enter the subnet mask.

NHRP and Tunnel

Parameters

Network 1D — Enter the NHRP Network ID. The network ID isaglobally unique, 32-bit network
identifier from a nonbroadcast multiaccess (NBMA) network. Therangeisfrom 1
to 4294967295.

Hold Time — (Optional) Enter the number of secondsfor which the Next Hop Resol ution Protocol

(NHRP) NBMA addresses should be advertised asvalid. The default valueis 7200.

NHRP Authentication
String

Enter the authentication string.

Tunnel Key — Enter thetunnel key. Thisisused to enableakey ID for aparticular tunnel interface.
Therange isfrom 0 to 4294967295.

Bandwidth — Enter the bandwidth. Thisis an optional field.

IPMTU — (Optional) Enter the MTU size of IP packetsthat are sent on a particular interface.

The default value for Ethernet and the serial interface is 1500. The default value
varies depending upon the media type.

TCP Maximum Segment
Size

Enter the TCP maximum segment size. The rangeis from 500 to 1460.

Tunnel Source Interface

(Optional) Enter the physical interface.

IPsec Information (These
fields appear only under
Operate > Device Work
Center)
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. Security > Easy VPN Remote

Field

Description

Encryption Policy

Name Enter the name of the transform set.

ESP Encryption Choose the encryption algorithm. The algorithm used to encrypt the payload.

ESP Integrity Choose the integrity algorithm. The algorithm used to check the integrity of the
payload.
AH Integrity Choose the AH integrity from the drop-down list.
Compression Choose appropriate option to enable or disable payload compression.
Mode Choose the mode. Indicates the mode to transport the traffic.
NHS Server
Cluster Support Cluster ID Enter the cluster value to form a group having one or more hubs. Therangeisfrom
0to 10.
Max Connections | Enter the maximum number of connections that can be active in a particular group
or cluster.
Priority Select the priority of the particular hub in a cluster. Depends on the priority of the

spoke router that will form atunnel with the hub devices.

Next Hop Server | Enter the IP address of the next-hop server.

IP Address of Hub's
physical interface

— Enter the | P address of the hub's physical interface.

Security > Easy VPN Remote

Cable modems, xDSL routers, and other forms of broadband access provide high-performance connections
to the Internet, but many applications also require the security of VPN connections that perform a high level
of authentication and encrypt the data between two endpoints. However, establishing a VPN connection
between two routers can be complicated and typically requires tedious coordination between network
administrators to configure the VPN parameters of the two routers.

The Cisco Easy VPN Remote feature eliminates much of this tedious work by implementing Cisco Unity
Client Protocol, which allows most of the VPN parameters to be defined at a Cisco |OS Easy VPN server.
This server can be adedicated VPN device, such as a Cisco VPN 3000 series concentrator or a Cisco PIX
Firewall or a Cisco |OS router that supports the Cisco Unity Client Protocol.

After the Cisco Easy VPN server is configured, VPN connection is created with minimal configuration on a
Cisco device. When the Easy VPN remote initiates the VPN tunnel connection, the Cisco Easy VPN server
pushes the | Psec policies to the Easy VPN remote and creates the corresponding VPN tunnel connection.

Before you create an Easy VPN Client template, create the necessary ACLSs, such as the identical addressing
ACL, theinteresting traffic ACL, and the protected subnet ACL using the ACL template. For moreinformation,
see Cisco Prime Infrastructure User Guide.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > Easy VPN Remote.
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Table 85: Security > Easy VPN Remote

Security > Easy VPN Remote .

Field

Description

Easy VPN Remote Profile
Name and Interface
Configuration

Profile Name

Enter a name for the profile.

Interface and Server
Association

Inside Interfaces

These aretheinterfacesthat areincluded inthe Easy VPN connection. All hosts
or subnets that are connected to these interfaces are a part of the VPN.

Outside Interfaces

The WAN interface that connects to the Easy VPN server or concentrator.

Virtual Template
Number

Thisnumber provides aroutable interface to selectively send traffic to different
Easy VPN concentrators and to the Internet.

Easy VPN Servers

Enter the Easy VPN server address. Up to ten IPv4 server addresses or server
hostnames can be added.

Idle Time Enter the idle time for the server in seconds. The range is from 60 to 86400.
The default value is 60.
Each VPN Remote
Connection Settings
Mode of Operation Client Choose the Client mode if you want the PCs and other devices on the router’s

inside networks to form a private network with private | P addresses. Network
Address Trandation (NAT) and Port Address Trandation (PAT) will be used
for routing the traffic. Devices outside the LAN will not be able to ping the
devices onthe LAN or reach them directly.

Network Extension

Choose the Networ k Extension modeif you want the devicesthat are connected
to the inside interfaces to have | P addresses that are routable and reachable by
the destination network. The devices at both ends of the connection will form
one logical network. PAT isautomatically disabled, allowing the PCs and hosts
at both ends of the connection to have direct access to one another.

Network Extension
Plus

Choose the Networ k Extension Plus mode to request an | P address via mode
configuration and automatically assign it to an available loopback interface.
The IPsec SAsfor this IP address are automatically created by Easy VPN
Remote. This IP address can be used for connecting to your router for remote
management and troubleshooting (ping, Telnet, and Secure Shell).

Note If the router is not running a Cisco |0S image that supports Easy
VPN Remote Phase 4 or |ater, you will not be ableto set the Network

Extension Plus mode.

Protected Subnets ACL

Enter the ACL for the subnets that are not directly a part of the provided inside
interface.
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Field Description
Connection Method Auto Choose Auto if you want the VPN tunnel to be established automatically when
the Easy VPN configuration isdelivered to the router configuration file. However,
you will not be able to control the tunnel manually.
Manual Choose Manual if you want to control when the VPN tunnel is established and

terminated.

Interesting Traffic

Choose Interesting Traffic when you want the tunnel to be established only
when a specific traffic is sensed. This traffic is determined by the Interesting
Traffic ACL.

EasyVPN Remote
Authentication
Mechanisms

Primary Authentication

Choose the device authentication method. The options are Pre-shared Key and
Digital Certificate.

Pre Shared Key
Configuration

Group Name Enter the IPsec group name. This group name must match the group name
defined in the VPN concentrator or server. Obtain this information from your
network administrator.

Enable Encrypted Select the Enable Encrypted Password check box to encrypt the password.

Password

Pre Shared Key Selecting pre-shared keys allowsfor asecret key to be shared between two peers
and be used by IKE during the authentication phase.

Confirm Pre Shared | Reenter the pre-shared Key to confirm the key.

Key

Digital Certificate

An authentication method in which RSA key pairs are used to sign and encrypt
IKE key management messages. Certificates provide nonrepudiation of
communication between two peers, meaning that it can be proved that the
communication actually took place.

Extended Authentication

Enable X Auth

Enable XAuth is enabled by default on Cisco 1OS devices.

Use Web Authentication

Choosethe Use Web Authentication radio button to use the web authentication
method. Select the Use HT TP Authorization for each client behind the Easy
VPN Remote check box to use the HTTP authorization.

. Field Reference for Configuration Pages

Save Credentials — Select the Save Credentials radio button and provide the username and
password. Reenter the password to confirm the password.

Prompt for Credential — Select the Prompt for Credentials radio button and provide the credentials
when prompted.

EasyV PN Remote Firewall

Settings
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Security > Easy VPN Server .

Field Description

Enable EasyVPN through |— Select the EasyVPN through Firewall check box to enablethefirewall settings.
Firewall

CcTCP Port Number — Enter the Cisco Tunneling Control Protocol (cTCP) port number. This number

should match the cTCP port number on the EZVPN server. The rangeis from
1to 65535. The default value is 10000.

NAT/Firewall Keepalive |—

Enter the Firewall Keepalive period, in seconds. The rangeis from 5 to 3600.
The default valueis 5.

Security > Easy VPN Server

The Easy VPN Server feature introduces server support for the Cisco VPN Client Release 3.x and later and
Cisco VPN hardware clients (such asthe Cisco I ntegrated Services Routers and the Cisco Application-Specific
Routers). By using I P Security (IPsec), the centrally managed IPsec policies are pushed to the client device
by the server and helps end users minimize the configuration.

You can use the Dynamic Virtual Tunnel Interface or Dynamic Crypto Map method to configure an Easy
VPN server.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > Easy VPN Server.

Table 86: Security > Easy VPN Server

Field

Description

Validation Criteria

Device Type

Choose Routers.

Interface Configuration
Methods

Outside Interface

Enter the interface name that connect to the WAN link.

Configure Dynamic Virtual
Tunnel Interface

Enter the virtual template number and the | Psec profile name that you
created in the I Psec Profile template (see “ Security > VPN Components >
I PSec Profile” section on page 2-85). Alternatively, you can enter the name
of an IPsec profile that already existsin the device. The IPsec profiles that
already exist in the device are displayed in the device view.

Configure Dynamic Crypto
Map

Enter the Crypto map name and the transform set name that you created
in the Transform Set template (see “ Security > VPN Components >
Transform Sets’ section on page 2-87). Alternatively you can enter the
name of atransform set that already existsin the device. The transform
setsthat already exist in the device are shown in the device view.

I SAK M P Settings

Client Configuration Address
Type

Select the client configuration address type from the drop down list.
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Field Description

Enable Dead Peer Detection |— Enable the device to send dead peer detection (DPD) messages to Easy
VPN clients. If aclient does not respond to the DPD messages, the
connection is terminated.

Keep Alive Interval — Specify the number of seconds between DPD messages in the Keepalive
Interval field. The range isfrom 10 to 3600.

Retry Interval — Specify the number of seconds between retries if the DPD messages fail.
The rangeisfrom 2 to 60.

AAA Group/User Palicy

AAA Group Method List — Enter the same AAA Group Method List profile name that you created in
the CLI template.

AAA User Method List — Enter the same AAA User Method List profile name that you created in
the CLI template.

Enable PKI download — Select the Enable PK 1 download check box to obtain user attributesfrom
the AAA server and push to the remote device through mode configuration.
The usernamethat is used to get the attributesis retrieved from the remote
device certificate.

VPN groups — Provide those ISAKMP group names that are not present locally in the
router but whose identity still heeds to be matched with the ISAKMP
profile.

EasyVPN Group

Configuration

Genera

Generd Group Name Enter an EasyVPN group name.

Enable Encrypted Key | Select the Enable Encrypted Key check box to allow providing an
encrypted pre-shared key.

Pre-Shared Key Pre-shared keys alow for a secret key to be shared between two peers and
to be used by IKE during the authentication phase.

Confirm Pre-Shared Key | Reenter the pre-shared Key to confirm the key.

. Field Reference for Configuration Pages



| Field Reference for Configuration Pages

Field

Description

Address Pool Configuration

Assign IP Addressto
Remote Clients

Security > Easy VPN Server .

Select the Assign | P Addressto Remote Clients check box to create new
I P address pools for internal 1P address allocation to clients.

Starting |P Address

Enter the starting | P address of the range, for example, 1.1.1.1.

Ending IP Address

Enter the ending | P address of the range, for example, from 1.1.1.1 to
1.1.254.1.

Subnet Mask

Enter the subnet mask used by the connecting clientsfor local connectivity.

Max Connections

Enter the maximum number of connections allowed in the configuration.

Domain Name

Allowed Therangeisfrom 1 to 5000.
XAuth Options Enable XAuth Select the Enable X Auth check box to enable the extended authentication
methods.
XAuth Banner Enter the banner that the server to pushes to the Easy VPN Remote.
Max Logins alowed per | The maximum number of logins allowed per user. Therangeisfrom 1to
user 10.
Enable group lock for | Select the Enable group lock for XAuth check box to perform an extra
XAuth authentication check during X Auth. The group name entered during X Auth
is compared by the server with the group name sent for the pre-shared key
device authentication. If they do not match, the server deniesthe connection.
Save XAuth password | Theclient is allowed to store the password locally when prompted for its
on router XAuth credential s after receiving the policy during IKE mode configuration
on a subsequent connection to the server.
DNS & WINS

Enter the name of the DNS domain to which a group belongs.

Configure DNS Servers

Select the Configure DNS Server s check box to specify the primary and
secondary DNS server for the group.

Primary DNS Server

Enter the IP address of the primary DNS server.

Secondary DNS Server

Enter the |P address of the secondary DNS server.

Configure WINS Server

Select the Configure WINS Server check box to specify the primary and
secondary WINS server for the group.

Primary WINS Server

Enter the IP address of the primary WINS server.

Secondary WINS Server

Enter the IP address of the secondary WINS server.

Split Tunneling

Split Tunnel ACL

Enter the name of the ACL that represents the protected subnets for split
tunneling purposes.
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Field Description

Split DNS Configuration — Enter the domain names that must be tunneled or resolved to the private
network.

Settings

Configuration Push URL Enter the URL that the remote device must use to get the configuration
from the server. The URL must be a nonnull-terminated ASCII string that
specifies the complete path of the configured file.

Version Enter the version of the configuration. The rangeisfrom 1 to 32767.
Backup Configuration Backup Gateways Assign backup gateways to push the list of backup gateways to the client

device. These gateways are used if a previous gateway fails.

Access Settings

Include local LAN

Select the Include local L AN check box to allow a nonsplit tunneling
connection to access the local subnetwork at the same time as the client.

Enable perfect forward
secrecy

Select the Enable perfect forwar d secrecy check box to notify the client
about whether perfect forward secrecy isrequired for any 1Psec SA.

Firewall and Proxy Settings

Enable Firewall Select the Enable Firewall Are-U-There check box to enable the
Are-U-There Are-U-Therefirewall.
Browse Proxy Settings | Enter the browser proxy profile as configured by the Easy VPN Browser

Proxy Template.

Firewall Settings

Enable cTCP — Select the Enable cT CP check box to configure cTCP encapsul ation for
Easy VPN. A maximum of 10 port numbers can be configured.
CTCP Port Number(s) — Enter the cTCP port number.

Enter the cTCP keep alive period, in seconds. Therangeisfrom 5 to 3600.

Security > Easy VPN Server Proxy Setting

The Easy VPN Server Proxy Setting feature allows you to specify the browser proxy settings that will be
pushed by the Easy VPN server to the EasyVPN remote and the Easy VPN clients. When you use the Easy
VPN Server Proxy Setting feature, you do not have to manually modify the proxy settings of the web browser
when you connect to the corporate network using the Cisco I0S VPN client or manually revert the proxy
settings when you disconnect from the network.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > Easy VPN Server Proxy Setting.

Table 87: Security > Easy VPN Server Proxy Setting

Field

Description

Browser Proxy Name

Enter a name for the browser proxy setting profile.
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Security > GETVPN-GroupMember .

Field

Description

Proxy Server Settings Used by Client Browser

to use proxy server.

tunnel.

« Choosethe No Proxy Server optionif you do not want the clientsin thisgroup

 Choosethe Automatically Detect Proxy Settingsoptionif you want the clients
in this group to automatically detect a proxy server when they use the VPN

 Choosethe M anual Configuration option to manually configure aproxy server
for the clientsin this group.

IP Address of Proxy Server

Enter the | P address of the proxy server.

Port

Enter the port number of the proxy server.

Following Hosts

Do not Use Proxy Server for Accessing the

Enter the addresses of the hosts for whom the proxy server will not be used.

Bypass Proxy Serve for Local Addresses

(LAN) addresses.

Select the check box to prevent the clients from using the proxy server for local

Security > GETVPN-GroupMember

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Security > GET VPN Group Member.

Table 88: Security > GET VPN Group Member

Field

Description

Group Information

Group ID — Enter the group ID. Thisisaunique identity for a
GETVPN group member. This can be anumber or
an |P address.

Group Name — Enter the group Name for the GETVPN group

member.

IKE Authentication
Policy

Use this anchored field and its associated pop-up
dialog box to specify the authentication type and
policies for this GETVPN group member.

Pre-Shared Key

Select thisradio button to select pre-shared Key as
the IKE authentication type. If you select thisradio
button, you must provide the key in the Pre-Shared
Key field that is present immediately below the
button.

Confirm Pre-Shared Key

Enter the pre-shared key again to confirm. Thisfield
is displayed only when you select Pre-Shared Key
as the authentication type.
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Field

Description

Digital Certificate

Select thisradio button to select Digital Certificate
asthe IKE authentication type. If you choose this
authentication type, the router must have a digital
certificate issued by a Certificate Authority to
authenticate itself.

Priority

Set the authentication policy’s negotiation priority
by entering avalue from 1 to 10000, with 1 asthe
highest priority. The priority value determines the
order of the IKE proposals compared by the two
negotiating peerswhen attempting to find acommon
SA. If the remote | Psec peer does not support the
parameters selected in your first priority policy, the
device tries to use the parameters defined in the
policy with the next lowest priority number.

Authentication

Select the authentication policy’sauthentication type
fromthelist.

D-H Group Select the authentication policy’s Diffie-Hellman
group from the list.

Encryption Select the authentication policy’s encryption type
from thelist.

Hash Select the authentication policy’s hash type from
thelist

IKE Lifetime Enter the SA lifetime, in seconds. When thelifetime
isexceeded, the SA expires and must be renegotiated
between thetwo peers. Asagenera rule, the shorter
the lifetime, the more secure your |IKE negotiations
will be.

WAN Interface —

Field Reference for Configuration Pages |

Enter the WAN interface registration for the
GETVPN group member.

Traffic Details

Loca Exception Policy
ACL

Enter the Local Exception Policy ACL specifying
the traffic that the GETV PN group member must
send in clear text.

Fail Close ACL

Enter the Fail Close ACL specifying the traffic that
must be allowed when GETVPN encryption fails.
If the Fail Close ACL featureis configured, all the
traffic passing viathe group member will be dropped
until the group member is registered successfully.
After the group member is registered successfully
and SAs are downloaded, this feature is disabled
automatically.
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Field

Description

Key Servers

Primary Key Server

Security > GETVPN-KeyServer .

Enter the IP address or hostname of the primary
encryption key server. The primary key server is
responsible for creating and distributing group
policiesto all group members and periodically
synchronizing with the secondary key servers.

Secondary Key Servers | —

Use this edit table to specify the set of secondary
key servers. Enter themin order of priority, with the
highest priority at the top of the edit table. During
periods when the primary key server is down or
inaccessible, the accessible secondary key server
with the highest priority is elected to serve asthe
primary key server.

Enable Passive SA

Select the Enable Passive SA check box to enable
the Passive SA mode on the group member.

Security > GETVPN-KeyServer

The following table describes the Template Detail fields on Configuration > Templates > Featuresand

Technologies > Security > GET VPN Key Server.

Table 89: Security > GET VPN Key Server

Field Description

Template Detail

Group Name Enter the group name for the GETVPN group member template.

Group ID Enter a unique identity for the GETVPN group member. This can be anumber or an IP address. The

number range is from 0 to 2147483647.

IKE Authentication Policy

Authorization Type

IKE during the authentication phase.

Click the Preshared Keys or Digital Certificatesradio button:
* Preshared Keys—This allows for a secret key to be shared between two peers and to be used by
« Digital Certificates—An authentication method in which RSA key pairs are used to sign and

encrypt IKE key management messages. Certificates provide nonrepudiation of communication
between two peers, meaning that it can be proven that the communication actually took place.

Priority

The priority value of the IKE proposal. The priority value determines the order of the IKE proposals
compared by the two negotiating peers when attempting to find acommon SA. If the remote | Psec
peer does not support the parameters selected in your first priority policy, the device triesto use the
parameters defined in the policy with the next lowest priority number.

Valid values range from 1 to 10000. The lower the number, the higher the priority.

Field Reference for Configuration Pages .



. Security > GETVPN-KeyServer

Field Reference for Configuration Pages |

Field

Description

Encryption

Choose the encryption algorithm from the drop-down list. The encryption algorithm isused to establish
the Phase 1 SA for protecting Phase 2 negotiations:

* AES-128—Encrypts according to the AES using 128-bit keys.
* AES-192—Encrypts according to the AES using 192-bit keys.
» AES-256—Encrypts according to the AES using 256-bit keys.
* DES—Encrypts according to the DES using 56-bit keys.

» 3DES—Encryptsthreetimes using 56-bit keys. 3DES is more secure than DES but requires more
processing for encryption and decryption. It isless secure than AES. A 3DESIicenseisrequired
to use this option.

Hash

The hash agorithm used in the IKE proposal. This algorithm creates a message digest that is used to
ensure message integrity. The options are:

* SHA (Secure Hash Algorithm)—Produces a 160-bit digest. SHA ismore resistant to brute-force
attacks than MD5.

* MD5 (Message Digest 5)—Produces a 128-bit digest. MD5 uses | ess processing time than SHA.

Diffie-Hellman Group

The Diffie-Hellman group is used for deriving a shared secret between the two |1Psec peers without
transmitting it to each other. A larger modulus provides higher security but requires more processing
time. The two peers must have a matching modulus group. The options are:

» 1—Diffie-Hellman Group 1 (768-bit modulus).
» 2—Diffie-Hellman Group 2 (1024-bit modulus).

« 5—Diffie-Hellman Group 5 (1536-bit modulus, considered good protection for 128-bit keys, but
group 14 isbetter). If you are using AES encryption, use thisgroup (or higher). The ASA supports
this group as the highest group.

Lifetime

The lifetime of the SA, in seconds. When the lifetime is exceeded, the SA expires and must be
renegotiated between the two peers. Asageneral rule, the shorter the lifetime (up to apoint), the more
secure your IKE negotiationswill be. However, with longer lifetimes, future | Psec security associations
can be set up more quickly than with shorter lifetimes.

You can specify avalue from 60 to 2147483647. The default is 86400.

Registration Interface

Enter the name of the interface to which the crypto map must be associated.

Traffic Details

Local Exception ACL

Choose an ACL for the traffic that must be excluded from encryption.

Fail Close ACL

Choose an ACL for the traffic that must be sent in clear text until the group member registers with the
key server. If the Fail Close feature is configured, all the traffic passing viathe group member will be
dropped until the group member is registered successfully. After the group member is registered
successfully and SAs are downloaded, this feature is disabled automatically.

Key Server Information

Primary Key Server

Specify the primary key server | P address to which the client connects. The primary key server is
responsible for creating and distributing group policiesto al group members and periodically
synchronizing with the secondary key servers. The server with the highest priority is elected asa
primary key server.
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Security > ScanSafe .

Field Description

Secondary Key Server Specify the secondary key server |P address to which the group member falls back when the primary
key server registration fails. A group member can be configured to register to any available key server
from alist of al the secondary key servers. Group member configuration determines the registration
order. The key server defined first is contacted first, followed by the second defined key server, and
so on. You can have amaximum of eight key servers for a group member.

Migration

Enable Passive SA Use this option to enabl e the Passive SA mode on the group member. The Passive SA mode overrides
the receive-only SA option on the key server and encrypts all outbound traffic.

Group Name Enter the group name for the GETVPN group member template.

Security > ScanSafe

Table 90: Security ScanSafe

Cisco ISR Web Security with Cisco Scansafe is a cloud-based Security as a Service (SaaS) that allows you
to scan the content of the HTTP and HTTPs traffic. When Cisco ISR Web Security with Cisco ScanSafeis
integrated with arouter, the selected HTTP and HTTPS traffic is redirected to the ScanSafe cloud for content
scanning and malware detection.

When Cisco ISR Web Security with Cisco ScanSafeis enabled and the ISR is configured to redirect web
traffic to Cisco ISR Web Security with Cisco ScanSafe, the I SR transparently redirects HTTP and HTTPS
traffic to the ScanSafe proxy server based on the IP address and port. You can configure the ISR to relay web
traffic directly to the originally requested web server without being scanned by Cisco ISR Web Security with
Cisco ScanSafe.

Allowed List Traffic

You can configure the ISR so that approved web traffic is not redirected to Cisco | SR Web Security with
Cisco ScanSafe for scanning. When you bypass this scanning, the I SR retrieves the content directly from the
originally requested web server without contacting Cisco | SR Web Security with Cisco ScanSafe. When it
receives the response from the web server, it sends the datato the client. Thisis called Allowed Listing traffic.

For more information on ScanSafe see Security Configuration Guide

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Security > ScanSafe.

Field

Description

Server Information

Primary Server

Enter the I1Pv4 address or hostname of the primary ScanSafe server.

HTTP Port

Specify the HTTP port through which HTTP requests are to be redirected to the primary
server. By default, ScanSafe uses port 80 for the HTTP traffic. However, you can choose to
use different ports for each request type.

Field Reference for Configuration Pages .


http://www.cisco.com/c/en/us/td/docs/ios-xml/ios/sec_data_zbf/configuration/15-mt/sec-data-zbf-15-mt-book/scansafe-web-sec.html

. CLI Templates Field Descriptions

Field Reference for Configuration Pages |

Field Description

HTTPS Port Specify the HTTPS port to redirect the HTTPS requests to the primary server. By default,
ScanSafe uses port 443 for HTTPS traffic. However, you can choose to use different ports
for each request type.

Secondary Server Enter the IPv4 address or hostname of the secondary ScanSafe server.

HTTP Port (secondary) Specify the HTTP port through which HTTP requests are to be redirected to the secondary
server. By default, ScanSafe uses port 80 for HTTP traffic.

HTTPS Port Specify the HTTPS port through which HTTPS requests are to be redirected to the secondary

server. By default, ScanSafe uses port 443 for HTTPS traffic.

Scansafe License

Specify the license key that the ISR sends to the ScanSafe proxy server to indicate the
organization from which the request originated. The license is a 16-byte hexadecimal key.

Encrypt License Info

Select the Encrypt License I nfo check box to encrypt the license information.

Server Timeout

Specify the primary ScanSafe server timeout, in seconds. The ISR waits for the specified
timeout period before polling the ScanSafe proxy server to check its availability.

Session Timeout

Specify the primary ScanSafe session idle timeout, in seconds. If the primary server fails,
the ISR will use the secondary server as the active ScanSafe proxy server. The ISR
automatically falls back to the primary server aslong asit is active for three consecutive
timeout periods.

Source Interface

Specify the source | Pv4 address or interface name on which ScanSafe is enabled.

Router behavior when ScanSafe
server fail to respond

Specify how the ISR should handle the incoming traffic when it cannot reach the configured
ScanSafe proxy servers. The options are Drop all traffic or Allow al traffic. Drop all traffic
isthe default.

User Information

Global User

Enter a Global User when web authentication (webauth) is not configured under the router’s
ingress interface.

Globa User Group

Enter a Global User Group when web authentication (webauth) is not configured on the
router’s egress interfaces.

User Group Inclusion & Exclusion
Info

Use the two edit tables to specify the user group information to be included or excluded
during exchanges with the ScanSafe tower. The user group information is used only when
web authentication (webauth) is configured on the router’s ingress and egress interfaces.

Notify Allowed list Info to ScanSafe
Tower

Select this option to send the allowedlist information to the ScanSafe Tower and specify the
Safe URL, Safe User Agent, and Safe ACL information that is to be sent.

CLI Templates Field Descriptions

The following topics describe the fields used in the system CL | templates.
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802.1X Change of Authorization-10S .

* 802.1X Change of Authorization-10S

» Access Layer-10S

« Authentication Proxy-10S

« Banner Configuration-10S

* Certificate Authority-10S

e Core Layer-10S

« Crypto Map Configuration-10S

* DNS Configuration-10S

* DNS Configuration-NAM

* DNS Configuration-Nexus

« Distribution Layer-10S

* EEM Environmental Variables-10S

» Embedded Event Manager Configuration-10S

* Enable Password-10S

» GOLD Boot Level and Monitoring Test for Cat6k Devices-10S
* GOLD Monitoring Test for Non Stack Devices-10S

* GOLD Monitoring Test for Stack Enabled Devices-10S
* Guest Users

e HTTP-HTTPS Server and WSMA Configuration-10S
*« MAC Trap Configuration

» Mediatrace-Responder-Configuration

» Medianet-PerfMon

« RADIUS Configuration-10S

» Reload Configuration-10S

* Reload Configuration-NAM

» Web User Configuration-NAM

« User Defined Protocol Configuration-NAM

802.1X Change of Authorization-10S

Use this option to support RADIUS client configuration for dynamic authorization for switches.

The following table describes the Template Detail fields in Configuration > Templates > Features and
Technologies > Templates> CLI Templates > System Templates- CL| > 802.1X Change of
Authorization-10S.

Table 91: CLI Templates > System Templates - CLI > 802.1X Change of Authorization-10S

Field

Description

Form View

RADIUS client IP Address or Host Name DNShost name or | P address of the RADIUS server host

Type of authorization the device uses for Specify the type of authorization (any, all, on key) the device must use for
RADIUS clients RADIUS clients. The client must match the configured attributes for authorization.
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Field

Description

RADIUS Key shared between the device and
RADIUS clients

Specify the authentication and encryption key to the RADIUS server.

Thekey isatext string that must match the encryption key used on the RADIUS
server. The leading spaces are ignored, but spaces within and at the end of the key
are used. If you use spaces in the key, do not enclose the key in quotation marks
unless the quotation marks themselves are part of the key

Port on which the device listensfor RADIUS
requests

Specify the port number on which the device listens for RADIUS requests.
The port number should be from 0 to 65535. The default value is 1700.

Access Layer-10S

Use this option to configure the platform, LAN Switch Universal Settings, Access Switch Global Settings,
Client Connectivity, and connect the devicesto Distribution or WAN Router.

The following table describes the Template Detail fieldsin Configuration > Templates > Featuresand
Technologies > Templates> CL| Templates > System Templates- CL 1 > Access Layer-10S.

Table 92: CLI Templates > System Templates - CLI > Access Layer-10S

Field Description
Form View tab
Device Type Deploys the template only on the selected device type.
Note To avoid deployment issues, do not edit thisfield.
Device OID Deploys the template only on the selected device OID.
Note To avoid deployment issues, do not edit thisfield.
Switch Number Enter the Switch number for Catalyst 2960-S and 3750-X Platform.

L AN Switch Universal Configuration

Host name

Enter the hostname for the device to be configured.

IP Domain-name

Enter the default domain name that the Cisco | OS software uses to complete
unqualified hostnames (names without a dotted-decimal domain name). Do not
include theinitial period that separates an unqualified name from the domain
name.

SNM P-server community RO

Enter the SNM P-server community read-only access (RO) to set up the community
access string to permit access to the Simple Network Management Protocol
(SNMP).

SNMP-server community RW

Enter the SNM P-server community read-write access (RW) to set up the community
access string to permit access to the Simple Network Management Protocol
(SNMP).

Enable Secret Password

Enter the Enable Secret Passwor d command to provide encryption automatically.
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Access Layer-10S .

Field

Description

Username Admin Password

Enter the Username Admin Password.

IP Address of Tacacs Server

Enter the |P address of the TACACS server.

TACACS Key

Enter the TACACS secret key to authenticate the switch to the TACACS server.

NTP Server IP Address

Enter the IP address of the NTP Server in order to keep the clocks in sync for
applications and other desktop processes.

Time Zone

Enter thetime zone to comply with the new Daylight Saving Time (DST) changes.

Hours offset from UTC

Select the number of hours behind or ahead from Coordinated Universal Time
(UTC).

Minutes offset from UTC

Enter the number of minutes behind or ahead from Coordinated Universal Time
(UTC).

Summer Time zone

Enter the Daylight Saving Time.

Access Switch Glaobal Settingsand Client
Connectivity

Voice VLAN Enter the voice VLAN to enable access portsto carry | P voice traffic from an IP
phone.
DataVLAN Enter the data VLAN to carry only user-generated traffic.

Configure Access Switch Global Settings

Management VLAN

Enter the management VLAN for managing the switch from aremote location by
using protocols such as telnet, SSH, SNMP, syslog, and so forth.

Management |P Address

Enter the management | P address for discovering, monitoring, auditing, and
managing the | P address space used on a network.

Management Subnet Mask

Enter the management subnet mask.

Default Router |P Address

Enter the |P address of the default router.

Other Settings

Interface Type to Configure Client Connectivity

Select the interface type from the drop-down list.

Start Interface Number

Enter the starting interface number, for example, 0/1 for Gigabit Ethernet,1 for
PortChannel.

End Interface Number

Enter the ending interface number, for example, 2.

Connect to Distribution or WAN Router

Select the required option from the drop-down list.

Channel Group Number

Enter the Channel Group number to assign and configure an EtherChannel interface
to an EtherChannel group.
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Field

Description

WAN Router

Interface Type for Connect to Distribution or | Select the Interface Type from the drop-down list.

Start Interface Number

Enter the starting interface number, for example, 0/1 for Gigabit Ethernet,1 for
PortChannel.

End Interface Number

Enter the ending interface number, for example, 2.

Unused VLAN for Hopping

Enter the unused VLAN as native VLAN.

Authentication Proxy-10S

Use this option to log in to the network or access the Internet using HTTP and helps you to deploy the
Authentication Proxy system-defined configuration template on Cisco |OS devicesthat have been configured
for VPN functionality.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > Authentication Proxy-1OS.

Table 93: CLI Templates > System Templates - CLI > Authentication Proxy-10S

Field Description

AAA Action Select the required option to enable, disable. If you do not want to make any change, select
No Change.

AAA Methodl Select either TACACS+ or RADIUS as your first method of authorization. Select None if
you do not want to configure.

AAA Method2 Select either TACACS+ or RADIUS as your second method of authorization, based on your

selection in the first method. Select None if you do not want to configure.

Cache Timeout in Minutes

Timeout value. The default timeout value can be in the range from 1 to 2147483647. The
default valueis 60.

Banner Action

Select Enable or Disable to set or reset Banner display in the login page.

« If you select Enable, the router name is displayed in the login page.
* If you select Disable, then the router name is not displayed.

If you do not want to make any changes to the banner, select No Change.

Banner Text

Enter the text that you want displayed in the banner. If you enter the banner text, then this
text is displayed instead of the router name in the login page.

Thisisan optional field.
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Banner Configuration-10S .

Field

Description

Authentication Proxy Rule Action Select Enable or Disable an authentication proxy rule.

« If you select Enable, a named authentication proxy ruleis created and associated with
accesslist.
« If you select Disable, the associated proxy ruleis removed.

Select No Change if you do not want to make changes to the Authentication Proxy Rule
group of fields.

Authentication Proxy Rule Name Enter a name for the authentication proxy rule.

The name can be up to 16 aphanumeric characters.

Authentication Proxy Rule Overriding | Enter a timeout value to override the default cache timeout.

Timeout Thisisan optional field. The overriding timeout value should be in the range of 1 and
2147483647.

Authentication Proxy Rule ACL Enter a Standard Access list name or number to be used with the Authentication proxy.

Number/Name Thisis an optional field,

New Model [AAA] Action Select the required option to enable or disable AAA.

Banner Configuration-10S

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Templates> CL| Templates > System Templates- CL| > Banner Configuration-l10S.

Table 94: CLI Templates > System Templates - CLI > Banner Configuration-10S

Field Description

Form View tab

Motd Action Select the appropriate option to add or remove a message of the day banner. Select No Change if you are not
modifying an existing task, and you do not want to change the value in thisfield.

Motd Message Enter message, if you select Add in Action field. When a user connects to the router, the message-of-the-day
(Motd) banner appears before the login prompt.

Exec Action Select the appropriate option to add or remove an Exec banner. Select No Change if you are not modifying an
existing task, and you do not want to change the value in this field.

Exec Message Enter message, if you select Add in Action field. After the user logsin to the router, the Exec banner or the
incoming banner will be displayed.

Incoming Action | Select the appropriate option to add or remove an Incoming banner. Select No Changeif you are not modifying
an existing task, and you do not want to change the value in thisfield.

Incoming Message | Enter message, if you select Add in Action field. After the user successfully logsinto the router, the Exec banner
or the incoming banner will be displayed.
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Field Description

Login Action Select the appropriate option to add or remove a Login banner. Select No Change if you are not modifying an
existing task, and you do not want to change the value in this field.

Login Message | Enter message, if you select Add in Action field. When a user connects to the router, the Motd banner (if
configured) appears first, followed by the login banner and prompts.

Slip_PPP Action | Select the appropriate option to add or remove a Slip/PPP banner. Select No Change if you are not modifying
an existing task, and you do not want to change the value in thisfield.

Sip_PPPMessage | Enter custom SLIP or PPP connection message, if you select Add in Action field. Thisis useful when legacy
client applications require a specialized connection string.

Certificate Authority-10S

This template provides manageability and scalability for IP security standards on VPN devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CLI Templates > System Templates- CL1 > Certificate Authority-10S.

Table 95: CLI Templates > System Templates - CLI > Certificate Authority-10S

Field Description
Form View tab
Certificate Authority Action Select Enable or Disable to activate/deactivate Certificate Authority (CA).

« If you select Enable you can create or modify CA.
* If you select Disable, you can delete the CA.

Certificate Authority Name Enter the CA name. This name is used to identify the Certificate Authority to be configured.

This name isthe CA domain name.

Enrollment URL Action * Select Enable to allow router to connect to the CA, using the URL specified in the Value
fidd.

* Select Disable, if you do not want to connect to the CA.
» Select No Changeto leave the Enrollment URL field unchanged.

Enrollment URL Value Enter the URL of the CA.

The URL should include any available nonstandard cgi-bin script location.

Enrollment Mode Action * Select Enableif the CA provides a Registration Authority (RA).
* Select Disable to disable the specified LDAP Server.
« Select No Changeto leave the Enrollment Mode field unchanged.

Enrollment Mode LDAP Server Enter the LDAP server of the CA, if your CA system provides an RA.

LDAP server contains the location of CRL s (certification revocation lists) and certificates.
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Core Layer-10S .

Field

Description

Enrollment Retry Period in Minutes

Enter the wait period between certification request retries.
The wait period isfrom 1 to 60 minutes.

Select this option to set the default wait period to 1 minute.

Enrollment Retry Count Number

Enter the certification request retry number.
The retry number must be from 1 to 100.
Select this option to set the default retry period to 1 minute.

CRL Optional Action

Select Enable to check the Certificate Revocation List.
If you select Disable, Certificate Revocation list is unchecked.

If you do not want to make any change, select No Change.

Certificate Query Action

Select an option to enable, disable or make no change to certificate query.

« If you select Enable, certificate query will be added to all trust points on the router.
* If you select Disable, the certificate will not be queried.

RSA Key pairs Action

Select an option to generate, delete or make no change to the RSA key pairs. This feature
alows you to configure a Cisco 10S router to have multiple key pairs.

Thus, the Cisco 10S software can maintain a different key pair for each identity certificate.

RSA Key pairs Key Type

Specify the key type:
* General Purpose—To generate ageneral purpose key pair that isused for both encryption
and signature.
» Usage—To generate separate usage key pairs for encrypting and signing documents.

Enter number of modulus bits

Choose the size of the key modulus in the range of 360 to 4096 for Signature Keys. Choosing
akey modulus greater than 512 may take afew minutes.

Core Layer-10S

Use this option to configure the Platform, LAN Switch Universal Settings, Core Switch Global Settings, |P
Multicast Routing, and connect the devices to Distribution Layer.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > Core Layer-10S.

Table 96: CLI Templates > System Templates - CLI > Core Layer-10S

Field

Description

Form View tab

Configure LAN Switch Universal Setting

Host name

Enter the hostname of the LAN Switch Universal Configuration.
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Field

Description

|P Domain-name

Enter the default domain name that the Cisco | OS software uses to complete
unqualified hostnames (hames without a dotted-decimal domain name). Do
not include the initial period that separates an unqualified name from the
domain name.

SNMP-server community RO

Enter the SNM P-server community read-only access (RO) to set up the
community access string to permit accessto the Simple Network Management
Protocol (SNMP).

SNMP-server community RW

Enter the SNM P-server community read-write access (RW) to set up the
community access string to permit accessto the Simple Network Management
Protocol (SNMP).

Enable Secret Password

Enter the enable secret password command to provide encryption automatically

Username Admin Password

Enter the Username Admin Password.

IP Address of Tacacs Server

Enter the |P Address of the TACACS server.

TACACS Key

Enter the TACACS secret key to authenticate the switch to the TACACS
server.

NTP Server |P Address

Enter the IP address of the NTP Server in order to keep the clocks in sync for
applications and other desktop processes.

Time Zone Enter the time zone to comply with the new Daylight Saving Time (DST)
changes.
Hours offset from UTC Select the number of hours behind or ahead from Coordinated Universal Time

(UTO).

Minutes offset from UTC

Enter the number of minutes behind or ahead from Coordinated Universa
Time (UTC).

Summer Time zone

Enter the Daylight Saving Time.

Configure the Core Switch Global Settings

Loopback-1 IP Address

Enter the Loopback-1 |P address.

Loopback-2 |P Address

Enter the Loopback-2 |P address.

Autonomous System Number

Enter the autonomous system number to uniquely identify the network.

Network Address

Enter the network address.

Inverse Mask

Enter the inverse mask.

IP address of Rendezvous-point

Enter the | P address of Rendezvous-point (RP), which acts as the meeting
place for sources and receivers of multicast data.

Access List Number

Enter the access list number.
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Field Description

Multicast Network Enter the multicast network address.
Multicast Inverse Mask Enter the multicast inverse mask address.
Other Setting

Multicast Routing

MSDP Core Switch IP Address to Configure IP Enter the Multicast Source Discovery Protocol (MSDP) to allow multicast

sources for a group to be known to all rendezvous points (RPs) in different
domains.

Connecting to Distribution Layer

Port Channel Number

Enter the port channel number.

Port Channel IP Address Enter the port channel IP address.

Port Channel Subnet Mask Enter the port channel subnet mask.
<Present as Port Channel Network Mask>

TenGigabitEthernet First Interface Number Enter the TenGigabitEthernet first interface number.

TenGigabitEthernet Second I nterface Number Enter the TenGigabitEthernet second interface number.

Crypto Map Configuration-10S

Use this option to configure |PSec on devices. You must configure the IKE and Transform configuration
before configuring this template, and it can be downloaded only to VPN-enabled devices

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies> Templates> CL | Templates> System Templates- CL| > Crypto Map Configuration-1OS.

Table 97: CLI Templates > System Templates - CLI > Crypto Map Configuration-10S

Field Description
Form View tab
Crypto Map Action | Select an option to add or remove the Cisco |OS configuration.
Crypto Map Name | Enter the name for the crypto map.
Map Number Enter the number for the crypto map.
The value must be from 1 to 65535.
Map Type Select the map type (manual or isakmp) for the crypto map.
» Manual - Manual keying is usually only necessary when a Cisco device is configured to encrypt traffic
to another vendor's device that does not support Internet Key Exchange (IKE).
* ISAKMP - The ISAKMP provides aframework for Internet key management and provides the specific
protocol support for negotiation of security attributes.

Field Reference for Configuration Pages .



Field Reference for Configuration Pages |
Il ons configuration-10S

Field Description

Map Description Enter the description for the crypto map.

Crypto ACL Enter the extended access list for crypto map.

I PSec Peer Enter the | Psec peer hostname or | P address to be associated with the crypto map.

Transform Set Name | Enter the transform set name (see Security > VPN Components > Transform Sets) to be used with the crypto
map.

DNS Configuration-10S

Use this option to configure Domain Name System (DNS) on Cisco 10S devices.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Templates> CL| Templates > System Templates- CL1 > DNS Configuration-10S.

Table 98: CLI Templates > System Templates - CLI > DNS Configuration-10S

Field Description

Form View tab

Add DNS Servers Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to add.
Separate multiple addresses with commas.

If the device accepts only one DNS server, then the first address will be considered.

Remove DNS Servers | Enter the IPv4 Address/| Pv6 Address of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Remove Domain Name | Select this option to remove the domain names.

If you do not want to make any change, select No Change.

Domain Name Enter the |P addresses of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Domain Lookup Select to enable or disable IP DNS-based hostname-to-address trandl ation.

If you do not want to make any change, select No Change.

CLNSNSAP Select to enable or disable or make no change to the CLNS NSAP option. If this option is enabled, any
packet with the specified CLNS NSAP prefix causes CLNS (Connectionless Network Service) protocol to
behave asif no route were found.

If you do not want to make any change, select No Change.

OSPF Select to enable or disable or make no change to the OSPF (Open Shortest Path First) protocol option.

If you do not want to make any change, select No Change.
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Field

Description

Domain List Action

Select an option to add, remove, or make no change to the domain list.

If you do not want to make any change, select No Change.

Domain List

Enter domain names to complete unqualified hostnames, or add to the existing list.
Separate multiple domain names with commas.

Do not include an initial period before domain names.

DNS Configuration-NAM

Use this option to configure Domain Name System (DNS) on NAM category devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates- CL| > DNS Configuration-NAM.

Table 99: CLI Templates > System Templates - CLI > DNS Configuration-NAM

Field Description
Form View tab
Add DNS Servers Enter the |Pv4 Address addresses of DNS name server(s) that you want to add.
Separate multiple addresses with commas.
If the device accepts only one DNS server, then the first address will be considered.
Remove Domain Name | Select this option to remove the domain names.

Domain Name

Enter the IP addresses of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Disable Name Servers

Select to disable domain name servers.

DNS Configuration-Nexus

Use this option to configure Domain Name System - DNS on Nexus devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies >Templates > CLI Templates > System Templates- CL| > DNS Configuration-Nexus.

Table 100: CLI Templates > System Templates - CLI > DNS Configuration-Nexus

Field

Description

Form View tab
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Field

Description

Add DNS Servers

Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to add.
Separate multiple addresses with commas.

If the device accepts only one DNS server, then the first address will be considered.

Remove DNS Servers

Enter the IPv4 Address/IPv6 Address of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Remove Domain Name | Select this option to remove the domain names.

Domain Name

Enter the | P addresses of DNS name server(s) that you want to remove.

Separate multiple addresses with commas.

Domain Lookup

Select to enable or disable |P DNS-based hostname-to-address translation.
If you do not want to make any change, select No Change.

Domain List Action

Select an option to add, remove, or make no change to the domain list.

If you do not want to make any change, select No Change.

Domain List

Enter domain names to compl ete unqualified hostnames, or add to the existing list.

Separate multiple domain names with commas.

Do not include an initial period before domain names.

Distribution Layer-10S

Use this option to configure the Platform, LAN Switch Universal Settings, Distribution Global Settings, and
connect the devicesto Access Layer and LAN Core or WAN Router.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Templates> CL| Templates > System Templates- CL 1| > Distribution Layer-10S.

Table 101: CLI Templates > System Templates - CLI > Distribution Layer-10S

Field Description

Form View tab

Device Type Deploys the template only on the selected device type.
Note Do not edit thisfield to avoid deployment issues.

Device OID Deploys the template only on the selected device OID.
Note Do not edit thisfield to avoid deployment issues.

Switch Number Enter the Switch number.

L AN Switch Univer sal Configuration
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Field

Description

Host name

Enter the hostname of the LAN Switch Universal Configuration.

|P Domain-name

Enter the default domain name that the Cisco 10S software uses to complete
unqualified hostnames (names without a dotted-decimal domain name). Do not
includetheinitial period that separates an unqualified name from the domain name.

SNM P-server community RO

Enter the SNM P-server community read-only access (RO) to set up the community
access string to permit access to the Simple Network Management Protocol (SNMP).

SNMP-server community RW

Enter the SNM P-server community read-write access (RW) to set up the community
access string to permit accessto the Simple Network Management Protocol (SNMP).

Enable Secret Password

Enter the enable secret password command to provide encryption automatically.

Username Admin Password

Enter the Username Admin Password.

IP Address of Tacacs Server

Enter the |P address of the TACACS server.

TACACS Key

Enter the TACACS secret key to authenticate the switch to the TACACS server.

NTP Server |P Address

Enter the |P address of the NTP Server in order to keep the clocks in sync for
applications and other desktop processes.

Time Zone

Enter the time zone to comply with the new Daylight Saving Time (DST) changes.

Hours offset from UTC

Select the number of hours behind or ahead from Coordinated Universal Time (UTC).

Minutes offset from UTC

Enter the number of minutes behind or ahead from Coordinated Universal Time
(UTC).

Summer Time zone

Enter the Daylight Saving Time.

Distribution Global Settings Configuration

Loopback-1 IP Address

Enter the Loopback-1 | P address.

IP address of Rendezvous-point

Enter the IP address of Rendezvous-point (RP), which acts as the meeting place for
sources and receivers of multicast data.

Multicast Network Address

Enter the multicast network address.

Network Address

Enter the network address.

Inverse Mask

Enter the inverse mask address.

Autonomous System Number

Enter the autonomous system number to uniquely identify each network.

Other Setting

Access List Number

Enter the access list number.

Connecting to Access L ayer

DataVLAN

Enter the data VLAN to carry only user-generated traffic.
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Field Description

Voice VLAN Enter the voice VLAN to enable access portsto carry |P voice traffic from an IP
phone.

Management VLAN Enter the management VLAN for discovering, monitoring, auditing, and managing

the | P address space used on a network.

Unused VLAN for Hopping

Enter the unused VLAN as native VLAN to prevent hopping.

Channel Group Number

Enter the channel group number to assign and configure an EtherChannel interface
to an EtherChannel group.

Interface Type

Select the interface type from the drop-down list.

TenGigabitEthernet First Interface Number

Enter the TenGigabitEthernet first interface number.

TenGigabitEthernet Second I nterface Number

Enter the TenGigabitEthernet second interface number.

DHCP Server |P Address

Enter the Dynamic Host Configuration Protocol (DHCP) IP Address to allocate the
network device an |P address.

DataVLAN IP Address

Enter the data VLAN |P address.

DataVLAN IP Mask

Enter the dataVLAN |P mask.

Voice VLAN IP Address

Enter the voice VLAN |P address.

Voice VLAN IP Mask

Enter the voice VLAN [P mask.

Management VLAN IP Address

Enter the Management VLAN |P address.

Management VLAN IP Mask

Enter the Management VLAN [P mask.

Connectingto LAN Core or WAN Router

Port Channel Number

Enter the port channel number.

Port Channel 1P Address

Enter the port channel |P address.

Port Channel Subnet Mask

Enter the port channel subnet mask.

Network Address Enter the network address.
Network Subnet Mask Enter the network subnet mask.
Interface Type Select the interface type from the drop-down list.

Start Interface Number

Enter the starting interface number for connecting to LAN Core or WAN router.

End Interface Number

Enter the ending interface number for connecting to LAN Core or WAN router.
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EEM Envi

ronmental Variables-10S

EEM Environmental Variables-10S .

Use this option to configure Embedded Event Manager (EEM) Environmental variables used by the EEM

TCL script policies on Cisco |OS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CL| Templates > System Templates- CL| > EEM Environmental

Variables-1OS.

Table 102: CLI Templates > System Templates - CLI > EEM Environmental Variables-10S

Field Description
Form View tab
Action Select either:

» Add—to add one or more variables.
or

* Remove—to remove one or more variables.

Variable Name

Enter the name for the variable.
Example:

my_counter

You can create a maximum of five variables at atime.

Variable Value

Enter the value for the variable.
Example:
15

Now the variable my_counter will have the value 15.

N\

Embedded Event Manager Configuration-10S

Note Five variable names and variable values can be entered at one time. To enter more than five variable names

and values, the template must be redeployed.

Use this option to configure Embedded Event Manager (EEM) scripts or applets on the Cisco |OS devices.

The following table describes the Template Detail fieldson Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > Embedded Event M anager

Configuration-10S.

Field Reference for Configuration Pages .
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Table 103: CLI Templates > System Templates - CLI > Embedded Event Manager Configuration-10S

Field

Description

Form View tab

EEM Configuration Action

Select Register or Unregister to register or unregister a script or applet.

EEM Configuration Policy Type

Select either Script or Applet as the policy.
When you choose script as the policy type, enter the following fields:

* Create New Directory

* Directory Name

* Enter the Server Name

« Enter the Script File Location with Name

When you choose Applet as the policy type, enter the following fields:

« Enter the Applet Name
« Enter the Applet File Content

Create New Directory

Check this option if you want to create a new directory on the device to copy the script.

If you select this check box, the input given in the Directory Name text box is used to create a
new directory.

Directory Name

Enter the absolute path of the directory where the file needs to be placed on the device.
Example:

diskO:/Testing

Here anew directory Testing is created in the device under the diskO partition.

Ensure that the selected directory has enough space before the script files are copied.

Enter the Server Name

Enter the TFTP server name.
Note The script file should be available in the TFTP boot folder.

Enter the Script File Location

Use this option to enter the file location to upload the scripts to deploy on the device.
Ensure that you enter the absolute path along with the filename.

Note You can specify only single script file.

Enter the Applet Name

Enter the Applet Name if you have chosen Unregister as the EEM Configuration Action.

Enter the Applet File Content

Enter the Applet File Content if you have chosen Register as the EEM Configuration Action.

Enable Password-10S

Use this option to configure the enable or secret password and enter into the enable mode on Cisco 10S

devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL | > Enable Password-10S.
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GOLD Boot Level and Monitoring Test for Cat6k Devices-10S .

Table 104: CLI Templates System Templates - CLI Enable Password-10S

Field Description

Form View tab

Action Select an option to enable, disable, or make no change to the enable password.
If you do not want to make any change, select No Change.

Enable Password | Enter the enable password.

Password Level | Set the Enable Password level. The level can be from 1 to15.
For a Cisco |OS device, it is advisable not to disable both Enable Password and Enable Secret password as
enabling the password will not allow the Cisco 10S device to go into the Enable mode. You can do thisonly if
you have the console password for the device.
If you have selected Enable Password as No Change in the Common Parameters pane, and selected Disable for
Enable Secret in the |OS Parameters pane, then Enable Secret Password is updated in the Device and Credentials
database.
If you have selected Enable Password as Disable in the Common Parameters pane, and selected No Change for
Enable Secret inthe | OS Parameters pane, then Enable Password is updated in the Device and Credential s database.

Encrypted Select this option to encrypt the password.

Secret Action Select an option to enable, disable or make no change to the secret password.

Secret Password | Enter the secret password.

Level Set the password level. The level can be between 1 and 15.

Encrypted Select this option to encrypt the password.

GOLD Boot Level and Monitoring Test for Cat6k Devices-10S

Use this option to configure GOLD Boot Level and Monitoring tests on Cat6k devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > GOLD Boot Level And
Monitoring Test for Cat6ék Devices-10S.

Table 105: CLI Templates > System Templates-CLI > GOLD Boot Level and Monitoring Test for Cat6k Devices-10S

Field Description

Gold Boot Level Configuration Action Select either Enable to enable the actions or Disable to disable the actions.

Gold Bootup Level Select either Compl ete to set the boot level to Complete or Minimal to set the boot
level to Minimal.
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Field

Description

GOLD Monitoring Test Action

Select any of the following:

» Addinterval —To add an interval.
» Nointerval —To not to add an interval.

If you do not want to make any changes to the GOLD Monitoring Test Action, select
No Change.

GOLD Monitoring Test Module Number

Enter the Gold Monitoring Test Module Number that is in the selected device. You
can enter one or more module numbers separated by commas.

Tests Details Action

Select any of the following:

« All - Allows you to configure all diagnostic tests.
* Testnames —Allows you to manually enter the test names.
* TestRange —Allows you to enter arange for teststo be run.

Test Names Enter one or more test names separated by comma. Do not add space in between
commas. Thisfield ismandatory if action is Testnames.
Range Enter test ranges. Thisfield is mandatory if action is TestRange.

No. of Days To Configure Health Monitoring
Interval

Enter the number of daystill which you require the teststo be run on the devices. The
number of days can be any value from 0 to 20.

Begin Time To Configure Health Monitoring
Interval

Enter the hours, minutes and seconds frequency at which the tests should be run.

Configuring Health Monitoring Interval in
Milliseconds

Enter the millisecond freguency at which the tests should be run. You can enter any
value from 0 to 999 for the second.

Enable/Disable Health Monitoring
Diagnostics Test Action

Select any of the following:

* Enable - To start the Health Monitoring tests.
* Disable - To stop the running Health Monitoring tests.

If you do not want to make any changes to the Health Monitoring test action, select
No Change.

GOLD Monitoring Test for Non Stack Devices-10S

Use this option to configure GOL D monitoring tests on nonstack devices.

The following table describes the Template Detail fields on Configuration > Templates > Featuresand
Technologies > Templates> CL| Templates > System Templates- CLI > GOLD Monitoring Test for
Non Stack Devices-1OS.
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GOLD Monitoring Test for Stack Enabled Devices-10S .

Table 106: CLI Templates > System Templates - CLI > GOLD Monitoring Test for Non Stack Devices-10S

Field

Description

Non Stack Health Monitor Action

Select any of the following:

¢ Addinterval - To add an interval
* Nointerval - To not to add an interval

If you do not want to make any changes to the Non Stack Health Monitor Action, select No
Change.

Non Stack Tests Details Action

Select any of the following:

« All - Allows you to configure all diagnostic tests.
* Testnames - Allows you to manually enter the test names.
« TestRange - Allows you to enter arange for tests to be run.

GOLD Monitoring Test for Stack Enabled Devices-10S

Use this option to configure GOLD Monitoring tests on stack-enabled devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CL| Templates > System Templates- CLI > GOLD Monitoring Test for
Stack Enabled Devices-1OS.

Table 107: CLI Templates > System Templates - CLI > GOLD Monitoring Test for Stack Enabled Devices-10S

Field

Description

Stack Health Monitor Action

Select any of the following:

» Addinterval - To add an interval
* Nointerval - To not to add an interval

If you do not want to make any changesto the Stack Health Monitor Action, select No Change.

Stack Health Monitor Switch 1d(s)

Enter the Switch ID. You can enter asingle switch ID or a number of switch |Ds separated by
comma. Example 1: Enter 2 if you want to include switch with ID 2. Example 2: Enter 3, 6 if
you want to include switches with IDs 3 and 6.

Stack Tests Details Action

Select any of the following:

* All - Allows you to configure al diagnostic tests.
* Testnames - Allows you to manually enter the test names.
* TestRange - Allows you to enter arange for tests to be run.

Guest Users

The purpose of a guest user account is to provide a user account for alimited amount of time. A Lobby
Ambassador isableto configure aspecific time framefor the guest user account to be active. After the specified
time period, the guest user account automatically expires. Choose Configuration > Templates > Features
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. HTTP-HTTPS Server and WSMA Configuration-10S

& Technologies> CL| Templates > System Templates- CL1 > Guest Usersto access the Guest Users
template page.

Table 108: CLI Templates > System Templates - CLI > Guest Users

Field

Description

User Name

Enter aguest username in the User Name text box. The maximum size is 24 characters.

Password

Enter a password for this username in the Passwor d text box.

Advanced

« Choose tbe guest user to connect to from the Profile drop-down list.
* Choose a user role for the guest user from the drop-down list. User roles are predefined by the administrator and
are associated with the access of the guest.

User Roleis used to manage the amount of bandwidth allocated to specific users within the network.
Choose one of the following radio buttons to specify the lifetime of the guest account:

e e« Limited—The period of time that the guest user account is active using the hours and minutes drop-down
lists. The default value for Limited is one day (8 hours).
* Unlimited Lifetime—no expiration date for the guest account.

» Choose the area (indoor, outdoor), controller list, or config group to which the guest user traffic islimited from
the Apply to drop-down list.

» Modify the default guest user description on the General tab if necessary. Thisis not mandatory.

» Modify the Disclaimer text on the General tab, if necessary. If you want the supplied text to be the default, select
the Make this Disclaimer default check box. Thisis not mandatory.

* Click Save.

HTTP-HTTPS Server and WSMA Configuration-10S

Use this option to configure HT TP access on devices that, in turn, configure WSMA and VPN functionality.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CL| Templates > System Templates- CLI > HTTP-HTTPS Server and
WSMA Configuration-10S.

Table 109: CLI Templates > System Templates - CLI > HTTP-HTTPS Server and WSMA Configuration-10S

Field Description

Server Action Select an option to enable or disable HTTP or HTTPs access on the device. Select No Changeif you do
not want to make changes to the server action.

Port Number Specify the HTTP or HTTPs server port number from 1024 to 65535. Default HTTP prt number is 80 and

default HTTPS port number is 443.

Authentication Action | Select an option to enable or disable authentication method. Select No Changeif you do not want to make

changes to the authentication action.
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MAC Trap Configuration .

Field

Description

Authentication Method

Select an authentication method:
* 32a
* Enable

* |local
* tacacs

AccessList Action

Select an option to enable or disable access list. Select No Change if you do not want to make changes to
the Access List Action.

ACL Number/Name

Enter the Access Control List number or name to be used. The access list number must be from 1 to 99.

WSMA Action

Select an option to enable or disable WSMA action. Select No Changeif you do not want to make changes
to the WSMA Action.

To apply HTTP-HTTPS Server and WSMA Configuration-10S template for Cisco |0S devices, do the
following:

Create two instances for the template, that is, you can edit the given template and save the template as
HTTP-WSMA-For-ISR-ASR-Series (with WSMA as enable/disable) and then again edit the given template
and save the template with a different name.

\}

Note

You must enable the WSMA option for ISR, ISR-G2 and ASR series of routers. Keep the WSMA option as

“No Change” for other routers.

MAC Trap Configuration

Use this option to enable SNMPv1 or SNMPv2 MAC Notification Traps on switches.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > MAC Trap Configuration.

Table 110: CLI Templates > System Templates - CLI > MAC Trap Configuration

Field

Description

Device OID

Deploys the template only on the selected device OID.

Note Do not edit thisfield to avoid deployment issues.

Notification Interval

Enter the time interval between traps from 0 to 2147483647 seconds.

Host Name/I P Address

Enter the hostname or |P address of the trap receiver.

SNMP Community Enter the SNMP v1/v2c community string.
UDP Port Enter the UDP port number on which the trap is received from 0 to 65535.
Interface Range Enter the interface or interface range on which the trap must be configured.
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Mediatrace-Responder-Configuration

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > -Responder-Configuration.

Table 111: CLI Templates > System Templates - CLI > Mediatrace-Responder-Configuration

Field Description

NameDescription | Enter a name for the template and an optional description.

Tags Enter one or more tags.
Tags are used to group templates. There are two ways you can tag a template:

« Create the tags when you create the template.
« Use the Tag icon located under the Templates search bar.

Device Type Choose Routers.

OS Version Enter the OS Version for the selected device type. This must be at least the minimum Cisco |OS version shown
in the following table. If thisfield is left empty, all available types for the chosen device type category
(Family/Series/Type) will be displayed.

Medianet-PerfMon

Use this option to configure performance monitoring for Medianet. In the Form View tab, you cannot edit
the fields since they act as variables for the CLI Template.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > Medianet-PerfMon.

Table 112: CLI Templates > System Templates - CLI > Medianet-PerfMon

Field Description
NameDescription Indicates the name for the template and an optional description.
Tags Enter one or more tags.

Tags are used to group templates. There are two ways you can tag a template:

« Create the tags when you create the template.
» Use the Tag icon located under the Templates search bar.

Device Type Select one of the Medianet PerfMon-compatible device types from the drop-down list.

OS Version Enter the OS Version for the selected device type. This must be at least the minimum Cisco 10S
version showninthefollowing table. If thisfield isleft empty, all availabletypesfor the chosen device
type category (Family/Series/Type) will be displayed.

Flow Exporter Name A name for the NetFlow exporter on the device types you selected. This can be any collection of
characters (for example: EXPORTER-1).
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Field Description

Flow Exporter Address The |P address of the Prime Infrastructure server.

Flow Exporter Port The port on which the NetFlow monitor will receive the exported data. Use the default 9991 port
unless you have a specia need to override it.

Performance Monitor Name | An arbitrary name for the Medianet Performance Monitor caching the data from the flow exporter
(for example: MP-MONITOR-1).

Interface The name of the interface on the device whose NetFlow data you want to monitor (for example:
ethernet 0/0).
Flow Monitor Name An arbitrary name for the NetFlow monitor caching the data from the flow exporter (for example:

FLOW-MONITOR-1).

RADIUS Configuration-10S

Use this option to configure Single Radius Host and Radius Group for |OS devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL| > Radius Configuration-l1 OS.

Table 113: CLI Templates > System Templates - CLI > Radius Configuration-10S

Field

Description

Radius Group Name

Enter the RADIUS group name.

Shared Key

Specify the authentication and encryption key to the RADIUS server.

Verify Shared Key

Specify the key for verification.

Server name or |P Address for Radius
Group/Host

DNS name or IP address of the RADIUS server group/host.
If you are entering a single RADIUS hogt, only the following fields must be entered:

* Shared Key

* Verify Shared Key

* Server name or |P address for Radius Group/Host
« Authentication Port

« Accounting Port

* Enablefor 802.1X / MAB AAA

» Enable AAA for Web Authentication

Authentication Port

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Accounting Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.
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Field

Description

Server name or |P Address for Radius
Group Only

DNS name or IP address of the RADIUS server group.

Authentication Port

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Accounting Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Server name or |P Address for Radius
Group Only

DNS name or IP address of the RADIUS server group.

Authentication Port

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Accounting Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Server name or |P Address for Radius
Group Only

DNS name or IP address of the RADIUS server group.

Authentication Port

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Accounting Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Server name or |P Address for Radius
Group Only

DNS name or IP address of the RADIUS server group.

Authentication Port

Specify the port number for authentication requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for authentication if port number is set
to 0. The default authorization port number is 1645.

Accounting Port

Specify the port number for accounting requests. Authentication and Accounting port
numbers cannot be the same. The host is not used for accounting if the port number is set
to 0. The default accounting port number is 1646.

Enablefor 802.1X / MAB AAA

Select the required option to enable or disable AAA for 802.1X and MAB authentication.

Enable AAA for Web Authentication

Select the required option to enable or disable AAA for Web-Based Authentication
(WebAuth).
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Reload Configuration-10S

Use this option to reload the Cisco 10S devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates > CLI Templates > System Templates- CLI > Reload Configuration-10S.

Table 114: CLI Templates > System Templates - CLI > Reload Configuration-10S

Field Description

Do not Save config beforereload | Check this option if you do not want to save the configurations before rel oading.

Enter time to wait after reload | Enter the duration to wait after reload in minutes.

Reload Configuration-NAM

Use this option to reload the NAM devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > Reload Configuration-NAM.

Table 115: CLI Templates > System Templates - CLI > Reload Configuration-NAM

Field Description

Enter time to wait after reload | Enter the duration to wait after reload in minutes.

Web User Configuration-NAM

Use this option to create, edit, and remove alocal web user for NAM devices.

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies> Templates> CL| Templates> System Templates- CL | >Web User Configuration-NAM.

Table 116: CLI Templates > System Templates - CLI > Web User Configuration-NAM

Field Description

Action Select an option to add or remove web user group of fields. Select No Change, if you do not
want to make changes to the action.

Username Enter the username of the web user.

Enter DES encrypted WebUser Enter the DES password for the username.

Password

Account Management Select the required option to enable or disable account management. Select No Change, if

you do not want to make changes to account management.

System Config Select the required option to enable or disable system configuration. Select No Change, if
you do not want to make changes to system configuration.
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. User Defined Protocol Configuration-NAM

Field Description

Capture Select the required option to enable or disable capture configuration. Select No Change, if
you do not want to make changes to capture configuration.

Alarm Config Sel ect the required option to enable or disable alarm configuration. Select No Change, if you
do not want to make changes to alarm configuration.

Collection Config Select the required option to enable or disable collection configuration. Select No Change,
if you do not want to make changes to collection configuration.

User Defined Protocol Configuration-NAM

The following table describes the Template Detail fields on Configuration > Templates > Features and
Technologies > Templates> CL| Templates > System Templates- CL1 > User Defined Protocol
Configuration-NAM.

Table 117: User Defined Protocol Configuration-NAM Template Page Field Descriptions

Field Description
Action Select an option to add, remove or replace the user-defined protocol.
Protocol Select the protocol:
- TCP
* UDP
Port Enter the port number. You can enter any port number in the range of 0 to 65535.
Name Enter the name of the user-defined protocol.
Host Select this option to enable host—Examines a stream of packets; produces atable of al network addresses observed
in those packets (also known as the collection data).
Each entry recordsthetotal number of packets and bytes sent and received by that host and the number of nonuni cast
packets sent by that host.
Conversations | Select this option to enable host conversations.
ART Select this option to enable Application Response Time.

Network Analysis Module Field Descriptions

The following topics contain field descriptions for pages found in Configuration > Templates > Features
and Technologies >Network Analysis Module

* Network Analysis Module > Monitoring
» Network Analysis Module > System
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Network Analysis Module > Monitoring

The following table describes the fields in Configuration > Templates > Features and Technologies >
Network Analysis Module > Monitoring.

Table 118: Network Analysis Module > Monitoring

Field Description

Response Time Enable Response Time Monitor check box and enter response time
ResponseTimel<=ResponseTime2<=ResponseTime3<=ResponseTimed<=ResponseTime5<=ResponseTime6<=L ate
Response Time.

Voice Enable the Call Signal Monitoring check box and enter MOS Quality Ranges as per NAM supported values.

RTP Filter Enable the RTP Stream Monitoring check box and enter the filter with source and destination | Pv4/IPv6 address and
mask.

Aggregation Interval | Enter minimum values for short term and long term interval.

Network Analysis Module > System

The following table describes the T fieldsin Configuration > Templates > Features and Technologies >
Network Analysis Module > System.

Table 119: NAM Analysis Module > System

Field Description

DNS Parameters Enter the Domain Name and DNS server |P address.

SNMP Agent Create SNM P community with read-only or read-write permissions.

System Time Enable the Synchronize System Time With NTP check box and enter the Primary NTP Server Name/IP
Address (IPV4 or IPV6), Secondary NTP Server Name/IP Address (IPV4 or IPV6), and Time Zone.

Email Setting Enable the Mail check box and enter the External Mail Server and Mail Alarm to (mail ID).

Web Data Publication

Enable the Web Data Publication check box and enter the Access list P address or Subnet which hasto
be permitted.

SNMP Trap

Enter community details with the |P address and UDP port for the SNMP trap.

\}

Note

Job status of the system template deploy for NAM3 displays failure, but changes happen on the NAM device.
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Wireless Configuration Field Descriptions

The following topics contain field descriptions for pages found on Design > Configuration > Wireless
Configuration.

* FlexConnect Parameters

* Lightweight AP Configuration Templates

« Switch Location Configuration Template

« Autonomous AP Migration Templates

« Controller Configuration Groups

FlexConnect Parameters

Thefollowing table describesthe FlexConnect fiel dswhen you choose Configur ation > Networ k > Networ k
Devices, select Device Type > Wireless Contraller, click a Device Name of a controller, then select
FlexConnect.

Table 120: Wireless Controller > FlexConnect Parameters

Field Description

General tab

Template Name Name of the template applied to this controller.

Primary Radius From the drop-down list, choose the primary radius authentication server present on the controller.

If the selected or configured Radius Authentication Server is not present on the controller with
version less than 7.4, the template will fail.

You must configure the RADIUS server configuration on the controller before you apply
FlexConnect RADIUS server configuration from the Prime Infrastructure.

Secondary Radius From the drop-down list, choose the secondary radius authentication server present on the
controller. If aRADIUS authentication server is not present on the controller, the Prime
Infrastructure configured RADIUS server does not apply.

FlexConnect AP tab

Ethernet MAC Select the check box to apply to the FlexConnect group.

An AP Ethernet MAC address cannot exist in more than one FlexConnect group on the same
controller. The controller does not alow you to set an AP Ethernet MAC in a FlexConnect group
if itisalready present in another FlexConnect group.

Add AP Click to add an additional FlexConnect AP (present in the Prime Infrastructure) to an existing
FlexConnect group. When you click Add AP, only those access points that are part of this
FlexConnect group islisted.

To enable local authentication for a FlexConnect group, click the FlexConnect Configuration
tab. Make surethat the Primary RADIUS Server and Secondary RADIUS Server parameters are
set to None on the General tab.
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Field Description
LEAP Select to alow a FlexConnect access point to authenticate clients using LEAP.
EAP-FAST Select to allow a FlexConnect access point to authenticate clients using EAP-FAST. You must

provide the EAP-FAST key aswell as confirm the EAP-FAST key.

Protected Access Credentials
(PACs)

 To use manual PAC provisioning, enter the key used to encrypt and decrypt PACsin the
EAP=FAST Key text box. The key must be 32 hexadecimal characters.

 To alow PACsto be sent automatically to clients that do not have one during PAC
provisioning, select the Ignore Server Key check box.

EAP-FAST Authority ID

Enter the authority identifier of the EAP-FAST server. The identifier must be 32 hexadecimal
characters.

EAP-FAST Authority Info

Enter the authority identifier of the EAP-FAST server in text format. You can enter up to 32
hexadecimal characters.

EAP-FAST PAC Timeout

Specify a PAC timeout value by entering the number of seconds for the PAC to remain visible
in the edit text box. The valid range is 2 to 4095 seconds.

Image Upgrade tab

FlexConnect AP Upgrade

Select this option to upgrade the FlexConnect access points.

Subordinate Maximum Retry
Count

Select this option to specify the maximum retries for the subordinate to undertake to start the
download from the primary in the FlexConnect group. This option isavailable only if you select
the FlexConnect AP Upgrade check box.

You are allowed to add an access point as a primary access point only if the FlexConnect AP
Upgrade check box is enabled on the General tab.

Lightweight AP Configuration Templates

« Lightweight AP Configuration Templates > Template Basic

* Lightweight AP Configuration Templates > AP Parameters

* Lightweight AP Configuration Templates > Mesh

« Lightweight AP Configuration Templates > 802.11a/n/ac

« Lightweight AP Configuration Templates 802.11a > SubBand

* Lightweight AP Configuration Templates > 802.11b/g/n

* Lightweight AP Configuration Templates > 802.11a/b/g/n

« Lightweight AP Configuration Templates > CDP

« Lightweight AP Configuration Templates > FlexConnect

* Lightweight AP Configuration Templates > Schedule
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Lightweight AP Configuration Templates > Template Basic

Thefollowing table describesthefieldsin the Template Basic tab in Configuration > Templates> Lightweight
Access Points.

Table 121: Lightweight AP Configuration Templates > Template Basic

Field Description
Template Name of the Lightweight AP Configuration template.
Name

Description Description for the Lightweight AP Configuration template.

Lightweight AP Configuration Templates > AP Parameters

Thefollowing table describesthefieldsin the AP Parameterstab in Configur ation > Templates> Lightweight
Access Points.

Table 122: Lightweight AP Configuration Templates > AP Parameters

Field Description

General

Location Enter the location in the Location text box.

Admin Status Select the Admin and Enabled check box to enable administrative status.
To conserve energy, access points can be turned off at specified times during nonworking
hours. Select the Enabled check box to allow access points to be enabled or disabled.
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Field

Description

AP Mode

From the drop-down list, choose one of the following:
* L ocal—Default

« Monitor—Monitor mode only.

Choose Monitor to enable this access point template for Cisco Adaptive wlPS. Once
Monitor is selected, select the Enhanced WIPS Engine check box and the Enabled check
box. Then select the AP Monitor Mode Optimization check box and choose WIPS from
the AP Monitor Mode Optimization drop-down list.

* FlexConnect—Cisco 1030 remote edge lightwei ght access point (REAP) used for
Cisco 1030 |EEE 802.11a/b/g/n remote edge lightweight access points.

FlexConnect must be selected to configure an OfficeExtend access point. When the AP
mode is FlexConnect, FlexConnect configuration options display including the option to
enable OfficeExtend AP and to enable Least Latency Controller Join.

« Rogue Detector—Monitors the rogue access points but does not transmit or contain
rogue access points.

* Bridge

« Sniffer—The access point “ sniffs’ the air on agiven channel. It captures and forwards
all the packets from the client on that channel to a remote machine that runs airopeek
(apacket analyzer for IEEE 802.11 wireless LANS). It includes information on
timestamp, signal strength, packet size, and so on. If you choose Sniffer asan operation
mode, you are required to enter a channel and server |P address on the AP/Radio
Templates 802.11b/g/n or 802.11a/n parameters tab.

The sniffer feature can be enabled only if you are running AiroPeek, which isathird-party
network analyzer software that supports decoding of data packets. For more information
on AiroPeek, see http://mww.wildpackets.com.

» SE-Connect—Thismode allows a CleanAir-enabled access point to be used extensively
for interference detection on all monitored channels. All other functions such as IDS
scanning and Wi-Fi are suspended.

Thisoption is displayed only if the access point is CleanAir-capable.

Changing the AP mode reboots the access point.

AP Sub Mode

Choose an option from the drop-down list.

Enhanced wiPS Engine

Select the Enhanced wl PS engine and the Enabled check box to enable.

AP Height (feet) Enter the height of the access point (in feet) in the text box.
Mirror Mode Select the Enabled check box to enable mirror mode.
Country Code Choose the appropriate country code from the drop-down list.

Stats Collection Interval

Enter the stats collection interval in the text box.
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Field

Description

Cisco Discovery Protocol

Select the Enabled check box to enable Cisco Discovery Protocol.

AP Failover Priority

Choose L ow, Medium, High, or Critical from the drop-down list to indicate the access
point failover priority. The default priority islow.

Pre-Standard 802.3af switches

Pre-Standard 802.3af switches

Antenna Band Mode

Antenna Band Mode

Domain Name

Domain Name can be configured only on APs which have static IP.

Server |P Address

Domain Name Server |P can be configured only on APs which have static IP.

Encryption

Select the Encryption check box to enable encryption.

Rogue Detection

Select the check box to enable rogue detection.

SSH Access Select the SSH Access check box to enable SSH access.

Telnet Access Select the Telnet Access check box to enable Telnet access.

Link Latency You can configure link latency on the controller to measure the link between an access
point and the controller.

Note Link latency is supported for use only with FlexConnect access pointsin
connected mode. FlexConnect access points in standal one mode are not
supported.

TCP Adjust MSS Select the TCP Adjust M SS check box to enable TCP to adjust MSS.

VLAN Tagging VLAN Tagging is supported only from controller version 7.3.1.26. If you change the mode
or value of VLAN tagging, the access point will be rebooted. VLAN tagging cannot be
enabled when the AP isin Bridge mode. Enabling VLAN tagging will ignore the val ue of
Native VLAN ID.

AP Group Name AP Group Name.

Reboot AP Select the check box to enable areboot of the access point after making any other updates.

Power Injector Configuration

Power Injector State

When enabled, this allows you to manipulate power injector settings through Prime
Infrastructure without having to go directly to the controllers. If the Enable Power Injector
State is selected, power injector options appear.

Power Injector Selection

Choose installed or override from the drop-down list.

Injector Switch MAC Address

Enter the MAC address of the injector switch.

Global Username Password
Configuration

Override Global Username Password

Select the check box to enable an override for the global username/password. Enter and
confirm the new access point username and password in the appropriate text boxes.
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Field

Description

Supplicant CredentialsConfiguration

Override Supplicant Credentials

Select the Override Supplicant Credentials check box to prevent this access point from
inheriting the authentication username and password from the controller. The default value
isunselected. The Override Supplicant Credential s option issupported in controller Release
6.0 and later.

In the Username, Password, and Confirm Password text boxes, enter the unique username
and password that you want to assign to this access point.

USB Configuration

You can set USB Module
State only if USB override
is enabled.

Note

USB Override - Enable the checkbox to override the AP's. For Aries OS you can override
group level status and for EWLC to override profile level status.

USB Module State - Enable the checkbox if you want to turn on/off the operational state.

AP Retransmit Configuration

AP Retransmit Count

Enter the AP Retransmit Count. The AP Retransmit Count default valueis 5 and the range
isfrom 3to 8.

AP Retransmit Interval (secs)

Enter the AP Retransmit Intervals. The AP Retransmit Interval default valueis 3. Therange
is2to5.

Controller Configuration

Controllers Configuration

Select the check box to enable the drop-down lists for the primary, secondary, and tertiary
controller names.

* Primary, Secondary, and Tertiary Controller Name—The Primary/Secondary/Tertiary
Controller names.

* Primary, Secondary, and Tertiary Controller IP—The Primary/Secondary/Tertiary
Controller IPisthe Management | P of the controller.

Venue Configuration

* Venue Group
* Venue Type
* Secondary Venue Name

 Language

BLE Beacon Configuration

Enable the BLE Beacon Configuration check box and configure the following:
* Beacon Id
» Mgjor Field
* Minor Field
* Tx Power (dBM)
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Field Description
AP LAN Port Configuration
Note This configuration is
applicable only for Cisco
Aironet 702W Series APs
and Cisco 1810W Series
APs.
AP LAN Override Select the check box to enable the LAN Override on the access point.
Port Displays the port number.
State Select the check box to enable the port status.
POE Status Thefirst LAN port contains a POE through which you can configure the POE status. Select
the check box to enable the POE status.
VLAN ID Enter the VLAN ID.

Lightweight AP Configuration Templates > Mesh

Thefollowingtable describesthefieldsinthe Mesh tabin Configuration > Templates> Lightweight Access
Points.

Table 123: Lightweight AP Configuration Templates > Mesh

Field Description

Bridge Group Name | Enter a bridge group name (up to 10 characters) in the text box.

Note Bridge groups are used to logically group the mesh access points to avoid two networks on the
same channel from communicating with each other. For mesh access points to communicate,
they must have the same bridge group name. For configurations with multiple RAPs, make sure
that all RAPs have the same bridge group name to alow failover from one RAP to another.

Data Rate (Mbps) Choose the data rate for the backhaul interface from the drop-down list. Data rates available are dictated
by the backhaul interface. The default rate is 18 Mbps.

Note Thisdatarateis shared between the mesh access points and is fixed for the whole mesh network.
Do not change the data rate for a deployed mesh networking solution.

Ethernet Bridge From the Ethernet Bridging drop-down list, enable Ethernet bridging for the mesh access point.
Role Choose the role of the mesh access point from the drop-down list (MAP or RAP). The default setting is
MAP,

An access point in a mesh network functions as either aroot access point (RAP) or mesh access point
(MAP).

Ethernet Interfacesarea| The group box provides information such as interface name, mode, VLAN 1D, and Trunk ID. Select the
appropriate interface and specify its mode.
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Lightweight AP Configuration Templates > 802.11a/n/ac

Thefollowing table describesthefieldsin the 802.11a/n/ac tab in Configuration > Templates> Lightweight
Access Points.

Table 124: Lightweight AP Configuration Templates > 802.11a/n/ac

Field Descriptions

802.11a parameters Select the check boxes of the 802.11a parameters that must be applied:

* Channel Assignment
» Channel Width
* Admin Status

802.11ac parameters | Select the check boxes of the 802.11ac parameters that must be applied. 802.11ac parameters are only
applicable for 11ac modules.

» Channel Width
e Admin Status

Power Assignment Select the Power Assignment check box to choose the appropriate power level.

Antenna Selection Select the Antenna Selection check box to select any of the 11n Antenna Selection parameters.

CleanAir Select the CleanAir check box to enable CleanAir functionality. CleanAir is supported from the WLC
Release 7.0 for CleanAir-supported APs.

AntennaConfiguration | Select the check boxes of the configuration that must be applied:

» Antenna M ode—Choose an antenna mode.

» Antenna Diversity—Choose enabled or disabled. Antennadiversity refersto the access point sampling
the radio signal from two integrated antenna ports to choose the preferred antenna.

» Antenna Type—Indicate an external or internal antenna.

» Antenna Name—Select the Antenna Type check box, then choose the applicable antenna name from
the drop-down list.

» Antenna Gain—Enter avalue for antenna gain.

» Azimuth—Configure each access point with the custom Azimuth in degrees. Azimuth and Elevation
are the angle used to define the apparent position of the access point.

» Elevation—Configure each access point with the custom Elevation in degrees.

» Up/ Down—Select Up or Down from the drop-down list.

Lightweight AP Configuration Templates 802.11a > SubBand

The following table describes the fields in the 802.11a SubBand tab in Configuration > Templates >
Lightweight Access Points. In the 802.11a SubBand tab, select the 802.11a Sub Band options (for either 4.9
or 5.8 parameters) that must be applied. The SubBand options are disabled unless the check box to the left of
thefield is selected.c
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Table 125: Lightweight AP Configuration Templates 802.11a > SubBand

Field Description

Admin Status Click if you want to enable administration privileges.

Channel Assignment | Select the check box and then choose the appropriate channel from the drop-down list.

Note The channel number is validated against the radio list of supported channels.

Power Assignment | Select the check box and then choose the appropriate power level from the drop-down list.
Note The power level isvalidated against the radio list of supported power levels.

WLAN Override | Select the check box and then choose Disable or Enable from the drop-down list.
Note The access point must be reset for the WLAN override change to take effect.

Antenna Type Indicate an external or interna antenna.

Antenna Name Select the Antenna Type check box, then choose the applicable antenna name from the drop-down list.

Lightweight AP Configuration Templates > 802.11b/g/n

The following table describesthe fieldsin the 802.11b/g/n tab in Configuration > Templates > Lightweight
Access Points.

Table 126: Lightweight AP Configuration Templates > 802.11b/g/n

Field Descriptions

Channel Assignment Choose a Global assignment method or choose Custom to specify a channel.

Channel Width From the drop-down list, choose either 20 MHz or 40 MHz.

Admin Status Select if you want to enable administration privileges.

Power Assignment Choose a Global assignment method or choose Custom to specify a power assignment.

Tracking Optimized Monitor Mode | Select to enable.

Antenna Selection Select the Antenna Selection check box, then select the appropriate antennas from the list.

CleanAir Select this check box to enable CleanAir.
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Field

Descriptions

Antenna Configuration

Select the check boxes of the configuration that must be applied:

» Antenna Mode—Choose an antenna mode.

« Antenna Diversity—Choose enabled or disabled. Antenna diversity refers to the access
point sampling the radio signal from two integrated antenna ports to choose the preferred
antenna.

 Antenna Type—Indicate an external or internal antenna.

» Antenna Name—Select the Antenna Type check box, then choose the applicable antenna
name from the drop-down list.

» Antenna Gain—Enter a value for antenna gain.

» Azimuth—You must configure every access point with the custom Azimuth in degrees.
Azimuth and Elevation are the angle used to define the apparent position of the access
point.

« Elevation—You must configure every access point with the custom Elevation in degree.

» Up / Down—From the drop-down list, choose Up or Down.

Lightweight AP Configuration Templates > 802.11a/b/g/n

Thefollowing table describesthefieldsin the 802.11a/b/g/n tab in Configuration > Templates> Lightweight
Access Points.

Use this tab to configure Hyper Location, WSM, and Monitor Mode AP module radios.

Table 127: Lightweight AP Configuration Templates > 802.11a/b/g/n

Field

Descriptions

Radio Role Assignment

Thisconfiguration issupported only for XOR Radios. Select the checkbox to configure the radio assignment
methods.

The assignment methods are Auto, Serving, or Monitor.

Choose either 2.4 GHz or 5 GHz radio for Serving radio role assignment.

Admin Status

Select the check box if you want to enable administration privileges.

Channel Assignment

(Only for Serving radio role assignment). Select this check box to configure one of the following:

* Global—Use this setting if the channel of the access point is set globally by the controller.

e Custom—Use this setting if the channel of the access point is set locally. Select a channel from the
Custom drop-down list. The values in the drop-down varies for 2.4 GHz and 5 GHz radios.

Channel Width (Only for Serving radio role assignment). Channel width is supported only for 11n supported APs. Only
radios with 20 MHz is supported for a 2.4 GHz radio. For 5 GHZ, from the Channel Width drop-down
list, choose 20 MHz, 40 MHz, 80 MHz or 160 MHZ.

Antenna Mode (Only for Serving radio role assignment). Choose an antenna mode from the drop-down list.

Antenna Diversity

(Only for Serving radio role assignment). Select Right/Side A, Left/Side B, or Enabled.

Antenna Type

Select the Antenna Type check box and then choose an applicable antenna name from the drop-down list.
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Field Descriptions

Antenna Name (For Serving and Monitor radio role assignment). Choose the applicable antennaname from the drop-down
list.

XOR Antenna A (Only for Auto mode). Configure an antennafor A band by selecting an antenna name from the drop-down
list.

XOR Antenna B (Only for Auto mode). Configure an antennafor B band by selecting an antenna name from the drop-down
list.

Antenna Gain (Only for Serving radio role assignment). Enter the desired antenna gain in the text box. To configure

custom antenna gain, select Others for the Antenna Name.

Antenna Selection

(Only for Serving radio role assignment). Prime Infrastructure provides the ability to enable or disable the
use of specific antennas. All antennas are enabled by default. Select any of the 11n Antenna Selection
parameters:

e Antenna A
* Antenna B
e AntennaC
* AntennaD

CleanAir

Select the CleanAir check box and choose the applicable option from the drop-down list.
For Serving and Auto mode, these options are available:

* Enabled

* Disabled
For Monitor Mode XOR, these options are available:

¢ 2.4 GHz Enabled
* 5 GHz Enabled

« Both Enabled

» Both Disabled

Power Assignment

Select one of the following:

« Global—Use this setting if the power level is set globally by the controller.

» Custom—Use this setting if the power level of the access point is set locally. Choose a power level
from the drop-down list.

Antenna Configuration

Select the check boxes of the configuration that must be applied:

» Azimuth—You must configure every access point with the custom Azimuth in degrees. Azimuth and
Elevation are the angle used to define the apparent position of the access point.

« Elevation—You must configure every access point with the custom Elevation in degree.

e Up/ Down—Select Up or Down from the drop-down list.

Lightweight AP Configuration Templates > CDP

Thefollowing table describesthe fieldsin the CDPtab in Configuration > Templates > Lightweight Access
Points.
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Table 128: Lightweight AP Configuration Templates > CDP

Field

Description

Cisco Discovery Protocol on Ethernet I nterfaces | Select the check boxesfor the ethernet interface slotsfor which you want to enable

CDP.

Cisco Discovery Protocol on Radio Interfaces | Select the checkbox for the radio interfaces slots for which you want to enable

CDP.

Lightweight AP Configuration Templates > FlexConnect

Thefollowing table describesthefieldsin the FlexConnect tab in Configur ation > Templates> Lightweight
Access Points.

Table 129: Lightweight AP Configuration Templates > FlexConnect

Field

Description

FlexConnect Configuration

Select the check box to enable FlexConnect configuration (including VLAN support, native VLAN
ID, and profile name VLAN mappings).

Note These options are only available for access points in FlexConnect mode.

OfficeExtend

The default is Enabled.

Unsel ecting the check box simply disables OfficeExtend mode for this access point. It does not undo
all of the configuration settings on the access point. If you want to clear the access point configuration
and return it to factory default settings, click Clear Config at the bottom of the access point details
page. If you want to clear only the access point personal SSID, click Reset Personal SSID at the
bottom of the access point details page.

When you select Enable for the OfficeExtend AP, several configuration changes automatically occur
including: encryption and link latency are enabled; rogue detection, SSH access, and Telnet access
are disabled.

When you enabl e the OfficeExtend access point, you must configure at |east one primary, secondary,
and tertiary controller (including name and IP address).

Least Latency Controller Join

When enabled, the access point switches from a priority order search (primary, secondary, and then
tertiary controller) to a search for the controller with the best latency measurement (least latency).
The controller with the least latency provides the best performance.

The access point only performs this search once when it initialy joins the controller. It does not
recal culate the latency measurements of primary, secondary, and tertiary controllers once joined to
seeif the measurements have changed.

VLAN Support

Select the check box to enable VLAN Support.

Native VLAN ID

The valid native VLAN ID rangeis 1 to 4094. If you are changing the mode to REAP and if the
access point is not already in REAP mode, then all other REAP parameters are not applied on the
access point.

WLAN VLAN Mapping

Select the WLAN VLAN Mapping check box to enable WLAN VLAN mapping (including WLAN
profile name and VLAN 1D mappings).
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Field Description

Web Auth ACL Mapping Select the VLAN 1D ACL Mapping check box to enable VLAN ID ACL Mappings. Enter aVLAN
ID and choose the Ingress and Egress ACL s from the drop-down list boxes to map to the VLAN ID
specified.

Policy ACL Mapping Select the Policy ACL Mapping check box to enable policy ACL mapping.

Local Split ACL Mapping | Select the Local Split ACL Mapping check box to enable Local Split ACL mapping.

Lightweight AP Configuration Templates > Schedule
The following table describes the fields in the Schedule page in Lightweight AP Configuration Templates.

Table 130: Lightweight AP Configuration Templates Schedule

Field Description

Start Time | Allows you to configure and start the template deployment at a scheduled time.
Now—Deploys the template right away.

Date—Enter a date in the text box or use the calendar icon to select a start date.

Recurrence | Select from none, hourly, daily, or weekly to determine how often this scheduling occurs.

You can deploy the template using the AP Selection or Schedule tabs.

Switch Location Configuration Template

The following table describes the Template Detail fields on Design > Wireless Configuration > Switch
L ocation Configuration.

Table 131: Design > Wireless Configuration > Switch Location Configuration

Field Description

Map Location

Campus Choose a campus for the map location for a switch/switch port.

Building Choose a building for the map location for a switch/switch port.

Floor Choose afloor for the map location for a switch/switch port.

Import Imports the civic information for the campus, building, and floor selected.
ELIN and CivicLocation

ELIN The Emergency Location Identification Number.

Civic Addresstab The available civic address information for the switch/switch port.
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Field Description
Advanced tab Detailed information about the switch/switch port location.
NMSP Select or unselect this check box to enable or disable NMSP for the switch.

Autonomous AP Migration Templates

Thefollowing table describesthe Template Detail fieldsin Design > Configuration > Wireless Configur ation
> Autonomous AP Migration Templates.

Table 132: Autonomous AP Migration Template Page

Field Description

Name Template name.

Description | Template description.

AP Count Number of APs.

Schedule Run | Scheduled run time.

Status Indicates one of the following:

« Not initiated—The template is yet to start the migration and starts at the scheduled time.

« Disabled—Thetemplateis disabled and does not run at the scheduled time. Thisisthe default state for atemplate
when it is created without selecting any autonomous access points.

 Expired—The template did not run at the scheduled time (this might be due to the Prime Infrastructure server
being down).

» Enabled—The template is yet to start the migration and starts at the scheduled time.

« In progress—The template is currently converting the sel ected autonomous access points to CAPWAP.

* Success—The template has completed the migration of autonomous access point to CAPWAP successfully.

* Failure—Thetemplate failed to migrate all the selected autonomous access point to CAPWAP. You can check
the detailed status about the failures by using the View Migration Status page.

* Partial Success—The template failed to migrate a subset of the sel ected autonomous access point to CAPWAP.
You can check the detailed status about the failures by using the View Migration Status page.

Autonomous AP Migration Templates Add Template

Thefollowing table describesthe Template Detail fieldsin Design > Configuration > Wireless Configuration
> Autonomous AP Migration Templates.

Table 133: Autonomous AP Migration Templates

Field Description
Upgrade Options
DHCP Support Ensures that after the conversion every access point gets an IP from the DHCP server.
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Field

Description

Retain AP HostName

Allows you to retain the same hostname for this access point.

The hostname is retained in the CAPWAP, only when you are migrating the AP to CAPWAP for the first
time. It might not be retained if you are upgrading an AP for several times. The CAPWAP access points
hostname is set to default if autonomous access points hosthame has more than 32 characters.

If you upgrade the access points to LWAPP from 12.3(11)JA, 12.3(11)JA1, 12.3(11)JA2, 12.3(11)JA3
autonomousimages, the converted access points might not retain their static | P address, netmask, hosthname
and default gateway.

Migrate over WANLink

Increases the default timeouts for the CL1 commands executed on the access point.

If you enable this option, the env_vars file stores the remote TFTP server location. Thisinformation is
copied to the access point. If this option is not selected, then the Prime Infrastructure internal TFTP server
is used to copy the env_varsfile to the access point.

DNS Address

Enter the DNS address.

Domain Name

Enter the domain name.

Controller Details

Controller IP Enter controller |P address.

AP Manager IP Specify the controller the access point should join by entering the access point manager |P address.
For SSC-enabled access points, this | P address must be the same asthe controller IPfield. For M1C-enabled
access points, the IP addresses need not match.

User Name Enter the username.

Password Enter the password for the username.

TFTP Details

TFTP Server IP Enter the |P address of the Prime Infrastructure server. Prime Infrastructure providesits own TFTP and
FTP server during the installation and setup.

File Path Enter the TFTP directory that was defined during Prime Infrastructure setup.

File Name Enter the CAPWAP conversion file defined in the TFTP directory during Prime Infrastructure setup (for
example, c1240-rcvkOw8-tar.123-11JX 1.tar).

Schedule Details

Apply Template Choose an option by which you want to apply the template for migration.

Notification Enter the email address of recipient to send notifications.

Controller Configuration Groups

The following topics describe the fieldsin Design > Wireless Configuration > Wireless Configuration >
Controller Configuration Groups.
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* Controller Configuration Groups > Add Config Group
« Controller Configuration Groups > General
« Controller Configuration Groups > Apply Schedule

Controller Configuration Groups > Add Config Group

Thefollowing table describesthe Template Detail fieldsin Controller Configuration Groups> Add Config
Group.

Table 134: Wireless Configuration > Controller Configuration Groups

Field Description

Group Name | The group name must be unique across all groups.

Templates | Other templates created in Prime Infrastructure can be assigned to a config group. The same WLAN template can be
assigned to more than one config group. Choose from the following:

» Select and add later: Add atemplate at alater time.

 Copy templatesfrom a controller: Copy templates from another controller. Choose a controller from alist of
current controllers to copy its applied template to the new config group. Only the templates are copied.

Note Theorder of the templatesisimportant when dealing with radio templates. For example, if thetemplate
list includes radio templates that require the radio network to be disabled prior to applying the radio
parameters, the template to disable the radio network must be added to the template first.

Controller Configuration Groups > General
The following table describes the Template Detail fieldsin Controller Configuration Groups > General.

Table 135: Wireless Configuration > Controller Configuration Groups > General

Field Description

Enable Background Audit | If selected, all the templates that are part of this group are audited against the controller during network
and controller audits.

Note To enable this option, set the template-based audit option under Administration > System >
Audit.

Enable Enforcement If selected, the templates are automatically applied during the audit if any discrepancies are found.

Note To enable this option, set the template-based audit option under Administration > System >
Audit.

Enable Mobility Group | If selected, the mobility group nameis pushed to all controllersin the group.

Mobility Group Name | A namethat is pushed to all controllersin the group. You can aso use this field to change the group
name.

Note A controller can be part of multiple configuration groups.

Last Modified On Date and time config group was last modified.
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Field Description

Last Applied On Date and time last changes were applied.

Controller Configuration Groups > Apply Schedule

The following table describes the Template Detail fieldsin Controller Configuration Groups > Apply
Schedule.

Table 136: Wireless Configuration > Controller Config Groups > Apply Schedule

Field Description

Apply Note This option is available only when the Schedule option is not enabled.

Click Apply to start the provisioning of mobility groups, mobility members, and templatesto all the controllers
in the config group. After you apply, you can leave this page or log out of Prime Infrastructure. The process
continues, and you can return later to this page to view areport.

Note Do not perform any other configuration group functions during the apply provisioning.

The report appearsin the Recent Apply Report page. It shows which mobility groups, mobility members, or
templates were successfully applied to each of the controllers.

Schedule Enabling the Schedule option disables the Apply option.

Start DateStart Time | Enter a starting date and time, then click Schedule.

Compliance Field Descriptions

The following topics contain field descriptions for Compliance:

* Configuration > Compliance > Policies
« Configuration > Compliance > Profiles
« Configuration > Compliance > Violation Summary

Configuration > Compliance > Policies

Table 137: Configuration > Compliance > Policies > New Rule Fields

Field Description

Rule Information

All information entered inthis
section is free text and does
not impact the conditionsand
the subsequent violations.

Rule Title Enter aname for the rule.
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Field Description

Description Enter a brief description

Impact Enter a brief note on the impact of the violation that the rule will generate.

Suggested Fix Enter abrief description of thefix that will help you decide to choose or to not choose the rule against

a specific policy. This description appears when you check the rule in the Rule Selector pane.

Platform Selection

Available Platforms

Check the platforms on which the condition must be run. If you select Cisco Devices, al of Cisco
platforms specified in the list are included. The platforms checked in this section impacts the ignore
count of an audit job. For example, if you run arule on all the devices within your scope, including
devices not selected in the Available Platforms pane, such devices are not audited and are marked
against Ignore count.

RuleInputs

New Rule Input

Click New to add inputs for the new rule. The input you create in this pane reflectsin the Policy
Profile page. You must provide rule inputs for the rule you have selected. For example, you can
create an input to be P Address. Any user who wantsto run thisrule can enter an | P address specific
to therule and add it to a specific profile. Enter the required details:

For Identifier, Enter your own Identifier, or click the Gener ate button to generate an identifier based
on thetitle.

The following fields appear based on the option that you choose in the Data Type field:

« IsList of Values—Check this check box to add multiple values to be associated with the rule
input. A table appears where you can add, edit, and delete values. You can also set a default
vaue.

* Accept Multiple Values—Check this check box if you want to provide more than one value at
the time of audit. Thisis applicable only for the execution type rule input.

* Min Value—Enter a minimum integer value for the rule input. Thisis applicable only for the
integer data type.

» Max Value—Enter a maximum integer value for the rule input. Thisis applicable only for the
integer data type.

« Default Value—Enter a default value for the rule input. The format of the value that you enter
in this field depends on the data type that you choose in the Data Type field. For example, if
you choose Integer as the data type, you can enter an integer value only.

» Max Length—Enter the maximum length that is applicable for the rule input.

* Val RegExp—Enter avalid regular expression that will be used for execution or fix.

Conditions and Actions

New Conditions and Actions

Click New to create conditions and actions for the new rule.

New Conditions and
Actions—ConditionsDetails
Tab
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Field

Description

Condition Scope Details

« Condition Scope—Sel ect the scope of the conditions from one of the below:

* Configuration—Checks the complete running configuration.
» Device Command Outputs—Checks the output of show commands.
« Device Properties—Checks agai nst the device properties and not the running configuration.

* Previously Matched Blocks—Runs the conditions against blocks that have been defined
in previous conditions. To run the condition with this option, you must have checked Parse
as Block option in one of the previous conditions. You cannot select this option for the
first condition of arule.

« Device Property—Select one of the following device properties:

» Device Name
* |P Address

¢ OS Name

» OS Version

Note Thisoption is enabled only if you selected Device Properties in the Condition Scope
drop-down list.

 Show Commands—Select the required show command that isapplicablefor the platform selected.
You can also enter a show command against which the audit must be performed.

Note Thisoption is enabled only if you selected Device Command Outputs in the Condition
Scope drop-down list.

Block Options

Parse as Blocks

Checking this option enables you to run conditions on specific blocks (as defined in this section) in
running configuration files. This option can be for show commands is enabled only if you selected
Configuration in the Condition Scope option.

Block Start Expression

Thisfield ismandatory if Parse as Blocks option is enabled. This must be aregular expression. Rule
inputs and Grep outputs can be used here.

Block End Expression

Thisfield is optional. By default, blocks end when the top-level or a sub-level command begins. If
you prefer to break the block earlier, enter the value as aregular expression.

Rule Pass Criteria

Check the option, as required. If you select:

« All Sub Blocks—Theruleismarked asuccessonly if all the blocksfulfill the specified condition.

» Any Sub Block—Theruleismarked a success even if one of the sub blocksfulfill the condition.

« Raise One Violation for Each Failing Instance—If you check this option, the violation count
specified in the Job view increases by as many number of violations as the condition encounters
in each block.

Condition Match Criteria

Operator

Choose an option based on the value you will enter in the subsequent fields.
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Field

Description

Operator Function

Click Edit. The Select Operator Function page appears. Select a predefined function and enter the
function parameters based on the predefined function that you have selected.

Note Thisfield isavailable only if you selected the option Execute a Function or Evaluate
Expression from the Operator field.

Vaue

Thevalue must be aregular expression. Rule inputs and Grep outputs can be used here. Thisvariable
can be grepped for use in the subsequent conditions. It follows the convention of condition
<Condition.value number> such as, <2.1> <2.2>... Thisnumerical identifier can be used from the
next condition as input parameter for Operator selected in the previousfield.

If you select the Evaluate Expression from the Operator field, click Edit to select the Operator
function.

If the you select “checkTraffic” as Function Name, it checkstraffic on any ACL. Enter the value
for expected traffic in Traffic and ACL fields, as the following Example.

"Traffic* = "deny tcp any any eq 27665 log”, "ACL" = <1.1>

"Traffic* ="<_Expected Traffic>", "ACL" = <1.1>, which means expected traffic has be captured
from execution type rule input *_Expected Traffic".

Rule Pass Criteria

Check the option, as required. If you select:

« All Sub Blocks—Theruleis marked asuccessonly if all the blocksfulfill the specified condition.
» Any Sub Block—Theruleis marked asuccess even if one of the sub blocksfulfill the condition.

« Raise One Violation for Each Failing Instance—If you check this option, the violation count
specified in the Job view increases by as many number of violations as the condition encounters
in each block.

New Conditionsand
Actions—Action Details
Tab

Select Action

Select one of the following actions that Compliance Audit must perform upon detecting a violation:

« Continue—If the condition is met or not met, the rule continues to run based on the condition
number specified in the field. If a condition number is not specified, the rule skips to the next
immediate condition.

» Does Not Raise a Violation—Does not raise a violation; stops further execution of rule.

« Raise a Violation—Raises a violation and stops further execution of rule.

« Raise a Violation and Continue—Raises a violation and continues execution of rule.

Condition Number

Specify the condition number to which the rule must continue with in case the condition ismet or is
not met. You cannot specify a condition number that islesser than or equal to the current condition

number. Thisfield isavailable only if you selected the option Continue from the Select Action field.

If the Condition Number field is blank, the next available condition is used.

Violation Severity

Specify a severity that Compliance Audit must flag if aviolation is detected. Thisfield is available
only if you selected the option, Raise a Violation from the Select Action field.
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Field

Description

Violation Message Type

Select one of the following message type:
* Default Violation Message—Select this option if you determine a violation as not fixable (or
requiring manual intervention).
« User defined Violation Message—Sel ect this option to enter acomment and provide a CLI fix
to fix aviolation.

Thisfield isavailable only if you selected the option, Raise a Violation from the Select Action field.

Violation Message

Note Thisfieldisavailableonly if you selected User defined Violation Messagein the Violation
Message Type field.

Enter a violation message that will be displayed in the Job View window. Rule inputs can be used
here.

Fix CLI

Note Thisfieldisavailableonly if you selected User defined Violation Messagein the Violation
Message Type field.

Enter arelevant CLI fix if the device does not meet the condition specified. Do not enter config t,
configure, and its exit commands. Rule inputs and Grep outputs can be used here.

Note The exit command is allowed in main and sub-level commands.
Following are the formats for the CLI fix that you enter in thisfield:

« For an execution type input, enter <Rule input ID>
« For afix typeinput, enter “<Rule input ID>"
« For agrep type output, enter <n.m>, where n isthe condition number and m isthe output number.

Configuration > Compliance > Profiles

Table 138: Configuration > Compliance > Profiles

Field Description

Profile Actions

Add Create new compliance profile.

Edit Edit the compliance profile description.

Run Run compliance audit for the selected policy profile.

Delete Delete the compliance profile.

Latest Archived Configuration | Prime Infrastructures archivesthe latest available backup configuration. If the backup configuration

is not available, the device is not be audited and will be marked against non-audited devices.

Current Device Configuration

Prime Infrastructure polls for the latest configuration from the device and then performs the audit.
If a Show command is used in the compliance policy, the output of the Show command is taken
from the current device configuration.
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Configuration > Compliance > Violation Summary

The following table displays the information about the rules that you selected for the compliance audit,
violation count, instance count, highest severity and ignore count.

Table 139: Configuration > Compliance > Violations Summary Fields

Field Description

Selected Rules | Number of rules selected in apolicy at the time the policy profile was created. This may be subset of the total
number of rules defined for the policy.

Violation Count | This lists the number of distinct violations (for a particular policy, for the number of devices) that were observed
in each job. For example, if aparticular policy isviolated in 100 devices, the violation count isonly 1.

Instance Count | Summation of the violation count for all the device. For example, if aparticular policy isviolated in 100 devices,
the instance count is 100.

Highest The highest severity of the various rules comprising the policy. The highest (as decided at the time of creating
Severity rules) is shown. This overrides the lower severity items.

Ignore Count | Thisisthe count of rulesignored due to devices falling outside the scope of platforms defined against the rule.

Configure Switches

The following topics contain field descriptions for configuring switches:

« Configure > Switches
« Configure > Switches > IP Address
* Configure > Switches > Add Switches

Configure > Switches

The following table diplays the field description in the summary of switches page:

Table 140: View Switches

Field Description

Management |P Address IP address of the switch. Click the IP address of a
switch to get more details.

Device Name Name of the switch.

Device Type Type of Switch

Reachahility Status Indicates Reachable if the switch is reachable or

Unreachable if the switch is unreachable.
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Field

Description

Inventory Collection Status

Status of the last inventory collection. The possible
values are OK, Partial, Failed, NA (for SPT-only
switches), or In Progress.

Inventory Status Detail

Specifies the status of the latest inventory collection.
If the inventory collection was not successful, lists
the possible reasons for the failure.

Last Inventory Collection Date

Displays the most recent date in which the inventory
was collected.

Creation Time

Date and time the switch was added to the Prime
Infrastructure.

License Status

Indicates the license status of the switch, which can
be Full Support or SPT only.

Configure > Switches > IP Add

ress

The following table displays the field description in the summary information that is displayed while viewing

switch details.

Table 141: Configure > Switches Summary Information

General Parameters

IP Address

|P address of the switch.

Device Name

Name of the switch.

Last Inventory Collection Date

Date and time of the last inventory collection.

Inventory Collection Status

Status of the last inventory collection. The possible values are OK, Partial, or
Failed.

Software Version Version of software running on the switch.
Location Location of the switch.
Contact Contact name for the switch.

Reachability Status

Indicates Reachableif the switch isreachable or Unreachableif the switchis
unreachable.

SNM P Parameters

Version SNMP version number, which can be v, v2c, or v3. For switch port tracing to
be successful in switches configured with SNMP v3, the context for the
corresponding VLAN must be configured in the switch.

Retries Retries (in seconds) allowed before the process stops without success.
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General Parameters

Configure > Switches > Add Switches .

Timeout

Indicate the amount of time (in seconds) allowed before the process time outs.
The valid rangeis 2 to 90 seconds. The default is 10 seconds.

If you selected v3in the Version drop-down list,
the following fields appear:

Username Username

Auth. Type Authentication type with can be None, HMAC-SHA, or HMAC-HD?5.
Auth. Password Authentication password.

Privacy Type Privacy type with can be None, CBC-DES, or CFB-AES-128.

Privacy Password Privacy password.

Community If you selected v1 or v2c, thisfield indicates the SNMP community string.

Telnet/SSH Parameters

Protocol Protocol used.

User Name Username.

Password Password.

Confirm Password Confirm the password by entering it again.
Enable Password Enable password.

Confirm Password Confirm the password by entering it again.
Timeout Timeout value (in seconds).

Configure > Switches > Add Switches
The following table displays the field descriptions in the adding switches page:

Table 142: Adding a Switch

Field Description
General Parameters
Add Format Type Select:

« Device I nfo to manually enter comma-separated | P addresses of
Ethernet switches.

* CSV Filetoimport aCSV file that contains IP addresses of multiple
switches. Enter the CSV file path in the text box or click Browseto
navigate to the CSV file on your computer.
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Field Description
IP Addresses If you selected Device Info, enter comma-separated | P addresses of the
Ethernet switches.
License Level Select:
 Full

» SPT only to specify Switch Port Tracing support only.

SNMP Parameters

Enter SNMP parametersfor thewrite access, if available.
If you enter read-only access parameters, the switch is
added but the Prime Infrastructure is unable to modify
the configuration.

Version Enter the SNMP version number, which can be v1, v2c, or v3. For switch
port tracing to be successful in switches configured with SNMP v3, the
context for the corresponding VLAN must be configured in the switch.

Retries Enter the retries (in seconds) allowed before the process stops without
success.

SNMP Timeout (in secs) Enter the SNM P timeout value (in seconds).

If you selected v1 or v2c in the Version drop-down list,

the Community field appears:

Community Enter the SNM P community string.

If you selected v3 in the Version drop-down list, the
following fields appear:

Username Enter the username.

Auth. Type Enter the authentication type with can be None, HMAC-SHA, or
HMAC-HD5.

Auth. Password Enter the authentication password.

Privacy Type Enter the privacy type with can be None, CBC-DES, or CFB-AES-128.

Privacy Password Enter the privacy password.

Telnet/SSH Parameters

Protocol Select the protocol.
User Name Enter the username.
Password Enter the password.
Confirm Password Confirm the password by entering it again.
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Field Description

Enable Password Enter the enable password.

Confirm Password Confirm the enable password by entering it again.
Timeout (in secs) Enter the timeout value (in seconds).

CSV File Fields

The following table displays the field description in the CSV file:

Table 143: Fields in the CSV File

Field Description

ip_address IP address

network_mask Network mask

snmp_version SNMP credentials version. Can bev1, v2, or v3.

snmp_community SNMP community (Mandatory for v2.)

snmpv2_community SNMP V2 community.

snmpv3_user_name SNMP V3 username (Mandatory for v3.)

snmpv3_auth_type SNMP V 3 authorization type. Can be None or HMAC-MD5 or HMAC-SHA
(Mandatory for v3.)

snmpv3_auth_password | SNMP V3 authorization password (Mandatory for v3).

snmpv3_privacy_type SNMP V3 privacy type. Can be None or DES or CFB-AES-128 (Mandatory
for v3.)

snmpv3_privacy password | SNMP V3 privacy password (Mandatory for v3.)

snmp_retries SNMP retries

snmp_timeout SNMP timeout

protocol telnet, ssh2

telnet_username for switches and APs, if configured (Mandatory if configured.)
telnet_password for switches and APs (mandatory)

enable password Enables the specified password

telnet_timeout The telnet timeout period
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